
 

Finance 101: Gallaudet Budget Basics  

 

 
Gallaudet University 

Administration & Finance 

Fall 2012 
 



 

 



 

Finance 101: Gallaudet Budget Basics 

 

 
Gallaudet University 

Administration & Finance 

Fall 2012 

 



 

 



i 

INTRODUCTION......................................................................................................................... 1 

PART I: BUDGETING FOR THE NON-BUDGET MINDED ................................................ 3 

WHAT IS A BUDGET? .................................................................................................................... 3 

Out with the old, in with the new ............................................................................................ 4 

HOW BUDGETING WORKS AT GALLAUDET ................................................................................... 5 

GENERAL BUDGET CONCEPTS ....................................................................................................... 6 

Bottom line .............................................................................................................................. 6 

Expenses: Positives or negatives? .......................................................................................... 6 

Encumbrances ......................................................................................................................... 7 

Balancing ins and outs ............................................................................................................ 8 

Big picture vs. detail ............................................................................................................... 8 

Temporary vs. permanent ....................................................................................................... 8 

HOW TO ESTABLISH A BUDGET ..................................................................................................... 9 

Example: Estimating expenses to develop a budget ............................................................... 9 

EXPENSE ACCOUNTS .................................................................................................................. 11 

Table 1: Expense accounts and when to use them ................................................................ 11 

The EDA Says No… .............................................................................................................. 17 

GARBAGE IN, GARBAGE OUT ..................................................................................................... 18 

Check Request ....................................................................................................................... 19 

Interdepartmental Invoices (I.I.s) ......................................................................................... 20 

Petty Cash ............................................................................................................................. 21 

Travel Advance/Reimbursement Form ................................................................................. 22 
Additional notes on the Travel Advance/Reimbursement Form ................................................................... 24 

Personnel Action Form (PAF) .............................................................................................. 25 
Additional notes on the PAF ......................................................................................................................... 26 

Purchase Requisition ............................................................................................................ 27 

Budget Revision .................................................................................................................... 28 

Financial Signature/Access Authority Form ........................................................................ 29 

PART II: PEOPLESOFT REPORTS — UP CLOSE AND PERSONAL ............................ 30 

THE BIG PICTURE ........................................................................................................................ 30 

THE WORKHORSES — WHAT YOU’LL USE EVERY TIME .............................................................. 30 

GUBS — Budget Status by Account ...................................................................................... 31 

GUACTJRN — Actuals Detail .............................................................................................. 32 
Table 2: The Journal and Ref relationship..................................................................................................... 34 

THE FINE TUNERS — WHAT YOU’LL USE TO ADJUST YOUR BUDGET .......................................... 35 

GUBE/GUBR — Expense/Revenue Budget .......................................................................... 35 

GUBUDJRN — Budget Detail .............................................................................................. 38 

THE SUPPORTING CAST — WHAT YOU’LL USE FOR ENCUMBERED EXPENSES ............................. 40 

Payroll Encumbrances .......................................................................................................... 40 

POSTAT — Purchase Order Status ...................................................................................... 41 



ii 

PART III: SUGGESTED BUDGET PRACTICES ................................................................. 44 

DEVELOP A BUDGET ROUTINE .................................................................................................... 44 

RESOURCES TO HELP YOU BUDGET ............................................................................................. 45 

HOW TO’S .................................................................................................................................. 46 

How to determine your bottom line ...................................................................................... 46 

How to determine your actual remaining funds ................................................................... 46 

How to find a specific amount or payee in your Actuals Details report............................... 47 

How to determine outstanding payments on a purchase order ............................................ 48 

How to associate a payment with a purchase order ............................................................. 49 

How to establish a budget that reflects your department’s actions and priorities ............... 50 

PART IV: WORKING WITH EXCEL .................................................................................... 52 

SETTING THE STAGE: PREPARING YOUR DOCUMENT FOR ANALYSIS ........................................... 52 

Reviewing the basic commands ............................................................................................ 52 
Table 1: Common Excel commands .............................................................................................................. 53 

Saving your work and the original data set .......................................................................... 54 
Creating a budget folder ................................................................................................................................ 54 
Saving your PeopleSoft report ...................................................................................................................... 55 
Copying the original data and renaming worksheets ..................................................................................... 56 

VIEWING REPORTS ON THE SCREEN AND IN PRINT ...................................................................... 56 

Keeping titles in view ............................................................................................................ 56 
Using FREEZE PANES ..................................................................................................................................... 57 
Detour! Setting print titles ............................................................................................................................. 57 

Printing budget reports (Page Setup) ................................................................................... 58 
Printing budget reports on one page only ...................................................................................................... 58 

Printing budget reports one-page wide by  pages long ................................................................................ 59 
Previewing a document before printing ........................................................................................................ 60 

MANIPULATING AND ANALYZING BUDGET DATA ....................................................................... 60 

Sorting data ........................................................................................................................... 60 
Sorting data — One-click method ................................................................................................................. 60 
Detour! Sorting data by multiple fields ......................................................................................................... 61 

Filtering data ........................................................................................................................ 62 
Filtering data ................................................................................................................................................. 63 
Removing a filter ........................................................................................................................................... 64 
Detour! Customizing a filter ......................................................................................................................... 64 

Calculating subtotals (Putting it all together) ...................................................................... 65 
Table 3: Breakdown of thought process for sample budget analysis............................................................. 65 
Preparing your data to SUBTOTAL ................................................................................................................. 66 

Copying and pasting records into a new worksheet ................................................................................................... 66 
Filtering and sorting the new data set ........................................................................................................................ 67 

Subtotaling data ............................................................................................................................................. 68 

GLOSSARY................................................................................................................................. 70 

 



 1 

Introduction 
Welcome to Finance 101: Gallaudet Budget Basics. One of the most daunting tasks for 

administrative assistants and administrators when they come on board is making sense of the 

University’s budget system. For most folks, learning how to budget is trial and error — mostly 

errors. There’s a lot of “let’s do it this way because it worked last time” instead of following best 

practices that make sense. 

 

So, that’s why you have this manual and are attending the accompanying workshop. The 

University budget is a giant document, and it depends on quality input from each department. It 

makes sense for all departments to use the same budgeting guidelines so information is 

consistent across the University. By understanding how to budget and analyze your department’s 

expenditures, you can make a direct impact on the University’s progress toward its goals. 

Budgets link to funds, which link to decisions on our programs and services. With solid budgets 

at its foundation (meaning your budgeting efforts), the University can better serve our students 

and the community at large. 

 

This manual is a basic tour of PeopleSoft budget reports and Excel, the program we use to view 

our reports. Advanced skills, such as drill downs, managing multiple budgets simultaneously, 

and managing special fund accounts (like grants or donations) will not be covered here. If you 

want information about those topics, you’ll have to wait for “PeopleSoft 201.” 

 

There are five major sections to this manual. They are: 

I. Basic budgeting concepts 

II. Budget report descriptions 

III. Recommended budget habits 

IV. Basic Excel functions 

V. Glossary 

 

PeopleSoft 101 

Goals: (1) Explain budgeting concepts 
 (2) Create consistent budgeting practices among all University departments 
 (3) Explain how to use Excel to analyze budget reports efficiently 

Audience: Staff who manage department budgets (administrative assistants and/or 
budget unit heads) 
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Before we get started, we should make clear the formatting used in this manual to represent 

different items in PeopleSoft and Excel. 

 

Throughout the manual, we will refer to budget reports (or worksheets) by abbreviated names. 

The names correspond to the capitalized letters in each file name. For example, when you 

download your Budget Status by Account report, you see PeopleSoft’s name for it: GUBS115B-

Budget Status by Account - ####. In this manual, we’ll refer to this report as GUBS. 

 

Report shorthand Full report name 

GUBS Budget Status by Account 

GUACTJRN Actuals Detail 

GUBE Expense Budget 

GUBR Revenue Budget 

POSTAT Purchase Order Status 

 

Underlined terms are field codes in a PeopleSoft report or identifiers in Excel (such as the name 

of a menu option).  

 

SMALL CAPS terms are Excel commands. 

 

That should do it for us. Now, let’s start our adventure! 
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Part I: Budgeting for the non-budget minded 

What is a budget? 

Webster’s Collegiate Dictionary defines budget as “a statement of the financial position of an 

administration for a definite period of time based on estimates of expenditures during the period 

and proposals for financing them.”1 

 

Ask the average person on the street to define budget and you’ll get different results. 

 It’s how much money I’ve set aside for different things. 

 It’s a limit for how much I can spend. 

 It’s a mystery. 

 

Sound familiar? Let’s go back to Webster’s definition to unravel why budgets are so confusing. 

 

First and foremost, budgets are predictions. The definition says, “based on estimates of 

expenditures.” Budgets don’t apply to what happened yesterday or last month; they get us 

through tomorrow, next month, or next year. So, budgeting is guesstimating how much you plan 

to spend. The first few times you review your department’s budget, you might feel like your 

numbers are all wrong, but the more you practice guesstimating, the better your budget will 

reflect your actual expenses. Like parallel parking, budgeting requires a good eye, familiarity 

with your vehicle (i.e., your department’s needs), and lots of practice. 

 

The definition also says budgets are “for a definite period of time.” Budgets have expiration 

dates. At Gallaudet, we base our budgets on the fiscal year, which is October 1 to September 30. 

With guesstimating, you can’t expect anyone to ballpark their expenses with an open timeline — 

that’s like taking a walk without setting a time or distance limit. (You’d end up like Forrest 

Gump, crossing the nation and not really knowing why.) So, a fiscal year is a reasonable 

timeframe in which to say, “This is what I want to do, and this is how much money I think I’ll 

need.” By the way, budgeting means your department must revisit its budget every year. Your 

anticipated activities for next year will not be the same as this year’s. 

 

Finally, the definition says, “… proposals for financing them.” This is the part of the budget that 

you probably know best. It’s the “object code” part of the definition. Budgets show how 

expenses are broken down into categories. Just as it helps to have a timeframe for your expenses, 

it also helps to analyze how you will incur them. For example, hosting a conference requires 

dozens of expenses — honoraria, travel, interpreting, space rental, Web marketing, postage, etc. 

It’s impossible to pull a figure out of thin air; you need to consider the pieces that come together 

to make the whole thing work. 

                                                 
1 “budget.” Merriam-Webster’s Collegiate Dictionary, 11th Ed. Merriam-Webster, 2002. 

http://www.merriam-webster.com (24 May 2007). 
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Out with the old, in with the new 

Since we mentioned object codes, we might as well come clean. Object code is the old term for 

expense account. It came from the system prior to PeopleSoft, but the term managed to stick. We 

need to change that — like the mullet, object code is so passé. The hip and the cool use expense 

account (or account, for the truly hip) to talk about how we spend our funds. And you know how 

you use account to refer to your department’s budget? We’ve updated that, too. Now, your 

department budget is referred to as … your department budget (or department, for short). By the 

way, these are the same terms you’ll find on your PeopleSoft reports and accounting forms, 

which makes life even easier. 

 

Breaking down Webster’s definition 
 
Budget: A statement… 
 
What Webster’s says What it means 

…of the financial position of an 
administration… 

…how much money our department 
has… 

…for a definite period of time… …to use during the fiscal year (October 1 
to September 30)… 

…based on estimates of expenditures 
during the period… 

…based on how much we think our 
projects will cost… 

…and proposals for financing them. …and the breakdown of how much we 
need by expense account. 

 

 

So, that’s it. That’s what a budget is. It’s how your department plans to spend its money. 

 

It’s also important to emphasize what a budget does. Obviously, it guides spending for the next 

fiscal year. More importantly, it links your department’s actions (through expenditures) with its 

priorities. Your department has goals to achieve — they cannot be successful without investing 

money for the training and materials your staff needs. Your budget reflects your department’s 

priorities. 

 

The relationship between budgets and priorities is critical for good planning. That’s why the 

president announces University priorities every year and that’s why division heads give 

preferential treatment to proposals that directly support the priorities. Anyone who studies 

Gallaudet’s budget immediately sees that we prioritize accessibility because we designate more 

funds for interpreting and captioning than our peers do. Ultimately, there’s a finite amount of 

funds, and priorities help us determine how best to use them. 

 

Keep in mind! 
Budgets reflect an organization’s priorities. 
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How budgeting works at Gallaudet 

The budgeting process begins in December or January, when the president announces the 

University’s priorities for the following two fiscal years. Yes, the University works on two 

budgets simultaneously — let’s call them FY +1 and FY +2 (as in “next year” and “in two 

years”). 

 

Departments submit plans to their division head, explaining why their projects are important and 

how they support University priorities. The division heads, in turn, review the proposals and 

develop their division-wide budgets, which become the foundation for the University budget. 

The president then presents the University budget to the Board of Trustees. Once the Board 

approves the budgets, the FY +1 budget becomes the official University budget on October 1 

while the FY +2 budget is sent to the government as part of our federal appropriations request. 

 

 
 

University Budget Cycle 

FY +1 = next year 
FY +2 = in two years 

OCT: Fiscal year begins 

DEC/JAN: University 
priorities announced  
for FY +1 and FY +2 

MAR: Divisions prepare 

FY +1 and FY +2 budget 
proposals  

APR: FY +1 and FY +2 
budgets are finalized 

MAY: Board receives and 
approves FY +1 budget 

JUNE: University submits 
FY +2 budget to  

U.S. Dept. of Education 

 

The whole process runs 

from December to June, 

but wise departments use 

the summer months to 

monitor and, if necessary, 

change their current 

spending behaviors. They 

also use the quiet time to 

set new goals for the 

upcoming fiscal year. 

Budgeting is like losing 

weight — much easier 

done a little at a time rather 

than all at once. 

 

So, what does this mean for you? 

 

It means that when you enter PeopleSoft on October 1, you should see a clean, new budget with 

payroll figures that reflect COLAs and merit increases. Expense account allocations should be 

set up for the new year and expenses should be zero. Most important, your bottom line — what’s 

left in your budget after setting aside payroll and other encumbrances — should be a positive 

number. (If it isn’t, you’ve got a problem beyond the scope of this book, and you should talk to 

someone in the Finance Office.) 

 

Of course, this is all theoretical, because there are lots of if’s: if you filed your paperwork 

properly to reallocate funds (see Budget Revisions, p. 27); if COLAs have been approved; if 

Congress has actually passed the new year’s budget. Most likely, you’ll have some revisions to 

make, but you should see some minor changes and expenses equal (or close) to zero. 
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General budget concepts 

As you begin budgeting, you’ll want to keep a few concepts in mind. These guidelines may not 

address every situation you encounter, but they’ll get you through most of them. 

Bottom line 

You’ve often heard the question, “What’s the bottom line?” In conversation, it usually means, 

“What’s the point? What do I really need to know?” As you may have guessed, bottom line 

comes from looking at budgets. It refers to the last line of a budget spreadsheet, where all the 

totals are given and (the $25,000 question) how much money is left in your account. 

 

In general, as long as your bottom line is a positive number, you’re in good shape. Some of the 

expense accounts above it may be negative — meaning you’ve spent more in those accounts than 

you planned to — but hopefully you have several areas with positive balances so everything 

comes out all right in the end. It’s hard to wrap your mind around that at first … that some 

negatives are OK as long as the bottom line is positive. 

 

 

The bottom 
line: Where 
is it? 
 

Worksheet 

GUBS 

(Budget 

Status by 
Account) 

Total budget Bottom line What's left 

 
This illustration shows a department that has exceeded its budget by $69,476.77. 

(In case you’re wondering, this is not good.) 

Expenses: Positives or negatives? 

Positive and negative numbers can be confusing on budget worksheets, especially when one 

worksheet might show expenses as a negative number while another shows it as a positive. You 

need to keep in mind the worksheet’s purpose. If it shows how much money you have, expenses 

are negative and expense reimbursements (i.e., money that comes into your department, usually 

through I.I.s) are positive. If it shows how much money you’ve spent, then expenses are positive 

and reimbursements are negative. 
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The GUBS (Budget Status by Account) worksheet on the previous page tracks how much money 

you have left, so expenses are negative and reimbursements are positive. In the column labeled 

Actual Expenses/Revenues, the line for General Office Expenses shows “-7,573.43” or expenses 

totaling $7,573.43. The line for Inter Department Charge shows “2,417.65” or reimbursements 

totaling $2,417.65. 

 

If you’re tracking how much you have left, expenses are negative. 
If you’re tracking how much you have spent, expenses are positive. 

 

In the example to the right, taken from 

GUACTJRN (Actuals Detail), we track our 

expenditures. So, expenses appear as positive 

numbers (“45.18” or $45.18), and expense 

reimbursements appear as negatives  

(“-725.00” or $725.00). 

Encumbrances 

Encumbrances are place holders for your 

spending. Expenditures that you have 

promised to make but haven’t paid yet are set 

aside to ensure you’ll have enough money to 

meet your obligations when they come due.  

 

The best example of an encumbrance is payroll. PeopleSoft automatically sets aside a large 

chunk of your department’s budget to cover everyone’s salary and benefits for the full year. 

Then, with each pay period, a portion of the encumbered amount becomes an expense as each 

employee gets paid. At the beginning of the fiscal year, everyone’s full salary and benefits are in 

the encumbered column. As the year progresses, the encumbrances decrease while the actual 

expenses increase. 

 

Encumbrances are factored into your bottom line calculations, so it can be tricky to differentiate 

between the bottom line (what your worksheet shows) and what you actually have left (how 

much money you have on hand). For example, if you’ve promised to pay Company X $10,000 

for their services and you’ve paid $3,000 to date, your encumbrance would be $7,000. Your 

budget would show that you’ve spent the full $10,000 even though you still have $7,000 in your 

possession. Some managers like to know this subtle detail because they might want to cancel the 

service and reallocate the funds. Other managers don’t bother, because they see the service as a 

sunk cost (economic term that means “money that can’t be unspent”). 

 

So what do you do if you want to reallocate the encumbered funds? You can deobligate them. 

(See Contracts and Purchasing for assistance.) Continuing with the Company X example, if you 

decide to cancel their service, the $7,000 encumbrance would go back into your remaining funds, 

and your bottom line would increase by $7,000. (Of course, keep in mind that you need to weigh 

the pros and cons of canceling a contract.) 

 

Reimbursement 

Expense  
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If you cancel a contract, deobligate the remaining 
encumbered funds to improve your bottom line. 

Balancing ins and outs 

Part of working with a budget is moving funds among different accounts to cover your expenses 

accurately. Let’s say you need to increase your budget for 5200 (Travel and Transportation). 

Where does the increase come from? More often than not, the increase comes from a decrease in 

another area of your own budget. It’s a zero sum game — if one area goes up, another must 

come down. 

 

What’s confusing about this concept is that you rarely get an influx of new money. So it’s 

important to distinguish between needs for a funding increase (as in “Please give us more 

money,”) and shifting funds within your budget. This is where the word budget can be fuzzy. 

Budget is not money. Budget is how you plan to use your money. Money or funds is money. So, 

don’t ask “What’s left in our budget?” Ask “What’s left of our funds?” 

 

Budget ≠ $$$ 
Budget = plans for using $$$ 

Funds = $$$ 

Big picture vs. detail 

If you’ve worked with account codes, you know that there are high level categories (those that 

end in “00”) and detail accounts. When you budget, you need to keep the big picture in mind, so 

use the high level accounts to guesstimate your expenses. However, when you track your 

expenditures, use the detail accounts to identify how you’ve spent your funds. Don’t budget at 

the detail level, unless you’re working with payroll (e.g., submit budget revisions for 5300, not 

5351). On the flip side, don’t charge any expenses to a high level account code (e.g., Post-it’s fall 

under 5351, not 5300). Planning = big picture; tracking = detail. 

Temporary vs. permanent 

You see these terms with budget revisions, which are changes to expense accounts. Temporary 

budget revisions are changes that do not continue to the next fiscal year; permanent revisions do. 

 

Let’s say your department is developing a new student handbook. You expect to spend $5,000 in 

the next fiscal year on printing, and your current budget has no money allotted for 5700 (Printing 

and Publishing). For a temporary budget revision (e.g., a single printing of the handbook), you 

would shift $5,000 from other areas of your budget to 5700. (Remember, it’s a zero sum game.) 

When the next fiscal year begins, the $5,000 would disappear from 5700 and go back to their 

original assignments. 
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Now, let’s suppose your department decides to print a new student handbook every year. You’ll 

need funds for this project every year. In this case, you would submit a permanent budget 

revision. When the next fiscal year begins, your budget would show $5,000 allocated for 5700 

expenses. 

How to establish a budget 

So, now that we’ve covered budget basics, are you looking at your current budget and thinking, 

“This is not quite where I want it to be”? With a little diligence and patience, you can rework the 

budget to better reflect your department’s activities. 

 

First, you need good records — at least three or four months of expenses. (For the truly gung-ho, 

a year’s worth would be even better for this exercise.) You’ll use these records to estimate your 

expenses by account. You can either pull information from GUACTJRN or use your “in house” 

records, such as copies of accounting forms. 

 

The information in PeopleSoft is the University’s official data. If your 
records are significantly different from PeopleSoft’s, you should contact 
the Finance Office to resolve the discrepancy. 

 

Let’s assume you’ve gathered records for three months. Assign every expense to the appropriate 

expense account. This is important, because the best way to analyze spending is to know where 

the money’s going. For example, if everything falls under 5351 (General Supplies) or 5371 

(Miscellaneous Services), you won’t be able to tell anything about your department’s spending. 

Likewise, if you classify a pager subscription under 5333 (Other Communications) one month 

and then 5371 another month, you won’t get good results. Be consistent. (By the way, we’ll go 

through the definitions of each expense account in a little bit.) 

 

When you’ve finished, tally the amounts in each account — they become your quarterly expense 

estimates (3 months = ¼ year). Aggregate the estimates under the high level “00” category 

(remember, big picture), and round figures to the nearest whole dollar. Once you’ve done that, 

multiply your “00” category estimate by four (4 quarters = 1 year) and the new figure is your 

budget estimate. (Don’t wallow here; we’ve got an example coming up.) 

 

Of course, you should also use common sense. If you happened to pull records for June, July, 

and August, your estimates might be low because the campus is usually quiet in the summer. 

Likewise, if you used records during months when your department hosted a major event, your 

expenses might be higher than normal. Use your judgment to determine if the estimate is reliable 

or not. 

Example: Estimating expenses to develop a budget 

Let’s walk through an example. Here is a portion of a department’s GUACTJRN report: 
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Partial actuals detail 

 

The full report shows expenses from January 1 to March 31, 2007 (3 months). To keep things 

simple, let’s look only at 5300 (General Office Expenses) accounts, and let’s assume the account 

assignments are correct. Summing by account, we find the following: 

 

Account Description  Total 

5322 Rental of equipment 80.73 

5324 Copying services 1080.00 

5332 Postage 134.61 

5334 Telephone usage (long distance) 106.86 

5338 Telephone service (lines) 495.00 

5341 Periodicals, books, etc. 47.80 

5351 General supplies 1067.40 

5300 General Office Expense Total 3012.40 

 

$3,012    4  =  $12,048 
 

Assuming this quarter was typical for this department, we would recommend allocating $12,100 

for 5300. Remember, budgets are not exact, so round up or down as your intuition tells you. 

 

Repeat this exercise for each expense category (codes ending in “00”), and you’ll get the gist of 

where money should be stashed in your budget. Hopefully, your totals are less than your entire 
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budget. If they come out higher, your department needs to rethink how it uses its money or 

prepare a compelling argument for a budget increase … or both. 

Expense Accounts 

Have you ever debated whether an expense falls under one account or another? Where do I put 

non-GIS interpreter charges? Why do some accounts appear in my PeopleSoft report when I 

can’t find them on any Finance Office lists? This section provides you with definitions for each 

expense account and when to use them. 

 

Consistency is the key! 
If you have trouble assigning an account to a particular expense, just 
make sure all occurrences of that expense fall in the same account. 

 

Keep in mind that the high level “00” category code is used for budgeting only. You charge 

expenses to the detail account codes within each category. (Don’t worry, if you use a “00” code, 

the Finance Office will contact you to fix it.) 

 

The following table lists most expense accounts and definitions. If you have an old copy of the 

account codes and find one that isn’t listed here, it’s probably obsolete or used only by specific 

departments under specific circumstances (and those departments know who they are). This table 

provides the most current list of account codes, their titles and descriptions. 

 

Under 5300 (General Office Supplies), some accounts have asterisks. They correspond to 

services provided by Reprographic Services, Postal Services and Telephone, and the expenses 

are entered directly into PeopleSoft from the provider. Your department does not receive an I.I. 

for these charges. 

Table 1: Expense accounts and when to use them 

ACCOUNT CATEGORY USE FOR … 

4500 Revenue Most departments don’t have revenue. 

If your department regularly generates 
revenue, please contact the Finance Office for 
bookkeeping guidance. 

4573 Miscellaneous Departmental Income … money your department receives for something 
that isn’t your primary mission (e.g., sales of a 
special report produced by your department). 

If you have questions about recording revenue, 
please contact the Finance Office. 
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5100 Salaries and Wages Accounts Most of the expenses in 5100 should be 
handled by HR only, as they pertain to 
employee salary and benefits. 

The main reason you would need these codes 
is to complete personnel action forms (PAFs), 
such as merit increases, new hires or status 
changes. For assistance, contact HR. 

Special notes are given below. Otherwise, 
defer to HR for salary-related account 
assignments. 

5111 Regular Status Instructional Faculty or 
Teacher 

 

5112 Temporary Instructional Faculty or 
Teacher 

 

5115 Short-term Faculty  

5116 Special Pay - Temporary Faculty or 
Teacher 

… compensation in addition to an individual’s 
salary. Typically, special pay is awarded for 
accepting additional responsibilities beyond the 
job description, such as chairing a major initiative. 5117 Special Pay - Regular Status Faculty 

or Teacher 

5119 Faculty/Teacher Benefits  

5121 Regular Status Staff - Exempt  

5123 Regular Status Staff - Non-Exempt  

5124 Special Pay – Exempt Staff  

5125 Regular Status Staff - Collective 
Bargaining 

 

5126 O/T Special Pay – Non-Exempt  

5129 Staff Benefits  

5131 Temporary Staff - Non-Exempt  

5132 Short-Term Temporary Staff  

5134 Extended Temporary Staff - Exempt  

5135 Student Compensation  

5136 Summer Student Compensation … compensation for students working in the 
summer but not enrolled in a summer class. 
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5137 Interpreter on Payroll … interpreters who are full-time staff in your 
department. For GIS, use 5144. For external 
interpreting agencies, use 5451.  

5138 Call in/Substitute  

5139 Temporary Staff Benefits  

     5149 Staff Benefits OT/Special Pay  

     5159 Faculty Benefits – Special Pay  

     5169 Faculty Benefits – SP Temp  

5200 Travel and Transportation Accounts Gallaudet covers many expenses for faculty, 
teachers and staff who travel on official 
business for the University.  

Refer to the A&O Manual, Section 2.05 for 
details on what is or isn’t allowed. 

5211 Travel – Outreach … travel for events that raise awareness of 
Gallaudet through non-academic activities (e.g., 
presentation by an employee on deafness). 

5213 Travel – Professional Development … travel for faculty, teachers and staff to 
continuing education events related to their jobs. 

5215 Travel – Development and Fund 
Raising 

… travel for events that cultivate donor prospects 
and/or raise funds for the University. 

5217 Travel – Recruiting … travel for events that attract new individuals to 
Gallaudet. 

5219 Travel – Administrative … travel for events related to the management of 
the University or a department (e.g., mileage to 
meeting with a University vendor). 

5221 Travel – Non-Gallaudet … travel to/from campus for non-Gallaudet 
employees, such as guest speakers. 

5222 Travel - Departmental   … travel for faculty, teachers and staff related to 
academic or athletic activities  

5300 General Office Expense Accounts The bulk of variable office expenses occur in 
the 5300 category. 

Categories with an asterisk (*) are 
automatically entered into PeopleSoft by the 
provider (i.e., Reprographics, Post Office, and 
ITS). 

5321 Rental of Facilities … room rentals for events; Kellogg Conference 
Hotel room rentals would be classified here. 
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5322 Rental of Equipment … equipment rentals for events, such as 
computers, A/V, tents, etc. 

5324 Reprographic Services* … copying done by Reprographic Services. 

5325 Copying Services … copying done by an EXTERNAL company. 

5331 Telephone and TDD … purchase of an actual telephone or TTY. Cell 
phone service can be classified here, also. 

Charges for Gallaudet line usage are classified 
separately. 

5332 Postage* … postage as calculated by Postal Services. 

Courier and overnight delivery expenses should 
also be classified here. 

5333 Other Communications … purchase of other communication devices 
(such as pagers or videophones) and their 
monthly service subscriptions, if applicable. 

5334 Telephone Usage* … toll and long distance charges. 

5338 Tele-Line Service – MRC* … monthly fee for telephone service. 

5341 Periodicals, Books and Films … purchase of periodicals, books and films for 
department use. 

5343 Magazines & Periodicals …purchase of magazines 

5344 Books … purchase of books for the Library. 

5351 General Supplies … purchase of general office supplies, such as 
paper, printer ink, pens, calendars, etc. 

5361 Repairs … repairs to office equipment, such as a broken 
copier. Repairs done by PPD (such as a hole in 
the wall) should go under 5931, Interdepartmental 
Services. 

5366 Temporary Help – Agencies … services provided for temp employees through 
temporary staffing agencies 

5371 Miscellaneous Services … other services a department may require, such 
as water service. 

5381 Entertainment … expenses incurred for entertaining a guest of 
the University (such as treating a visiting speaker 
to dinner), or catering for a large reception. 

Note: The A&O Manual has strict guidelines on 
what constitutes an entertainment expense. Refer 
to Section 2.05 for more information. 
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5400 Consultants and Advisors Expenses in 5400 usually involve a purchase 
requisition to establish a contract between the 
University and the consultant/advisor. 

Refer to the A&O Manual, Section 3.07 for 
more information or contact the Contracts & 
Purchasing Department. 

5411 Academic Consultants … individuals who provide academic services to 
the University, such as advising on curriculum 
revisions. 

5421 Research Consultants … individuals who provide research services to 
the University, such as advising on sampling 
techniques. 

5431 Administrative Consultants … individuals who provide advisory services 
related to University operations (such as strategic 
planning), or other administrative functions. Temp 
agency hires are classified here. 

5441 Honoraria … payments made to guest lecturers. 

5451 Interpreting Contractors … payments made to external interpreting 
agencies. 

5461 Royalties … payments made to individuals from profits on 
items they created, such as the author of a book. 

5462 Advance Royalties … royalty payments made before an item is sold. 

5500 Professional Fees/Service 
Contracts 

As with 5400 expenses, service contracts may 
require purchase requisitions. Contact 
Contracts & Purchasing for more information. 

5501 Legal fees … legal services provided 

5502 Accounting fees …accounting, tax services provided (e.g.auditors) 

5511 Professional Fees … professional services (e.g., consultants, 
architects, etc.) 

5521 Maintenance Contracts … service contract with a vendor for regular 
maintenance of office equipment (e.g., monthly 
servicing of office copier). Emergency repairs 
(e.g., when the copier spews smoke) are 
classified under 5361. 

5522 Software, Licenses, and Services … purchase of computer software licenses and 
associated services, such as help line 
subscription. 

5531 Service Contracts … agreements with external companies or 
consultants who provide a business-related 
service, such as Web design. 
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5545 Library Electronic DB Services … services for electronic DB for the library 

5561 Insurance  … property coverage, workers comp, auto, etc 

5600 Professional Development Both professional organization expenses and 
job training fall under 5600. Related travel 
expenses, however, should appear in 5213 
(Travel - Professional Development). 

5611 Professional Dues/Memberships … annual dues to professional organizations 
related to an employee’s job. 

5621 Training Programs - On-Campus … registration fee and related expenses for 
training provided by a Gallaudet department. 

5631 Training Programs - Off-Campus … registration fee and related expenses for 
training provided by a non-Gallaudet entity. 

5641 Professional Meetings … registration fee and related expenses for 
meetings and conferences of professional 
organizations. 

5651 Sponsored Meetings … expenses related to meetings for the general 
public (e.g., a lecture that has been advertised 
and open to the public) 

5700 Printing and Publishing This category is related to the production of 
actual books or printed material. Copying falls 
under 5324 (Reprographics) or 5325 (external). 

5711 Printing and Publications … production of a book or other printed material 
performed by an EXTERNAL vendor. 

5718 Reprographic Printing and Publishing … production of a book or other printed material 
performed by Reprographic Services. 

5800 Student Aid  

5811 Stipends … payment for student living and travel expenses. 

5851 Tuition and Fees (Grants Only) … tuition covered by grants. 

5900 Interdepartmental Charges These codes are used when paying other 
campus departments or receiving payments. 

5931 Campus Services … payments to other campus departments. 

5932 Interdepartmental Credits … payments from other campus departments. 

6300 Special Projects Special projects are just that — special, one-
time expenses, such as developing a new 
workshop. 

6301 Departmental Projects … expenses related to a special project. 
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6380 Foreign Study Programs … study abroad programs 

6400 Furniture and Equipment These expenses are often related to purchase 
orders. 

Criteria for whether or not an item must be 
inventoried is outlined in the A&O Manual, 
Section 2.23. Most departmental purchases 
are uninventoried. 

6411 Furniture - Inventoried … furniture over $5,000. 

6421 Equipment - Inventoried … equipment (e.g., computers, copiers, printers, 
etc.) over $5,000. 

6431 Equipment - Uninventoried ... equipment under $5,000. 

6441 Furniture - Uninventoried … furniture under $5,000. 

6600 Access Services This category is related to the services 
provided by interpreters and for captioning.  

6630 GIS Interpreting Service …interpreting services provided by GIS 

6631 Interpreting Contractors …interpreting services provided by an 
EXTERNAL contractor. 

6632 Captioning Service ..expenses related to captioning services 

The EDA Says No… 

Gallaudet is unique in its funding because it receives money from the federal government. Yes, 

folks, your tax dollars go toward the money that is now running this University. When Congress 

passed the Education of the Deaf Act (EDA) in 1986, it authorized Gallaudet and the National 

Technical Institute of the Deaf to receive federal appropriations. It also prohibited the use of 

federal funds to purchase the following: 

 Alcoholic beverages 

 Goods or services for personal use 

 Housing and personal living expenses (unless required by written employment 

agreement) 

 Lobbying 

 Membership in country clubs and social or dining clubs or organizations 

 International student recruitment 

Most of the no-no’s make sense. Look at it this way: If it would upset you to find out your 

representative or senator were spending your tax dollars to purchase an item, it probably is an 

EDA no-no, too. 

 

On the rare occasion that you do need to purchase one of the above items (e.g., wine for a 

reception), you must submit a request for non-federal discretionary funding with the president, 

vice president, or provost.  
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Garbage In, Garbage Out 

Ahh, the golden rule of programmers also applies to good budgeters. The quality of information 

you get from your budget reports depends on the quality of data you provide on the accounting 

forms. In other words, if you do a lousy job assigning expense accounts (garbage in), your 

budget won’t tell you much about how your department spent its money (garbage out). 

 

Consequently, in this section we review the accounting forms you use most often. The bulk of 

your PeopleSoft report data comes from these forms, so it’s a good idea to understand the 

connection between what you enter in the forms and what you see in the reports.  

 

Some accounting forms (i.e., check requests, petty cash, I.I.s, etc.) allow you to enter an Optional 

Tracking Number field. If your department uses internal tracking (such as grouping expenses by 

course or by project), enter an Optional Tracking Number to code expenses for your own 

records. 

 

The following pages cover each form individually. The forms that appear are partial forms and 

should not be used for your future transactions. You can download the current forms by clicking 

the Forms & Procedures link on the Finance Office’s Web site at http://finance.gallaudet.edu. 
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Check Request 

Use this form to pay for products or services not associated with a purchase order. 

 
Finance Office 

College Hall, Room 108 

Phone/tty 202 651-5299 

Fax 202 448-6920 

Gallaudet University 

Check Request 

 
Today's 

Date 
  

OPTIONAL tracking number-up 

to 8 characters 
  

 
PAY TO: 

Payee  

 

Address   

  

City  State  Zip Code  

 
Social Security # 

(if payee is an individual) 

 

 

DESCRIPTION AMOUNT 

 

 

 

 

 TOTAL   

 
CHARGE TO: 

Department Expense Account Amount Department Expense Account Amount 

      

      

Requested 

By 
Signature:  Telephone   Date   

 Print:     

APPROVED BY: Signature: ______________________________ DATE: ______________ 

 Print: _______________________________ 

Check requests must be approved in accordance with policy 2.02.  Appropriate documentation must be attached. 

Special Instructions: 

 U.S. resident 
 International resident 
 EFT (attach appropriate paperwork for new account set-up) 
 Payment to this invoice only 
 Combine with other payments 
 Mail Check (please provide current address) 
 Pick up at Cashier’s Office 
 Hold check with these special instructions 

Partial form — Not for official use 

 

For your dept’s internal 
record keeping 

You must provide the mailing address (and social security number, if 
applicable) for the payee, even if the payee insists on picking up the check. It’s 
an auditing thing; don’t question it. The payee name generally appears in 
GUACTJRN as the Journal Line Description. 

If the check request is for several different products, you can list them here with 
their respective costs. Please provide as much detail as you can — it’s an 
auditing thing. 

You can split costs with other departments or assign multiple expense accounts to one check request. 
Doing this will provide you with a more accurate picture of how you are spending money. 

Complete this 
section, if 
appropriate. 
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Interdepartmental Invoices (I.I.s) 

Use this form to pay or receive payment from another campus department. 

 

 
Today’s 
Date 

 OPTIONAL tracking 
number-up to 8  
characters 

 

 
DEPARTMENT REQUESTING SERVICE  DEPARTMENT PROVIDING SERVICE 

Department 
Name 

  Department 
Name 

 

Building and 
Room Number 

  Building and 
Room Number 

 

Requested 
By 

 Ext   Delivered 
By 

 Ext  

 

 DESCRIPTION OF SERVICES   AMOUNT 
FOR THIS TRANSACTION, ENTER THE 
DESCRIPTION  
(UP TO 30 CHARACTERS) YOU WANT TO 
APPEAR IN YOUR 
PEOPLESOFT FINANCIAL REPORT. 

 

 

 

 
 

 

 
 

 

 
 

 

 
 

 

 
 

 

 
 

 

 

CHARGE TO CREDIT TO 
Department Expense Account Amount Department  Expense Account Amount 

 
 

     

 
 

     

Approved 
By/Date 

 Approved 
By/Date 

 

Interdepartmental Invoices requests must be approved in accordance with policy 2.02.  
Appropriate documentation must be attached. 

Partial form — Not for official use 
 

Always provide documentation! 

For your dept’s internal 
record keeping 

TOTAL 

Department making  
the payment 

Department receiving 
reimbursement 

Whatever you enter here will appear on your 
GUACTJRN report. 

You can use the additional lines to list other 
products/services and their costs. 

Complete the area that pertains to your department. Only complete the other 
department’s information if you have discussed department and account numbers 
with them. As with check requests, you can split costs/credits among several 
different accounts. 
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Petty Cash 

Use this form to receive cash from the Cashier’s Office. 

 

 
Today’s 
Date 

 OPTIONAL tracking 
number-up to 8 
characters 

 

 

PAY TO 
 

 EXT.  AMOUNT  

 
Check One 

 REQUEST FOR PETTY CASH REIMBURSEMENT (Attach receipts) 

 REQUEST FOR PETTY CASH ADVANCE (Receipts are due in three business day) 

 

DESCRIPTION OF 
EXPENSES 
For this petty cash request, type the description 
(up to 30 characters) you want to appear in your 
PeopleSoft report. 

 

DETAILED DESCRIPTION OF EXPENSES 
 
 
 
 
 
 
 
 

 

CHARGE 
TO: 
Department Account Expense Account         Amount Department Account    Expense Account     Amount 

 
 

     

 
 

     

 
APPROVED BY: ___________________________ ______________________________ DATE: ____________ 
  Print Name    Signature 
 
PETTY CASH RECEIVED BY: ___________________ ______________________________ DATE: ____________ 
    Print Name  Signature 
 

Petty Cash Forms must be approved in accordance with policy 2.07. Appropriate documentation must be attached. 

Partial form — Not for official use 
 
 
 

For your dept’s internal 
record keeping 

The person who’s getting the cash 

You MUST provide a receipt and change (if applicable). 

Whatever you enter here will appear on your 
GUACTJRN report. 

You can expand on your entry here. 

You can split costs among multiple departments and/or accounts. 

Always provide documentation! 
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Travel Advance/Reimbursement Form 

Use this form to record expenses related to travel for University business. 
 

Finance Office 
College Hall #108 
(202) 540-8519 – 
VideoPhone 
(202) 651-5299 – Voice 
(202) 448-6920 – FAX 

Gallaudet University 
Travel Advance / Reimbursement Form 

Today’s 
Date 

 
Travel 
Order # 

 

Name  Employee     Student   Other  

Home or 
Campus 
Address 

Street  

City  State  Zip Code  

Reason for 
this Trip and 
Traveler’s 
Role 

 
 

Is this an International trip?  Yes   No  

Duration of 
Trip 

From 
Date 

 
Time 

 To 
Date 

 
Time 

 Destination  

Will any portion be paid by a Non-
Gallaudet Organization? If so 
whom and amount. 
(Check or cash receipt only at time of 
reimbursement.) 

 

Detail of Expenses                                 Gallaudet 
P-Card 

Expenses 
Estimated Expenses 

Actual 
Expenses Item Description  

Lodging  
   

Meals 
(Include conference 
agenda) 

    

Transportation 
(Include itinerary with  
pre-approval form) 

    

Registration Fee 
    

Other Expenses 
  

 
 

Total Receipts must be attached to support actual expenses. 
Per diem rates may be used for meal expenses. 

  

Note: Please submit this form to the Finance Office two 
weeks prior to the travel date if an advance is needed. 
Complete the estimated column to determine the travel 

advance. 

Advance Requested  

 

Department 
Account 

 Expense 
Account 

 Advance Received 
 

 

       

Traveler’s information; home address is required if calculating mileage to/from a 
destination. 

Lodging = hotel. Obviously, mini-bar and other extra services 
are NOT included. 

Meals = Travelers usually get $42/day for their meals. Alcohol, 
however, is NOT allowed. 

Transportation = anything that gets them there — including 
mileage if using their own car. 

Registration fee = conference/meeting registration. 

Other expenses = other expenses incurred during the trip, like 
workshop fees not included with registration. 

With the exception of registration fees, everything on 
the form should fall under 5200 (Travel and 
Transportation). Registration should fall under 5600 
(Professional Development). 

See next page. 

This is an auditing thing, to ensure travel falls within the guidelines 
outlined in the A&O Manual, Section 2.05. 
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Pre-Travel Approval Required 
(Travel expenses will not be reimbursed unless travel had been approved prior to the start of the travel and a copy of this document 

given to the Finance Office.) 

Traveler’s Signature  Date  

Approved: Budget Unit 
Head Signature 

 
Date  

Approved: Senior 
Administrator’s 
Signature 

 Date  

Approved for 
International Travel: 
President’s Signature 
(if required) 

 Date  

Approval of Reimbursement Expenses Upon Return Original  

Amended  

Traveler’s Signature  Date  Due Traveler  

Budget Unit Head 
Signature 

 Date  Due Gallaudet  

Senior Administrator’s 
Signature (if required) 

 Date  

Finance Office Use Only 

Approved by  Voucher Number  

Approvals must be obtained 
prior to the start of travel.  No 
expenses will be reimbursed 
unless all approvals have been 

completed. 

Actual expenses must be 
documented and submitted 
within 5 business days after 
the return date. 
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Additional notes on the Travel Advance/Reimbursement Form 

You only need to complete the Estimated Expenses column if the traveler requests a travel 

advance. Once travel is completed, fill in the Actual Expenses column to calculate if money is 

due to or from the traveler.  

If Estimated > Actual, the traveler owes money 

If Estimated < Actual, the traveler gets reimbursed 

Traveling with purchase cards. Generally, travelers who have purchase cards don’t need a 

travel advance. You still need to reconcile the meal expenses — whether charged to the hotel 

room, paid with cash, or paid on the purchase card — to ensure they fall within the per diem 

rates. You will also need to verify purchase card expenses and review account assignments on 

the JP Morgan Chase Web site, http://www.paymentnet.com. 

 

As stated on the form, when calculating estimated and actual expenses, do NOT include any 

items that have been paid for using the purchase card. Otherwise, items will be double-counted 

— once with this form and once with the automatic download from JP Morgan Chase. 
 

Is it allowed? It can be tricky determining if an expense is allowed as a travel expense. You can 

always refer to the A&O Manual, Section 2.05 for the University’s official guidelines on travel. 

You can also ask yourself, “Is this expense directly related to the individual’s assignment?” If it 

is, great! Process the expense. If it isn’t, you may need to discuss your concerns with the traveler 

to determine if the expense is allowable. 
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Personnel Action Form (PAF) 

Use this form to record any employee status or salary changes in your department. 

 

Regular PAF — Page 1 

GALLAUDET UNIVERSITY 

REGULAR 
PERSONNEL ACTION FORM 

Effective 
Date 

 Today’s 
Date 

 

PERSONAL INFORMATION 

Ms/Mrs/ 
Mr/Dr 

 Name 
L/F/MI  

 SS 
# 

 

Address  City  State  Zip  

Date of Birth  Home Telephone 
Number 

 

TYPE OF ACTION  

 New Appointment  Promotion  Performance Increase  Transfer 

 Rehire  Reclassification  Additional Responsibilities   Account Distribution  

 Extension of 
Appointment 

 Union Pay Adjustment  Change of Status  Other: 

 LWOP Reason:  Return From LWOP 

 Paid Leave Type:  Return From Paid Leave 

POSITION CONTROL FUNDING 

 New Position  Replacement of:  Federal    Income  Grant 

JOB INFORMATION 

 PREVIOUS NEW 

Job Title   

Department Name   

Department # and Account # (Object Code)   

Appointment (i.e., 9, 10, 11, 12 months)   

Full-Time/Part-Time (Hrs/Week, Attach Schedule)   

SALARY 

 PREVIOUS NEW 

Salary Schedule/Level/Step   

Hourly Rate (Non-Exempt)/or Daily Rate   

Base Salary (Exempt)   

Add  1/9  2/9   

Add Other    

Total   

Salary Distribution (Describe, e.g., 9 mos salary 
paid over 12 mos) 

  

ACCOUNT DISTRIBUTION (if more than one account) 
 PREVIOUS NEW 

Acct  %  Amount   Acct  %  Amount  

Acct  %  Amount   Acct  %  Amount  

Acct  %  Amount   Acct  %  Amount  

 

Partial form — Not for official use 

 

Standard information collected about each employee. 

For definitions of each action, please see the HR 
Web site on the University intranet. 

Employee’s current 
information; for new 
hires, leave this column 
blank. 
 
See notes below for 
details about each field. 

Employee’s updated 
information; for new hires, 
this information can 
usually be found on the 
employee requisition form. 
 
See notes below for 
details about each field. 

This section is important for employees who are paid by multiple departments (e.g., faculty who 
receive special appointments outside their primary department). You can enter either the 
percentage each department is responsible for or the actual amount. 

Human Resources Services 
College Hall, Room 106 

Ext. 5352 

Official date the change is recorded 
in the employee’s personnel file. 

This is an HR/Accounting thing and has to do with 
which fund is supporting the employee’s salary. 
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Regular PAF — Page 2 

LOCATION INFORMATION 

Building  Room  Telephone 
Ext 

 Voice, TTY, or 
Both 

 

 
PREPARER VERIFICATION 

Prepared By  Telephone Extension  

I-9 Form 
Attached 

 I-9 Form 
On File 

 Tax Forms 
Attached 

 Recent Tax Forms On  
File (within calendar year) 

 Employee data sheet attached 
(All temporary categories) 

 

 
 SIGNATURE DATE  SIGNATURE DATE 

Unit 
Administrator 

  Senior 
Administrator 

  

 
HUMAN RESOURCES SERVICES/PAYROLL USE ONLY 

Human 
Resources 
Services  

  

ORIGINAL MUST BE SUBMITTED TO THE HUMAN RESOURCES SERVICES OFFICE.  DEPARTMENTS SHOULD MAKE COPIES FOR THEIR FILES.   
ATTACH SUPPORTING DOCUMENTS. 

Partial form — Not for official use 

Additional notes on the PAF 

The field descriptions for the Job Information box are as follows: 

 Job Title. This title will also be used for the individual’s directory listing. 

 Department Name. For employees who work in two different departments, list the 

individual’s primary department, where the position resides. 

 Department # and Account Code. The primary department’s budget code and the individual’s 

account code. Contact HR for help with employee classifications. 

 Appointment. Indicate the employee’s appointment (i.e., 9-, 10-, 11-, or 12-month). 

 Full-time/Part-time. This matters for employee classification and also as a qualification for 

benefits. Hours per week must be indicated. Attach the employee’s schedule for eTIME®. 

 

The field descriptions for the Salary box are as follows: 

 Salary Schedule/Level/Step. The salary schedule is based on the employee’s status as a 

faculty, staff or teacher. For new hires, the salary schedule should be listed on the employee 

requisition form. 

 Hourly (Non-exempt) or Daily Rate and Base Rate (Exempt). Indicate the employee’s 

previous and new pay rate. 

 Add 1/9, 2/9. This field is for faculty who have a 10- or 11-month appointment. 

 Add Other. Indicate any additional pay. 

 Total. The sum of the base salary and additional payments (1/9, 2/9, other fields). For hourly 

and daily rate employees, this field is just their hourly or daily rate. 

 Salary Distribution. Indicate the employee’s salary distribution (e.g., 12 mos. over 12 mos.; 9 

mos. over 9 mos.; or 9 mos. over 12 mos.) 

 

For special payments, use the Special Personnel Action Form (SPAF). If you have any questions 

about completing PAFs or SPAFs, contact the HR office at ext. 5352 v/tty or go to their Web 

site: http://af.gallaudet.edu/hrs/hrs.asp. 

This information is for the employee directory. If the employee works for two 
different departments, list the location where you are most likely to find this person. 

The top line applies to you, the person who prepared the PAF. The second line (tax 
forms, etc.) applies to the employee. In most cases, the tax forms should already be 
on file with HR. If the individual is a new hire or rehire, you might want to check if 
HR has already collected the appropriate forms from him/her. If not, get them and 
submit with the PAF. 
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Purchase Requisition 

Use this form to create purchase orders for purchases over $5,000 or for service contracts with 

specific terms. 

 

 
REQUISITION 

NUMBER  

FOR INTERNAL USE ONLY. THIS IS 
NOT A PURCHASE ORDER NUMBER. 
“DO NOT GIVE TO VENDORS.” 

TODAY’S  DATE 
 

  

ACCOUNT NUMBER 

 
DEPT./GRANT NAME 

 
DELIVER TO: BLDG/ROOM NO. 

 

INVENTORY ACCOUNT NUMBER (if other than above) 

 
DATE NEEDED 

 
FOR QUESTIONS ABOUT THIS REQ., 
CONTACT/PHONE 

 
SPECIAL INSTRUCTIONS: 

 

SELECTED CONTRACTOR (DO NOT WRITE IN THIS SPACE) LIST THREE SUGGESTED CONTRACTORS, ADDRESSES, 
TELEPHONE NUMBERS 

SHIP VIA: INVOICE TERMS: DELIVERY DATE: 

ITEM QUANTITY UNIT 

 
COMPLETE DESCRIPTION 

 

MODEL NUMBER, SIZE, COLOR, CATALOG 
NUMBER, MANUFACTURER, SPECIAL 
INSTRUCTIONS, ETC. 

UNIT PRICE AMOUNT 

      

      

      

      

      

TOTAL  

APPROVAL SIGNATURE 

1 
INITIATOR SIGNATURE DATE 

 
3 ADMINISTRATOR/VICE PRES. 

 
SIGNATURE DATE 

 

2 
BUDGET UNIT HEAD 

 
SIGNATURE DATE 

 
4 VICE-PRESIDENT 

 
SIGNATURE DATE 

 

 
Partial form — Not for official use 

 

GALLAUDET UNIVERSITY 
REQUISITION 

 

Create an 8-digit Requisition number using your 4-digit Budget Unit number 
plus a 4-digit number in sequence (Do not use the same number twice) 

Department budget code 

Expense account code 

For product delivery 

Usually your name & extension 

List each item or service individually; they correspond 
to the line items listed in your POSTAT report. (See 
Part II.) 

As always, include documentation when possible. 

The person who will receive the 
products/services. 

The BUH must sign all requisitions. 

Large purchases may require 
administrator signatures, 
depending on the BUH’s 
financial authority. (See 
Financial Access form below.) 

Preprinted forms have pre-
assigned req. numbers. 
For electronic forms, follow 
the directions (circled). 
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Along with all the accounting forms to spend your department’s funds, there are forms to 

manage the funds. 

Budget Revision 

Use this form to revise expense account allocations within your budget OR to transfer funds 

from one department to another. Remember, all revisions must equal zero. 

 
Today’s 
Date 

 OPTIONAL tracking 
number-up to 8 
characters 

      

 

FISCAL YEAR       PERMANENT REVISION       TEMPORARY REVISION       

 
 
 
 
 

BUDGET 
UNIT 

NUMBER 

EXPENSE/ 
REVENUE 
ACCOUN  

AMOUNT 
(IN $$ ONLY) DESCR PTION 

                        

                        

                        

                        

                        

                        

 TOTAL             

 

APPROVED 
Budget Unit 
Head 

      Date       

Unit 
Administrator 

      Date       

Administrative 
Officer 

      Date       

Finance  
Office 

      Date       

Partial form — Not for official use 
 

 

 

 

For your dept’s internal 
record keeping 

The fiscal year in which the 
revision becomes effective, 
usually the current fiscal year (if 
submitting this form well before 
September) or the next one (if 
revising around September). 

If you intend for the change to become a part of your budget going 
forward, check permanent. If it is effective for only one year, check 
temporary. 

Budget Unit Number. Department’s budget number. 

Expense/Revenue Account. Accounts being revised. Remember to keep the nonpayroll 
accounts at the “00” level. Payroll changes can be listed at the detail level. 

Amount. Use whole dollar figures. Remember that the sum of all amounts must be zero. 

Description. This line appears in GUBUDJRN. It is where you record the reason for the 
revision. 
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Financial Signature/Access Authority Form 

Use this form to change who has access to your department’s funds. Typically, you only use this 

form when there is a personnel change. 

 

FINANCIAL SIGNATURE / ACCESS AUTHORITY FORM 

GALLAUDET UNIVERSITY 

Finance OFFICE 

College Hall - Room 108 
Phone: 202 / 651-5299 (VOICE / TTY) - Fax: 202 / 448-6920 

  Funding Source: 

Print Organization Name / Project Title below:      (Note: Only 30 characters will show in the system) General  

 Endowment  

Division: Donation  

Dean-Director to which the ORG reports: Grant  

Assoc. Dean Unit, if applicable: Other *  

 * Provide details for Other Funding Source: 

 
 
_________________________________________________________   ______________________ 
Unit Administrator Signature [Directors, Associate Deans, Managers, and Department   Date 
Heads reporting to a Senior Administrator (see definition below)], required on all forms. 
 
 
_________________________________________________________   ______________________ 
Senior Administrator Signature (Special Assistants to the President;    Date 
Deans & Associate Deans reporting directly to the Provost; and 
Executive Directors & Directors reporting directly to the VP), required if $10,000 or over. 
 
 
_________________________________________________________   ______________________ 
Administrative Officer Signature (Vice President, Provost, & President), required    Date 
if $25,000 or over. 

Partial form — Not for official use 

Please indicate which one: 

 

New* Change Removal 

   

* New organizations must complete the form located at 
http://intranet.gallaudet.edu/af/Finance/neworg.html 
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 Print: name here Position Title: Signature: Please use Y or N in each box 

1             

2             

3             

4             

5             

 

Organization No. 
    

4 digits 

Department 
budget 

Most likely, you will 
check General. The 
other funds are 
special accounts. 

Identifies where your department 
falls in the University organizational 
structure. 

 

Any employee who needs access to the department’s funds must sign this form. Generally, 
anyone who receives financial access will be authorized to make purchases up to $500 and 
request petty cash. BUHs receive authority for expenses above $500, payroll authorization, 
budget revisions and access to PeopleSoft. Administrative assistants should have access to 
biweekly payroll (meaning they’re the ones who fill out the forms), PeopleSoft and, depending 
on their situation, may have authority for expenses above $500. 
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Part II: PeopleSoft Reports — Up Close and Personal 
Now that we’ve discussed “Garbage In, Garbage Out” and reviewed the accounting forms, let’s 

look at the output part of budgeting … the PeopleSoft reports. This section summarizes each 

PeopleSoft report, explaining what they contain and how to use them. 

The big picture 

Before we look at each individual report, it’s important to note that they are all summarized on 

the GUBS (Budget Status by Account) report. The arrows below show where the information 

can be found in more detail. Get to know GUBS — it’s your map through “Budget Land.” 

 

GUBR 
Revenue  Budget 

Payroll 
Encumbrances  

GUBE 
Expens e Budget 

POSTAT 
Purchas e Order Status 

GUACTJRN 
Actuals Detail 

 
The big picture — How GUBS summarizes all the reports 

The workhorses — What you’ll use every time 

If you’ve been handling your department’s budget for a while, you’re probably quite familiar 

with the Budget Status by Account and Actuals Detail reports. There’s good reason for this — 

they provide almost everything you need to know about your budget. 
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GUBS — Budget Status by Account 

GUBS should be the first stop every time you study your budget. As we mentioned earlier, it 

combines all your reports into one document, which means it’s a snapshot of your department’s 

financial situation. 

 

GUBS Summary 

 Purpose: Provide snapshot of your financial situation 

 Expenses: Shown as negatives 

 Rows: Top section is revenue; middle is payroll; bottom is nonpayroll 

 Columns:  Where you started (Annual Budget), where you are today (Remaining), 
and how you got there (Encumbered, Actual Expenses/Revenues, and Total) 

 Claim to fame: Shows you the bottom line 

 

 
Sample GUBS (Budget Status by Account) report 

 

Tour by rows. Most likely, when you open a GUBS file, you won’t see the revenue portion of 

the report — relatively few departments need a revenue budget. But if your department happens 

to be one of them, you can find your revenue budget at the top of the GUBS report. For more 

information about revenue budgets, please contact the Finance Office. 

 

The next section summarizes payroll information. It is the only part of the report that provides 

category breakdowns (i.e., accounts ending in digits other than “00”). Almost everything in 

payroll is a fixed expense, meaning the expenses are the same each pay period. As mentioned in 

Part I, payroll is encumbered to ensure your department has enough money to cover everyone’s 
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salary and benefits. The only exception to this rule is Student Compensation (5135). This 

expense is variable, depending on how many hours your student worker(s) clocked; 5135 funds 

are not encumbered. 

 

The bottom section contains nonpayroll information. Here, expenses are grouped at the general 

category level. Encumbrances in nonpayroll indicate purchase orders that have outstanding 

payments. 

 

The last row is your budget’s bottom line. It provides totals to date for each column, the most 

important of which is the Remaining value. 

 

Tour by columns. The columns in GUBS are linked through simple math: 

 

 
ANNUAL 
BUDGET 

ENCUMBERED 
ACTUAL 

EXPENSES/ 
REVENUES 

TOTAL REMAINING 

Math 
formula 

A B C B + C A - (B + C) 

Example 1,000 -300 -500 -800 200 

 

In English, it means that what you’ve set aside (encumbered) and what you’ve actually spent 

(actuals) are deducted from your annual budget to give you what’s left to spend (remaining).  

 

Keep in mind, however, that encumbered funds are funds you’ve promised to pay but haven’t 

actually paid yet. In the example above, your funds are actually $500, because the $300 that’s 

encumbered is still in your possession. Here’s a good rule of thumb: If the encumbered amount is 

in payroll, consider it money you can’t touch. The only time you can deobligate encumbered 

payroll is if there’s a personnel change in your department. If the encumbered amount is in 

nonpayroll, you can think about deobligating the funds, but you need to weigh the pros and cons 

of canceling a contract. 

 

How to use the report. Consider this report your “cheat sheet” when the BUH asks you, “How 

much money do we have left in our budget? Can we afford to do XYZ?” Scan the bottom line to 

see your budget’s vital statistics — total budget, total expenses to date, and total funds left. 

When forecasting future expenses, you could scan the Encumbered column to see how much 

money you owe on existing purchase orders. (You’ll also want to calculate your monthly fixed 

nonpayroll expenses, like pager subscriptions and phone service.) When planning future budgets, 

you could scan the Remaining column to identify areas that were under- or overbudgeted. 

GUACTJRN — Actuals Detail 

GUACTJRN (Actuals Detail) lists every expense as it was entered into PeopleSoft. If you were 

to sum the expenses by account, the totals would correlate to the rows in GUBS. Whereas GUBS 

gives you a budget snapshot, GUACTJRN shows you every single transaction that happened. 
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Data for GUACTJRN come from the accounting forms (see Part I, Garbage In, Garbage Out), 

payroll, Corporate Express, JP Morgan Chase (purchase card), and campus service departments 

(Reprographics, Telephone, Postal Services, Transportation and GIS). With so many data 

sources, it’s possible (though infrequent) to find errors in this report. You should review the 

entries regularly and report discrepancies to the Finance Office. 

 

GUACTJRN Summary 

 Purpose: Provides detail about each transaction 

 Expenses: Shown as positives 

 Rows: Each transaction 

 Columns: Data fields about each transaction 

 Claim to fame: Allows you to analyze spending behavior 

 

 
Sample GUACTJRN (Actuals Detail) report 

 

Tour by rows. Each row equals one financial transaction. At the beginning of the fiscal year, 

GUACTJRN might be only a page long. By August, however, it’s practically a book! 

Transactions (or records) are entered into PeopleSoft in the order they were received, which 

means that sometimes, you’ll find an expense from last month in the middle of this month’s 

entries. Before reconciling your report, perform a SORT by date (see Part IV, Manipulating and 

analyzing budget data) to ensure out of order entries are included. 

 

The last row of GUACTJRN totals all your expenses. Because this report tracks how much 

you’ve spent, expenses are positive numbers and reimbursements are negative. 
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Tour by columns. You probably won’t use most of the columns in the report, but they are 

necessary to record complete information about each transaction. 

 Journal and Line # are record identifiers. Give this information to Finance Office staff when 

you have questions about specific transactions. It’ll help them find the record faster. 

 Period and Date tell you when the transaction occurred. Period refers to the month of the 

fiscal year (October = 1, November = 2, etc.) 

 Org, Fund, and Acct tell you where the transactions were counted. Org is your department’s 

budget code; Fund refers to which pot of money the funds came from (general, grants, etc.); 

and Acct is the expense account. Of the three, you really only pay attention to Acct. 

 Monetary Amount, Ref, and Journal Line Description tell you how much the transaction was 

and what it was for. There’s actually a relationship between Journal and Ref. Below is a table 

that explains it. (Wow your colleagues at your next budget meeting!) 

Table 2: The Journal and Ref relationship 

Journal 
Prefix 

Journal Source Ref Description 

All 
numbers 

Interdepartmental transfer, GIS, Travel, 
Reprographics, Post Office, Other 
Finance Office entries 

Blank Varies 

AP Accounts Payable Invoice # Vendor Name 

AV Development Office Constituent ID Batch ID + Donor name 

BSS Bookstore Blank Date of Service 

EXP Staples (Corporate Express) EWAY Order # Order Number 

EXP JPMorgan Purchase Card Transaction 
YYMMDD 

Vendor Name 

EXP Telephone Month Telephone Line or 
Telephone MRC Service 

PEX Payroll Pay Period Employee Name 

SF Student Accounts Tuition or Fee Charged Student's ID # Tuition or fee description 

SF Cashier's Office Blank C/R + deposit date + 
deposit description 

 Year is the fiscal year in which the transaction was counted. 

 

How to use the report. You’ll probably use GUACTJRN the most, as it can give you the 

clearest picture of your department’s spending behavior. By using the Excel functions explained 

in Part IV, you can analyze expenses by account. For example, you might track Professional 

Development (5600) expenses over several months to see if they form a pattern (like steady 
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increases). This pattern, in turn, could guide decisions to revise budget allocations or change 

employee behavior (as in “Stop going to conferences every month!”). 

The fine tuners — What you’ll use to adjust your budget 

These reports are handy when you need to revise your budget, which should be at least once a 

year. (Budgets expire! See Part I, What is a budget?) They do not contain information about 

your actual expenses or revenue; they only look at your plans to spend or earn money. 

GUBE/GUBR — Expense/Revenue Budget 

GUBE (Expense Budget) and GUBR (Revenue Budget) are essentially the same report. GUBE, 

obviously, looks at the expenditure side of the budget while GUBR looks at earnings. These 

reports look like GUBS, and they function in much the same way, too. In this case, GUBE and 

GUBR provide snapshots of how the budget has been revised. Because these reports do not track 

expenses, positive and negative numbers indicate increases and decreases to accounts. With the 

exception of COLAs applied by HR and funding increases awarded by the president or division 

heads, the sum of all changes to the budget should be zero. 

 

GUBE/GUBR Summary 

 Purpose: Provide snapshot of changes to department budget 

 Rows: (GUBE) Top half is payroll; bottom half is nonpayroll; (GUBR) revenue 
accounts 

 Columns: Changes to the budget 

 Claim to fame: Shows how your budget has changed over the fiscal year 

 

Because most departments do not collect revenue, this section will focus only on GUBE. For 

help with GUBR, contact the Finance Office. 

 

 
Sample GUBE (Expense Budget) report 
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Tour by rows. As with GUBS, GUBE is divided into payroll allocations on top and nonpayroll 

on the bottom.  

 

Note how the sample budget above shows mostly “0.00” for nonpayroll expenses. Clearly, the 

department has not budgeted well for its initiatives. They may have enough money to cover their 

projects, but their budget should reflect how funds will be used. Remember, budget = plan to use 

money. Zero allocations = zero planning. 

 

Here’s the same budget with a little more planning. 

 

 
Sample GUBE report — revised budget plan 

 

Based on this budget, the department has staff who plan to attend a conference, because they 

have allocated funds in Professional Development (5600) and Transportation & Travel (5200). 

Likewise, this department is undertaking a major project with the help of a consultant, as 

Consultants & Advisors (5400) and Special Projects (6300) show. Finally, this department plans 

to replace some computers and has set aside funds in Furniture and Equipment (6400) to cover 

that. 
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Tour by columns. Like GUBS, the columns in GUBE/GUBR are related by math functions. 

 

 
BASE 

BUDGET 
PERMANENT 

REVISION 

BASE & 
PERMANENT 

TOTAL 

TEMPORARY 
REVISION 

REVISED 
BUDGET 

Math 
formula 

A B A + B C A + B + C 

Example 1,000 500 1,500 200 1,700 

 

Base budget is the budget you begin the fiscal year with. Often, it’s your revised budget from the 

previous year. A permanent revision is a budget change that will carry over to all subsequent 

fiscal years. In the table above, your base budget for the next fiscal year would be $1,500, as you 

made a $500 permanent revision. A temporary revision is a change to the budget for the current 

fiscal year only. Typically, you would see a temporary revision if a department is undertaking a 

special project, like a major conference. 

 

You might use permanent and temporary revisions to reallocate funds in your nonpayroll budget. 

Just remember that the revisions must equal zero. Continuing our budget illustration, here’s how 

permanent and temporary revisions would be recorded: 

 

 
Sample GUBE report — permanent and temporary revisions 

 

Notice the Total Non-Payroll line. The sums of the permanent revisions and temporary revisions 

are both zero. Funds were reallocated from General Office Expenses (5300) and Special Projects 

(6300). Based on this budget, we can tell that the use of a consultant is intended for this fiscal 

year only. The other expenses will carry over to subsequent years, meaning the department plans 
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to send staff to professional development conferences and replace computer equipment annually. 

(Nice department!) 

 

How to use the report. This report is especially handy when doing your annual budget review to 

see if your department’s priorities and activities will be appropriately funded. It will give you an 

overview of what needs to be changed and how to shift the funds. 

GUBUDJRN — Budget Detail 

In the previous section, we compared GUBS and GUBE/GUBR. As you might have guessed, 

GUBUDJRN is comparable to GUACTJRN, except this report tracks details about budget 

changes. And like GUBE/GUBR, GUBUDJRN does not track any expenses. 

 

GUBUDJRN Summary 

 Purpose: Provide details about budget changes 

 Rows: Individual revisions to budget 

 Columns: Data fields about each revision 

 Claim to fame: Provides the “Why?” behind budget revisions 

 

 
Sample GUBUDJRN (Budget Detail) report 

 

Tour by rows. Each row is an individual budget revision. If you submit several budget revisions, 

GUBUDJRN provides a history of when and why the revisions happened. Most likely, you won’t 

see many rows, as you shouldn’t make frequent changes to your budget during the fiscal year. 

 

Let’s continue with the sample budget from the GUBE section. After we submit our budget 

revision form, our GUBUDJRN might look like this: 
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Sample GUBUDJRN report — outlined area shows nonpayroll budget revisions 

 

Notice that all the nonpayroll budget revisions (outlined area) equal zero. The first six nonpayroll 

revisions are permanent, meaning they will be incorporated into all future budgets. The last two 

are temporary, indicating they are for this fiscal year only. 

 

Tour by columns. Each column represents a data field about the revision. 

 

 Journal is the record identifier. If you need to discuss a revision, have this info handy to help 

the Finance Office locate the record. 

 Date is when the revision went into effect. Any item listed as “Base Budget Forward” should 

show October 1 as the date, as that’s the start of the fiscal year. 

 Fund, Dept, and Acct show where the revision was recorded. Fund pertains to which 

University fund provides money for this budget (general vs. grants), Dept is the department 

(as opposed to Org in GUACTJRN), and Acct is the expense account.  

 Budget is the fiscal year budget that is being revised. In our example, it’s the 2007 fiscal year 

budget. 

 Type, Amount, and Descr tell you whether the change is permanent or temporary (Type), 

how much it was for (Amount), and the reason for it (Descr).  

 

How to use the report. Like GUBE/GUBR, this report is handy for budget planning. It provides 

you with the history behind your budget revisions. It also confirms whether or not payroll or 

funding changes were applied to your budget. 
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The supporting cast — What you’ll use for encumbered expenses 

For the most part, you shouldn’t adjust encumbrances. However, it’s nice to know some details 

about them, so that’s where the Payroll Encumbrances and POSTAT reports come into play. 

They help you track your department’s major expenses. 

Payroll Encumbrances 

The Payroll Encumbrances report shows you each employee’s total salary and benefits and how 

much of their salary/benefits remains to be paid. It also shows the fixed expense attributed to 

each employee per pay period. 

 

Payroll Encumbrances Summary 

 Purpose: Provide detail about payroll 

 Expenses: Shown as positives 

 Rows: Salary and benefit expense by employee 

 Columns: Data fields for each expense 

 Claim to fame: Shows payroll expenses by pay period 

 

 
Sample Payroll Encumbrances report 

 

Tour by rows. There are two entries per employee — one each for salary and benefits. Only 

employees on the University payroll will appear on this report; student workers, for example, are 

not included here. (They are shown on GUACTJRN.)  

 

This report shows how much payroll remains to be paid; it does not show you how much you’ve 

already paid each employee. To find out how much you’ve already paid, you have two options. 

The easy option is to hop over to your GUBS and look at the Actual Expenses/Revenues column. 
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Of course, the figures given there only tell you how much you’ve paid the entire group; it doesn’t 

break down the numbers by employee. 

 

The other option is to subtract the Remaining Encumbered from the Annual Salary, which allows 

you to calculate amounts for each employee. So, for Joe Employee 1, salary and benefits paid to 

date would be: 

$110,251 - 42,404.20 = $67,846.80 in salary and 

$31,422 - 12,085.20 = $19,336.80 in benefits. 
 

Tour by columns. The data fields are pretty self-explanatory. 

 

 Account is the expense account. Everything in this column should begin with a 51. 

 Description is the employee classification. You might see other categories of employees here, 

like Short-term Faculty (5115) or Regular Status Staff - Non-exempt (5123). 

 Annual Salary includes both the payments for wages and benefits. This is the total amount 

paid to the employee for the fiscal year. 

(The default mode in PeopleSoft shows this amount rounded to the nearest whole dollar. 

You can see the exact amount by highlighting the cells then typing CTRL+1. In the 

Decimal places box, enter a 2 then click OK.) 

 Bi-weekly Gross is the amount that is paid to the employee per pay period. It is 1/26th of the 

Annual Salary. For faculty who are paid over 9 or 10 months, this figure may differ from the 

actual expense. For example, 9-month faculty might be paid over 19 pay periods instead of 

26, so they are paid 1/19th of the Annual Salary, not 1/26th. (The 1/19th payments are 

recorded in GUACTJRN.) 

 Remaining Pay Periods shows the number of pay periods left in the fiscal year. In our 

example, there are 10 pay periods remaining, which means 16 pay periods have occurred. 

 Remaining Encumbered is the amount of the annual salary that has yet to be paid. It should 

equal (Bi-weekly Gross)  (Remaining Pay Periods). Nine- and 10-month faculty figures 

may be different from what the report shows. 

 

How to use the report. You probably won’t need to use this report until calculating merit 

increases. Or it can be handy if there’s a personnel change in your department. (For example, if 

an employee leaves mid-year, their remaining encumbered salary could be deobligated and 

reassigned to other portions of your budget.) By the way, when the president announces a 

General Pay Increase, HR automatically applies it to everyone’s salaries and benefits. You’ll see 

the adjustments appear on GUBUDJRN and the figures in Payroll Encumbrances will change 

accordingly. 

POSTAT — Purchase Order Status 

POSTAT (Purchase Order Status) lets you track payments made to vendors via purchase orders. 

Typically, you issue purchase orders for purchases over $5,000 or for service contracts with 

specific terms of agreement (such as using a project consultant). The purpose of issuing a 

purchase order is to ensure your department has sufficient funds to pay the full contract. As 

payments are made to the vendor, they are recorded both in GUACTJRN and POSTAT. 
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POSTAT Summary 

 Purpose: Track payments made and remaining on purchase orders 

 Expenses: Shown as negatives 

 Rows: Items on a purchase order 

 Columns: Data field about each item 

 Claim to fame: Shows what you owe on your big ticket items 

 

 
Sample POSTAT (Purchase Order Status) report — Page 1 

 
Sample POSTAT (Purchase Order Status) report — Page 2 

 

Tour by rows. Each row corresponds to an item on a purchase order. If a purchase order 

contains multiple items, it will have multiple rows in the report. For example, the Apple 

Computer purchase was for two items (iLife 2006 single license and iLife 2006 volume purchase 

licensing), so each item is listed separately. 

 

This report tracks both amounts due and payments, so it looks different from the other budget 

reports. Each item is listed at least twice — once for the amount due and one or more times for 

each payment made. In this example, the iLife licenses have been paid in full. You see a positive 

number in the amount column when the purchase order is issued and a negative amount when a 

payment is applied. 

 

Tour by columns. There’s a lot of data associated with each item on a purchase order, so the 

columns span two pages. 

 

 PO ID is the purchase order number. It’s also the best way to identify the purchase order if 

you have a question for Contracts and Purchasing. 

 PO Date is the date the purchase order was issued. It is not the date the requisition was made. 
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 PO Status tells you if the purchase order is active or not. Dispatched means it’s ready to use. 

Completed means either the purchase order has been paid in full or the department has 

deobligated or closed it. 

 Vendor tells you who is providing the product/service. 

 Buyer identifies who initiated the purchase order.  

 Req Number is the requisition number, taken from the purchase requisition form you 

submitted to Contracts and Purchasing. 

 Line Status tells you which portions, if any, of the purchase order have been paid. Active 

means the item is ready to use; Closed means the item has been received/completed; and 

Cancelled means you no longer need the item and have requested its deletion (deobligation) 

from the purchase order. 

 Line identifies the items of a purchase order. It essentially numbers each part of the purchase 

order. In our example, there are two purchase orders. The first one is for only one item (Web 

site design); the second one is for two (iLife purchase and volume license). 

 Item Description tells you what the item is. 

 Fund, Org, and Acct tell you how the expense is recorded. As with the other reports, Fund 

indicates which University fund the money comes from (general vs. grant or other); Org is 

your department’s budget code; and Acct is the expense account. 

 Budget Yr is the fiscal year in which the purchase order exists. If you have a contract that 

runs from August to December, you would have to issue two purchase orders — one for this 

fiscal year and one for the new fiscal year that begins on October 1. POSTAT shows only 

purchase orders for the current fiscal year. 

 Voucher records the check number if the University has issued a payment on the purchase 

order. This column is an easy way to tell if the row shows an amount due or an expense. 

(Amounts due don’t have Voucher entries.) 

 Amount shows either the purchase order amount or payments made. In our example, we see 

that $56,000 of the total $84,000 has been paid on the first purchase order. The second 

purchase order has been paid in full. 

When a purchase order is issued, the amount appears as an encumbrance on the GUBS 

report. As payments are made, they are deducted from the Encumbered column and 

added to Actual Expenses. 

 

How to use the report. This report is the best place to track any activities related to a purchase 

order. For example, if you don’t clearly reference the purchase order on an invoice, the Finance 

Office may just issue a check. Your department will have paid the vendor but the check won’t 

show on the purchase order. If this happens, you should contact Contracts and Purchasing to 

have the payment amount deobligated. POSTAT is also useful for calculating outstanding 

payments on purchase orders when you forecast your department’s remaining funds. 
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Part III: Suggested Budget Practices 
In this section, we provide suggestions for tracking your department’s budget more efficiently. 

These are suggestions only; you may develop routines that are better suited to how you manage 

finances and plan future activities. 

Develop a budget routine 

Probably the easiest way to monitor your budget is to designate specific days (such as the 1st and 

15th of the month) as “budget days.” On these days, you would spend time reviewing the reports. 

This habit, more than any other, will help you become more familiar and comfortable with your 

department’s budget. 

 

By consistently downloading reports every month, you can more easily identify new versus 

reconciled records. You will also be able to spot patterns in spending behavior. Most 

importantly, the time needed to review reports would eventually decrease as you get more 

practice looking at the information contained in them. One month of expenses is a lot easier to 

reconcile than two or three months’ worth. So the longer you go between “budget days,” the 

longer your “budget wrestling session.” 

 

It’s one thing to analyze the information in a budget; it’s another to make it useful to someone 

else, notably the BUH. So, the second step of your budget routine might be noting your 

observations in a report. This serves two purposes: (1) it helps the BUH plan department 

activities better; and (2) it serves as a reminder to you of what you found when your next budget 

day comes around.  

 

The report should be only one page — too long and it will become more of a burden than a help. 

Think bullet points. Think big picture. Think about what the BUH would need to know if s/he 

has only one minute to read the report. Suggested information to include: 

 

 Top 3 (or 5) areas of spending — the nonpayroll accounts where your department spent the 

most money since the last budget day 

 Payments made (or not made) on purchase orders 

 New purchase orders issued (if applicable) — Initiating a new purchase order will create an 

encumbrance, which affects your bottom line. 

 Reminders of upcoming expenses — If you know your department needs funds for an 

upcoming activity, a gentle reminder could help the BUH plan for the expenses accordingly. 

 How much is remaining in your budget — Remember to factor encumbrances, monthly fixed 

expenses (like phone service) and upcoming expenses into your calculations. 

 Revisions that have (or haven’t yet) been incorporated into the budget, if you submitted a 

budget revision request 

 Recommendations for revising the budget, if you notice areas that are “out of whack.” 

Remember that you also must identify account(s) to provide the funds to the account(s) that 

need them. 
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Resources to help you budget 

Budget processes. You can always contact the Finance Office for assistance with a budget 

process, such as completing forms or correcting errors in a report. For assistance with purchase 

orders, contact Contracts and Purchasing. They can help you with purchase requisitions, 

deobligating funds, and extending contracts to a new fiscal year. Finally, for personnel actions 

and anything related to payroll, contact Human Resources. 

 

Key contacts 
Accounting: Finance Office — College Hall, Room 108 • ext. 5299 v/tty 
Purchase orders: Contracts & Purchasing — College Hall, Room 313 • ext. 5533 v/tty 
Payroll: Payroll Office — College Hall, Room 320 • ext. 5293 tty 

 

Budget data. Remember that PeopleSoft data come from multiple sources. The Finance Office 

can assist you with most data issues, especially those that come from other departments (GIS, 

Reprographics, Postal Services, ITS and Transportation). You can also verify purchase card 

expenses at the JP Morgan Chase Web site, http://www.paymentnet.com. When you login, you 

can review your purchases and assign them the correct accounts. 

 

Budget concepts. The Finance Office maintains a list of accounting terms on their Web site at 

http://finance.gallaudet.edu/terms.html. They also have common accounting forms and expense 

account codes on the University intranet. You need to enter your Bison/Campus username (using 

the format campus\firstname.lastname) and password to access these Web pages. 
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Bottom Line 

How to’s 

This section provides summaries of how to perform common budget tasks. Terms in SMALL CAPS 

are Excel commands; underlined terms are identifiers (column titles, window names, etc.)  

How to determine your bottom line 

ACTION REASON 

Open GUBS. GUBS summarizes expenditures and 
revenues. 

Look at the last line, Net Total. Net Total adds the totals for payroll and 
nonpayroll budget, encumbrances, 
expenses, and remaining funds. 

 

 

How to determine your actual remaining funds 

ACTION REASON 

Open GUBS. GUBS summarizes expenditures and 
revenues. 

Look at the last line, Net Total. Net Total adds the totals for payroll and 
nonpayroll budget, encumbrances, 
expenses, and remaining funds. 
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ACTION REASON 

Calculate: 

Remaining - Nonpayroll Encumbered 
-69,476.77 - (-28,000) = -41,476.77 

(See red circles on illustration above.) 

Encumbered is listed as a negative value 
so you are subtracting a negative, which 
means you’re really adding the 
Encumbered value to Remaining. 

Funds in the Encumbered column are 
funds that have been promised but are still 
in your possession. By adding them back 
to the Remaining amount, you can 
calculate how much money you still have 
on hand. 
 
Use only the Nonpayroll Encumbered 
amounts; Payroll Encumbered shouldn’t 
be altered unless your department has a 
personnel change. 

How to find a specific amount or payee in your Actuals Details report. 

ACTION REASON 

Open GUACTJRN. GUACTJRN lists all your transactions, so 
you can search entries for amounts, 
payees, or any other information you want. 

Type CTRL+F (FIND). Enter your search 
criteria in the box and click Find Next. 

The FIND command searches your 
worksheet by rows or by columns and 
highlights the first cell it finds with your 
criteria. 

 

Use GUACTJRN to search Monetary Amount 
or Journal Line Description fields to find 

specific payments. 
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ACTION REASON 

If the found cell is not what you were 
looking for, you can click FIND NEXT until 
you find the record you want. 

If multiple cells have your criteria, Excel 
will highlight each one until it reaches the 
end. Some found cells may contain your 
search criteria as a portion of its cell (e.g., 
a search for “AV” will yield “AV” and also 
“Bette Davis” and “David Copperfield” 
because they all have an “AV” in them.) 

If your criteria is not found in the 
worksheet, you may need to check the 
spelling or amount to ensure you have 
correct information. 

If a FIND yields no results and you are 
certain your information is correct, it could 
mean that the item has not yet been 
entered into PeopleSoft. Wait a few days 
and try FIND again. 

If you find what you want, click Close. The FIND window stays open otherwise. 

How to determine outstanding payments on a purchase order 

ACTION REASON 

Open POSTAT. POSTAT summarizes actions on all 
purchase orders. 

Go to the Amount column and calculate 
the total for all entries related to the 
purchase order in question. 

The Amount column lists both the total 
amount due and the payments made toward 
the purchase. Positive numbers are the 
amounts due; negative numbers are 
payments made (expenses). 

 

Highlight Amounts related to 
P.O. and look for sum in 
bottom status bar 
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How to associate a payment with a purchase order 

ACTION REASON 

When you receive an invoice from the 
vendor, include: 

OK to pay 
P.O. # 
BUH Signature 
Date 

When staff see a purchase order number, 
they know immediately to associate the 
payment with the P.O.  

Payments made on P.O.s will decrease 
encumbrances. Otherwise, regular checks 
increase expenses without affecting 
encumbrances. 

If a payment was made and was not 
applied to the purchase order, contact 
Contracts and Purchasing to adjust the 
encumbrance. 

 

 

OK to pay 

P.O. #987654 

El Guapo 

5/8/07 
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How to establish a budget that reflects your department’s actions and 
priorities 

The information that follows is a repeat of the example given in Part I, How to establish a 

budget. Illustrations of Excel commands can be found in Part IV. 

 

ACTION REASON 

Open GUACTJRN. GUACTJRN lists all your transactions so 
you can subtotal expenses by account. 

FILTER for nonpayroll expenses then SORT 
by account. 

See Part IV to review FILTER and SORT. 

Work with nonpayroll expenses only, 
because they are the ones your 
department can control. Payroll is 
generally predetermined by HR. 

SORT by account to group all similar 
expenses together. 

SUBTOTAL the Monetary Amount column. See Part IV to review SUBTOTAL. 

Subtotaling allows you to see how much 
you’ve spent on each account. 

Aggregate accounts under the general 
categories (5200, 5300, etc.). Compare 
the totals to what exists on your current 
budget. 

Budgets look at the big picture. You used 
the details in the previous steps to help 
you guesstimate values for major expense 
areas. 

Submit Budget Revision forms, if 
necessary, to move funds within your 
budget. Remember to determine if the 
change will be permanent or temporary 
and to keep all changes equal to zero. 

Remember, budget = plan to spend $$$. 
The more accurately you allocate funds, 
the easier it is to eyeball how well your 
department is carrying out its activities and 
meeting its goals. 
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Part IV: Working with Excel 
You thought budgeting was hard enough, but now you’ve got to use Excel! This section will 

introduce you to basic Excel commands that you might use to analyze budget reports. 

Setting the stage: Preparing your document for analysis 

Learning how to use a computer program is challenging. It can be especially frustrating to read a 

manual, if you learn better from hands-on instruction or videos. 

 

This section will try to bridge that gap by using screen shots to illustrate the concepts. We’ll use 

special formatting, like SMALL CAPS for commands and underlining for identifiers or parameters 

(like which window we’re in or what to set a field to). To explain where commands can be 

found, we will use MENU > COMMAND > SUBCOMMAND. 

 

If you see… …it means 

FILE > SAVE AS Go to the File menu to find the Save As 
command. 

FORMAT > COLUMN > HIDE Go to the Format menu, then to Column. 
You will get a submenu where you can 
find Hide. 

Save in In the dialog box, there’s a window called 
“Save in.” Make sure the info in the box is 
what you want. 

In the Fit to: field, enter 1. There’s a field called “Fit to.” Enter a “1” in 
the box next to it. 

 

Occasionally, we’ll explore a topic that is slightly advanced, such as customizing filters. 

Knowing these topics can help you become more proficient at using Excel, but they aren’t 

necessary if you just want to know the basics. We’ll highlight these discussions as Detours so 

you know you can skip the section if you want to. 

Reviewing the basic commands 

Excel has hundreds of commands to manipulate data. This section explains the commands you 

will probably use the most. These are the basics — you will learn other, more involved 

commands for analysis later in this manual. 

 

Where possible, we recommend using keyboard shortcuts rather than the mouse, because typing 

is more efficient. After you’ve used the keyboard shortcuts a few times, you’ll find them easy to 

remember as well as big time and energy savers. 
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Table 1: Common Excel commands 

Command Keyboard shortcut/ 
Location 

What it does 

FILE MENU 

Open CTRL+O Opens a file. 

Close CTRL+W Closes a file; you can save the file before closing. 

Save CTRL+S Saves your file. 

Page Setup… FILE > PAGE SETUP Controls how your report prints (full scale vs. 
reduced, paper orientation, margins, etc.) — great 
tool to minimize paper waste. 

Print Preview FILE > PRINT PREVIEW Allows you to check how your report will print — 
also helps minimize paper waste. 

Print CTRL+P Prints your document. 

EDIT MENU 

Undo CTRL+Z For your “oops” moments — this command undoes 
whatever action you just did. You can undo several 
steps, by retyping CTRL+Z as many times as 
needed. 

Redo CTRL+Y Repeats whatever action you just did — useful for 
commands that don’t have keyboard shortcuts, like 
inserting a row. Insert your first row, then type 
CTRL+Y to insert more. 

Cut CTRL+X Removes your selection from the document so you 
can insert it elsewhere. 

Copy CTRL+C Copies your selection so you can insert it 
elsewhere. 

Paste CTRL+V Inserts your cut or copied selection into the 
worksheet. 

Find CTRL+F Searches for data you specify. 
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Command Keyboard shortcut/ 
Location 

What it does 

INSERT MENU 

Rows INSERT > ROWS Inserts a blank row — useful if you want to 
separate groups of data instead of seeing one long 
list. 

Columns INSERT > COLUMNS Inserts a blank column — useful if you want to add 
information that isn’t in PeopleSoft to each 
transaction (e.g., who created the expense). 

Worksheet INSERT > WORKSHEET Inserts a blank worksheet into your file — great for 
analyzing large blocks of data without destroying 
your original. 

 

Besides these commands, you’ll also highlight cells to calculate totals quickly. Suppose you 

want to calculate only the first 12 transactions in this month’s GUACTJRN report. You would 

click on the first transaction and drag the mouse down to the 12th. The status bar at the bottom of 

the screen will show you the total of whatever you highlighted. 

 

To use the highlight technique with nonadjacent cells, hold down the CTRL key and click your 

mouse on the cells you want to add. (Click a cell again to deselect it from your total.) The sum 

will appear in the bottom status bar. 

Saving your work and the original data set 

As you learn to use Excel, you’ll find it easy to dive in and play with the data. After you’ve 

completely dissected your worksheet, you might find that you made a mistake at the very 

beginning and need to go back to square one. Unfortunately, you forgot to save the original, so 

now you have to reenter PeopleSoft and download a whole new report. Ugh! Learn to prep your 

files first and save yourself a lot of frustration. 

 

Ideally, you already have a folder for your budget files. If you don’t, take time now to create one 

so you can easily find all your reports when you need them. 

 

Creating a budget folder 

1. Click on your Desktop. 
2. Right-click your mouse then select NEW > FOLDER. 
3. Rename the new folder something useful, like Budget Files. 

 

Back to where we left off …. Let’s save your report first. 
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Saving your PeopleSoft report 

1. In Excel, select FILE > SAVE AS. 
2. Make sure the Save in window shows Budget Files. 

a. If it doesn’t, select DESKTOP > BUDGET FILES. 
3. Pick a useful name for the report like 051507-BudgetStatus. 
4. Hit SAVE. 
5. All subsequent saves can be done with CTRL+S (SAVE). 

 

About naming files. It’s best 

to include the date at the start 

of your file name, so you can 

easily locate and identify the 

report(s) you want. 

 

It’s also good to avoid using 

spaces and periods in your file 

names. (The spaces and periods 

affect how computers process 

information about a file.) 

 

 

 

 

Now that you’ve saved your report, we need to copy the original data. It’s best to work with the 

copy, because if something goes awry, you can always go back to the original. 

 

File location: Make sure 

you select your designated 
budget folder. 

Includ e date and 
type of report in the 

new file name. 
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Copying the original data and renaming worksheets 

1. Right-click on the worksheet tab, Sheet1. 
2. Select MOVE OR COPY …. 
3. Check the box next to Create a copy and click OK . 
4. Right-click on the new worksheet tab and select RENAME. 
5. Rename the sheet something useful, like Use This. 
6. You can also rename the original worksheet. Right-click on the worksheet tab for 

Sheet1 and RENAME it Original. 

 

Creating a copy of a worksheet 

Viewing reports on the screen and in print 

Some PeopleSoft reports are large, requiring you to scroll up and down frequently on the screen. 

In print, these reports can take up several pages. You can save time and resources by using 

FREEZE PANES and PAGE SETUP. 

Keeping titles in view 

FREEZE PANES allows you to keep a portion of your worksheet stationary and, therefore, visible 

on your screen. It’s especially useful when looking at the long list of transactions in 

GUACTJRN, as titles remain visible to remind you what’s in each column. Using this command 

does NOT change any data in your worksheet. It just changes how you view it. 

 

 

Step 2 

Step 3 
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Using FREEZE PANES 

1. Click on the cell immediately below and to the right of where you want to freeze. 
a. If you want to freeze only rows, click on the first cell of the row below 

where you want the freeze. 
b. If you want to freeze only columns, click on the topmost cell of the column 

to the right of where you want the freeze. 
2. Go to WINDOW > FREEZE PANES. 
3. When FREEZE PANES is on, you will see thin black lines marking where the freeze 

begins. 
4. To undo FREEZE PANES, go to WINDOW > UNFREEZE PANES. 

 

You probably won’t need to freeze a 

column when working on your budget 

reports, but it can be useful if you find 

yourself scrolling left-right a lot. 

 

Detour! 
Related to freezing panes is 

designating a title row/column for 

printed reports. When you designate a 

title row/column, Excel automatically 

prints it on every page. 

 

 

(Left) In GUACTJRN, select cell B8 then 

FREEZE PANES to freeze titles across the top. 

 

Detour! Setting print titles 

1. Go to FILE > PAGE SETUP. 
2. Select the Sheet tab. 
3. In the second section, Print titles, enter the row/column that you want to appear as a 

title. 
a. To select rows, click on the WORKSHEET icon next to Rows to repeat at 

top. 
b. To select columns, click on the WORKSHEET icon next to Columns to 

repeat at left. 
4. You can choose multiple rows/columns by dragging across the entire area you want 

repeated. 
5. After selecting the title rows/columns, click on the DROP WINDOW icon and click OK. 

 

 

Click on cell just below 
and to the right  of where 
you want freeze to begin 
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Setting print titles 

Printing budget reports (Page Setup) 

Have you ever tried to print GUACTJRN only to have a 

single column cross over to a second page, giving you 15 

pages of what you need … and 15 pages of nothing but a 

column of “2007s”? It kills the environmentalist in you, 

doesn’t it? Well, you can control how your reports print 

using the PAGE SETUP command.  

 

PAGE SETUP controls different printing aspects of your 

worksheet, such as page specifications, margins, the header 

and footer, and print area. For this section, we will focus 

only on page specifications. 

 

For some reports, like GUBS, it’s best to see everything laid out on one page. 

 

Printing budget reports on one page only 

1. Go to FILE > PAGE SETUP. 
2. Choose the Page tab of the dialog box. 
3. In the second section, Scaling, select the Fit to: button. 
4. Enter a 1 in both boxes so it reads: 1 page(s) wide by 1 tall. 
5. Click OK. 

 

 

Click here to 
select title row(s). 

Sheet 
tab 

Dotted line indicates 
title selection. 

Click this icon 
to finish. 
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Print on one page only 

Print one page wide by  long 

 

For other reports, like GUACTJRN, it’s best to see entire entries on one page. However, because 

the actuals are a long list, you can’t tell how many pages the report will be. In this case, you’d 

use the following format: 

 

Printing budget reports one-page wide by  pages long 

1. Go to FILE > PAGE SETUP. 
2. Choose the Page tab of the dialog box. 
3. In the second section, Scaling, select the Fit to: button. 
4. Enter a 1 in the first box, page(s) wide. In the second box, delete the 1 so the box is 

blank. 
5. Click OK . 

 

Before printing, you can check that everything is laid out the way you want. By doing a PRINT 

PREVIEW, you can see exactly how the pages will be printed, including how many pages the 

entire document will be. 

 

 

 1 in both 
boxes 

 

Leave 
blank 
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Previewing a document before printing 

1. In the Excel toolbar, click on the magnifying glass icon  
 OR go to FILE > PRINT PREVIEW. 

2. In the bottom left corner, Excel shows you how many pages are in your document. 
3. Scroll through the preview to check your report will print the way you want. 

Manipulating and analyzing budget data 

The fun with Excel and PeopleSoft begins when you start moving data around to find patterns 

and other useful information within your report. The three most common functions you will use 

are sorting, filtering, and subtotaling. 

Sorting data 

Sorting means to order the data from highest to lowest (or lowest to highest). This function is 

particularly useful for grouping like entries together. For example, when you sort GUACTJRN 

by account, you can clearly see how many expenses have been attributed to each account. 

 

Sorting does NOT change your data. It only changes how you see it. 

 

Sorting data — One-click method  

1. Click on a cell in the column that you 
want to sort. The cell MUST contain an 
entry. 

2. Click on the SORT AZ icon. 
 
 

GUACTJRN sorted by account 

 

 

 

 

Expense s sorted 
by account 



61 

Probably the biggest pitfall with sorting is that once you sort the 

data, it’s hard to unsort it. Normally, that’s not a problem because 

the data hasn’t changed. Still, if the sort isn’t what you wanted 

AND you haven’t done anything else (like enter new data or save 

the document), you can hit CTRL+Z to UNDO the sort. 

 

If you can’t undo the sort (see right), you can always go back to 

your original data, make another copy, and start over. (This is why 

you should always work from a copy, not the original.) 

 

Detour! 
Excel allows you to sort up to three fields simultaneously. Sorting by multiple fields is useful 

when you want subsets of data to be ordered. For example, you might want to track expenses 

over time — have your 5334 (Telephone Usage) charges increased over time? You would sort by 

account first to group all the 5334 entries together and then by date to see if the charges form any 

patterns. 

 

Detour! Sorting data by multiple fields 

1. Click on any cell with data. 
2. Go to DATA > SORT…. 
3. In the Sort by box, select the field you want sorted first. 
4. In the first Then by box, select the second field you want sorted. 
5. In the second Then by box, select the third field you want sorted, if applicable. 
6. Click OK. 

 

Still on the detour! 
When you sort by multiple fields, Excel sorts in the order you tell it to.  

 

Here’s a table that is sorted by Date, then 

Account, then Amount. Note that only the Date 

column is completely ordered. 

 

The other 2 columns are ordered based on their 

dates first. For the 2 entries on 01/05/07, they are 

in Account order first because that was the order 

of our sort. 

Date Account Amount 

01/01/07 5213 14.00 

01/02/07 5219 14.00 

01/05/07 5213 16.00 

01/05/07 5219 10.00 

01/08/07 5221 65.00 
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Here’s the same table sorted by Account, then 

Date, then Amount. Again, notice that only the 

Account column is completely ordered. 

 

The pair of entries for 5219 are listed in 

chronological order and descending amount. 

That’s because we told Excel to order first by 

Date and then by Amount. 

Date Account Amount 

01/01/07 5213 14.00 

01/05/07 5213 16.00 

01/02/07 5219 14.00 

01/05/07 5219 10.00 

01/08/07 5221 65.00 

 

Finally, here’s the table sorted again, this time by 

Amount, then Date, then Account. Again, notice 

how the presentation of data changes based on 

how we sorted. 

Date Account Amount 

01/05/07 5219 10.00 

01/01/07 5213 14.00 

01/02/07 5219 14.00 

01/05/07 5213 16.00 

01/08/07 5221 65.00 

 

What’s the point of showing you all of these tables? 
SORTING ORDER MATTERS! 

Filtering data 

Filtering means selecting a specific subset of information to appear. For example, you can filter 

data so only 5200 accounts appear or only expenses from January 1 to January 31 appear. 

 

When Excel filters data, only the data you specify will show on the screen. As with sorting, 

filtering does NOT change your data. It only changes how you view it. In this case, filtering 

gives you a “lens” through which to view a specific set of data. 
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Filtering data 

1. Click on a cell with data. 
2. Go to DATA > FILTER > AUTOFILTER. 
3. You should see menu arrows appear for each column title (see below). 
4. Use menus to select your filter. 

Example: Let’s filter so we see only our FedEx expenses. 
Go to JOURNAL LINE DESCRIPTION > FEDEX (see below). 

Filtering data, step 3 

Filtering data, step 4 

 

After you apply the FedEx filter, you 

may see the total expense figure at 

the bottom of the Monetary Amount 

column (see right). Remember that 

filtering just lets you view your data 

differently — in essence, filtering 

squishes all the non-essential cells to 

0 height (thus hiding them). Rows at 

the bottom move up, as does the data 

in them. 

 

So, how do you figure out your total 

FedEx charges? Highlight the 

Monetary Amount cells and look at 

the bottom status bar. You will see 

your FedEx charges total $200.64. 

 

When you’re finished looking at the 

FedEx charges, you can filter for a different expense or you can remove the filter to see all your 

data again. 

 

 

Total 
expenses  

FedEx total 

(Sum of 
highli ghted area) 

 

Auto filter 
menu arrow 

 

AutoFilter 

dropdown 
menu 
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Removing a filter 

1. Go to the menu where you applied the 
filter. In our example, it’s Journal Line 
Description. 

Hint: Look for menu arrows that 
have turned blue. Blue arrows 
indicate a filter has been applied. 

2. Scroll to the top and select (ALL). 

 

 

Detour! 
Sometimes, you want to filter by something that doesn’t appear on the menu. For example, you 

want to see all expenses in the 5300 account, but the ACCT filter menu shows each individual 

account you used (5322, 5333, 5334, etc.). You can customize! 

 

Detour! Customizing a filter 

Let’s filter for all 5300 expenses. 
1. Go to ACCT > (CUSTOM…). 
2. In the first dropdown menu, select 

begins with. 
3. In the text window, enter 53. 
4. Click OK. 
5. You should now see only your 5300 

expenses. 

 

 

More on the detour! The customize filter operations depend on whether the data is text or a 

number. Excel differentiates between numbers and numbers stored as text. You can tell which 

one you have by looking at the top status bar when you click on a cell. If the number is preceded 

by an apostrophe ( ' ) or if a green flag appears on the cell, you have a number stored as text.  

 

 

 

Enter 53 to filter 

only  for 5300 
expenses.  
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If you have numbers, you can filter data 
with math operators. 

If you have numbers stored as text, you 
can filter data with logic operators. 

Example: 
equal to ( = ) ; is not equal to ( ≠ ) 
is greater than ( > ), is less than ( < ) 

Example: 
begins with; does not begin with 
contains 

(These operators don’t have math 
symbols.) 

Calculating subtotals (Putting it all together) 

The SUBTOTAL command is useful when you want to quickly calculate how much you spent by 

account in GUACTJRN. However, before you can use SUBTOTAL, you need to prepare your data. 

 

Probably the biggest challenge of using Excel is figuring out what you need to do to make the 

data analyzable. It requires methodical thinking because you will most likely get data that is 

completely out of order and includes a lot more entries than you really want. 

 

Here’s a scenario when you would use SUBTOTAL: You want to find out how much your 

department spent, by account, on all nonpayroll expenses from January 1 to March 31 (2nd 

quarter of the fiscal year). 

 

First, let’s walk through a step-by-step checklist of what you need to do. 

Table 3: Breakdown of thought process for sample budget analysis 

Action Reason 

 SORT raw data by date. Orders all expenses so we can easily 
identify January 1 to March 31 
transactions. 

 COPY and PASTE relevant cells to new 
worksheet. 

Allows us to isolate the relevant data so 
it’s easier to manipulate. 

 COPY and PASTE column titles to new 
worksheet. 

Allows us to apply AUTOFILTER and SORT 
to the new worksheet. (Without column 
titles, AUTOFILTER and SORT are harder to 
use.) 

 RENAME the worksheet. Allows us to easily identify our work. 

 FILTER the data for nonpayroll 
transactions. 

Removes payroll expenses from our 
analysis. 

 SORT new data set by account. Groups expenses by account. 
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Action Reason 

 SUBTOTAL expenses by account. Calculates totals by account. 

 

Remember this is a multi-step process. If you get confused about why we are doing a certain 

function, review the checklist above. 

 

Preparing your data to SUBTOTAL 

PeopleSoft data appears in the order they were entered into the system. We need to 
sort the data in chronological order, so we can find just the January 1 to March 31 
expenses. 
 
1. Click on a cell in the Date column. 
2. Click on the SORT AZ icon. 

Next, we want to look at only the January 1 to March 31 entries. It’s easier to work with 
a large subset of data by isolating it onto its own worksheet. 

Copying and pasting records into a new worksheet 

1. Place the cursor in the left margin (where the row numbers appear) to highlight an 
entire row at once. 

2. Highlight the rows from January 1 to March 31. 
3. Type CTRL+C to COPY the selected cells. 

a. Do NOT type anything else while the cells are highlighted. (If you do 
accidentally type something, hit CTRL+Z to UNDO your last action and 
repeat steps 1-3.) 

4. Go to INSERT > WORKSHEET. 
5. In the new worksheet, click on the topmost, leftmost cell (cell A1, as in column A, 

row 1) and type CTRL+V to PASTE. The copied records will appear. 
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Now, your data is in a new worksheet, but 
there are no column titles. So, let’s add 
them. 
 
1. Go back to your Use This worksheet.  
2. Highlight the top row where the 

column titles are. It should be row 7. 
3. Type CTRL+C to COPY the title row. 
4. Go to your new worksheet. 
5. Click on the topmost, leftmost cell (cell 

A1, see right). 
6. Go to INSERT > COPIED CELLS. The title 

row should now appear as the top row 
of your new worksheet. 

 

Once you have established your new worksheet, you should rename it. Let’s call it 
2ndQtr-NonPayroll, as in nonpayroll expenses analysis for quarter 2. 

Now that we have our data subset, we need to filter it for nonpayroll expenses and then 
sort the transactions by account. 

Filtering and sorting the new data set 

1. Go to DATA > FILTER > AUTOFILTER. Menu 
arrows should appear with each column title. 

2. Go to ACCT > (CUSTOM…). 
3. Select does not begin with from the first 

dropdown menu. 
4. Enter 51 in the text box and click OK. 
5. Your data should now show only accounts 

5200 and higher, which are the nonpayroll 
expenses. 

 
Now, we SORT the data to group all the accounts together. 

1. Click on a cell in the Acct column. 
2. Click on the SORT AZ icon. 
3. Your data is now grouped by account. 

 

 

Remember to 
click cel l A1 first. 
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At long last, your data is now ready for the SUBTOTAL command! 

Subtotaling data 

1. Go to DATA > SUBTOTALS…. 
2. In the dialog box, enter the following: 

a. At each change in: Acct 
b. Use function: Sum 
c. Add subtotal to: Monetary Amount 
d. This means that with each change in account, Excel will subtotal the 

figures in the Monetary Amount column. 
3. Click OK. 
4. If you want to double-check Excel’s work, highlight all the expenses and confirm that 

the sum in the status bar is the same as the subtotal. 

Subtotal dialog box 

 

 

Congratulations! You now have the tools to begin doing your own budget analysis.  

 

As we said in the introduction, being able to interpret the data in your budget reports is one of the 

most powerful contributions you can make to your department … and by extension, the 

University. Budget analysis helps guide decision-making at its best — by looking at what you 

want to achieve and how best to get there.  

 

 

Subtotal and 
Sum match! 
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Glossary 
The list below includes common terms used in this manual. Additional terms and definitions can 

be found on the Finance Office Web site at: http://finance.gallaudet.edu/terms.html. 

 

Account — on PeopleSoft reports; expense category denoted by 4-digit code; also known as 

expense account; formerly called object code 

Actuals — accounting term; expense or revenue that occurred (as in “actually spent/earned”) 

Appropriations — funds received from the U.S. government; Federal law mandates how these 

funds may be used 

Base Budget — on PeopleSoft reports; budget with which a department begins the fiscal year 

Budget — a department’s plan to spend money during the fiscal year 

COLA — Cost Of Living Adjustment; generally a percentage increase applied across all salaries 

and benefits 

Deobligate — used with encumbrances; release of encumbered funds from a purchase order or 

payroll for another use 

Department — on accounting forms; 4-digit code representing your department’s budget; 

formerly called account 

Encumbrance — accounting term; money that is set aside for a promised expense (such as for 

payroll or a purchase order) 

Expense — outflow of funds; money that is spent to purchase a product or service 

Expense account — on accounting forms; expense category denoted by 4-digit code; also 

known as account; formerly called object code 

Expense reimbursement — money that comes into your department, usually via an I.I. to 

reimburse an expense/service you provided to another department 

Federal appropriations — see Appropriations 

Filter — Excel command; allows user to view a specific subset of data (as in “filters out 

extraneous data”) 

Fiscal year — accounting term; year in which all financial transactions are recorded; at 

Gallaudet, October 1 to September 30 

Fixed expense — accounting term; expense that does not fluctuate with each occurrence 

Freeze Panes — Excel command; causes designated area of screen to remain stationary while 

scrolling through a worksheet  

Funds — money in a department’s budget 

GUACTJRN — abbreviation for PeopleSoft report, Actuals Detail; lists details about each 

financial transaction 

GUBE — abbreviation for PeopleSoft report, Expense Budget; snapshot of budget revisions to a 

department’s expense accounts 
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GUBR — abbreviation for PeopleSoft report, Revenue Budget; snapshot of budget revisions to a 

department’s revenue accounts 

GUBS — abbreviation for PeopleSoft report, Budget Status by Account; snapshot of a 

department’s budget with encumbrances, actuals, and remaining funds to date 

GUBUDJRN — abbreviation for PeopleSoft report, Budget Detail; lists details about budget 

revisions 

Object code — former term for expense category denoted by 4-digit code; current terminology 

is expense account on accounting forms or account (acct) on PeopleSoft reports 

Organization — on PeopleSoft reports; department whose budget is represented on the report 

PAF — Personnel Action Form; form used to record changes to an employee’s job information 

and/or salary 

PaymentNet — Web site of JP Morgan Chase, the University’s purchase card provider; allows 

users to verify purchase card expenses and account classifications 

Payroll Encumbrances — PeopleSoft report; lists salary and benefits information by employee 

Permanent Budget Revision — accounting term; change to budget that continues to subsequent 

fiscal years; permanent revisions become part of the next fiscal year’s base budget 

POSTAT — abbreviation for PeopleSoft report, Purchase Order Status; lists encumbrances and 

payments associated with purchase orders 

Purchase card — University credit card 

Purchase order — contract issued by the University to a vendor, agreeing to purchase specified 

product(s) or service(s) 

Purchase requisition — accounting form to initiate a purchase order for a product or service 

Revenue — inflow of funds; monies earned on sales of products or services 

Revised Budget — on PeopleSoft reports; base budget with permanent and temporary budget 

revisions applied 

Sort — Excel command; allows user to view entries in ascending or descending order 

SPAF — Special Personnel Action Form; form used to process special non-salary payments to 

individuals 

Subtotal — Excel command; sums groups of data as directed by the user 

Temporary Budget Revision — accounting term; change to budget that applies only to current 

fiscal year 

University — Gallaudet University; in this manual, University (with a capital U) refers to 

Gallaudet and the Clerc Center 

Variable expense — accounting term; expense that fluctuates with each occurrence 
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	Introduction
	Introduction
	 

	Welcome to Finance 101: Gallaudet Budget Basics. One of the most daunting tasks for administrative assistants and administrators when they come on board is making sense of the University’s budget system. For most folks, learning how to budget is trial and error — mostly errors. There’s a lot of “let’s do it this way because it worked last time” instead of following best practices that make sense. 
	 
	So, that’s why you have this manual and are attending the accompanying workshop. The University budget is a giant document, and it depends on quality input from each department. It makes sense for all departments to use the same budgeting guidelines so information is consistent across the University. By understanding how to budget and analyze your department’s expenditures, you can make a direct impact on the University’s progress toward its goals. Budgets link to funds, which link to decisions on our progr
	 
	This manual is a basic tour of PeopleSoft budget reports and Excel, the program we use to view our reports. Advanced skills, such as drill downs, managing multiple budgets simultaneously, and managing special fund accounts (like grants or donations) will not be covered here. If you want information about those topics, you’ll have to wait for “PeopleSoft 201.” 
	 
	There are five major sections to this manual. They are: 
	I. Basic budgeting concepts 
	I. Basic budgeting concepts 
	I. Basic budgeting concepts 

	II. Budget report descriptions 
	II. Budget report descriptions 

	III. Recommended budget habits 
	III. Recommended budget habits 

	IV. Basic Excel functions 
	IV. Basic Excel functions 

	V. Glossary 
	V. Glossary 


	 
	PeopleSoft 101 
	PeopleSoft 101 
	PeopleSoft 101 
	PeopleSoft 101 
	Goals: (1) Explain budgeting concepts 
	 (2) Create consistent budgeting practices among all University departments 
	 (3) Explain how to use Excel to analyze budget reports efficiently 
	Audience: Staff who manage department budgets (administrative assistants and/or budget unit heads) 

	Span


	 
	Before we get started, we should make clear the formatting used in this manual to represent different items in PeopleSoft and Excel. 
	 
	Throughout the manual, we will refer to budget reports (or worksheets) by abbreviated names. The names correspond to the capitalized letters in each file name. For example, when you download your Budget Status by Account report, you see PeopleSoft’s name for it: GUBS115B-Budget Status by Account - ####. In this manual, we’ll refer to this report as GUBS. 
	 
	Report shorthand 
	Report shorthand 
	Report shorthand 
	Report shorthand 

	Full report name 
	Full report name 

	Span

	GUBS 
	GUBS 
	GUBS 

	Budget Status by Account 
	Budget Status by Account 

	Span

	GUACTJRN 
	GUACTJRN 
	GUACTJRN 

	Actuals Detail 
	Actuals Detail 

	Span

	GUBE 
	GUBE 
	GUBE 

	Expense Budget 
	Expense Budget 

	Span

	GUBR 
	GUBR 
	GUBR 

	Revenue Budget 
	Revenue Budget 

	Span

	POSTAT 
	POSTAT 
	POSTAT 

	Purchase Order Status 
	Purchase Order Status 
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	Underlined terms are field codes in a PeopleSoft report or identifiers in Excel (such as the name of a menu option).  
	 
	SMALL CAPS terms are Excel commands. 
	 
	That should do it for us. Now, let’s start our adventure! 
	Part I: Budgeting for the non
	Part I: Budgeting for the non
	-
	budget minded
	 

	What is a budget? 
	Webster’s Collegiate Dictionary defines budget as “a statement of the financial position of an administration for a definite period of time based on estimates of expenditures during the period and proposals for financing them.”1 
	1 “budget.” Merriam-Webster’s Collegiate Dictionary, 11th Ed. Merriam-Webster, 2002. http://www.merriam-webster.com (24 May 2007). 
	1 “budget.” Merriam-Webster’s Collegiate Dictionary, 11th Ed. Merriam-Webster, 2002. http://www.merriam-webster.com (24 May 2007). 

	 
	Ask the average person on the street to define budget and you’ll get different results. 
	 It’s how much money I’ve set aside for different things. 
	 It’s how much money I’ve set aside for different things. 
	 It’s how much money I’ve set aside for different things. 

	 It’s a limit for how much I can spend. 
	 It’s a limit for how much I can spend. 

	 It’s a mystery. 
	 It’s a mystery. 


	 
	Sound familiar? Let’s go back to Webster’s definition to unravel why budgets are so confusing. 
	 
	First and foremost, budgets are predictions. The definition says, “based on estimates of expenditures.” Budgets don’t apply to what happened yesterday or last month; they get us through tomorrow, next month, or next year. So, budgeting is guesstimating how much you plan to spend. The first few times you review your department’s budget, you might feel like your numbers are all wrong, but the more you practice guesstimating, the better your budget will reflect your actual expenses. Like parallel parking, budg
	 
	The definition also says budgets are “for a definite period of time.” Budgets have expiration dates. At Gallaudet, we base our budgets on the fiscal year, which is October 1 to September 30. With guesstimating, you can’t expect anyone to ballpark their expenses with an open timeline — that’s like taking a walk without setting a time or distance limit. (You’d end up like Forrest Gump, crossing the nation and not really knowing why.) So, a fiscal year is a reasonable timeframe in which to say, “This is what I
	 
	Finally, the definition says, “… proposals for financing them.” This is the part of the budget that you probably know best. It’s the “object code” part of the definition. Budgets show how expenses are broken down into categories. Just as it helps to have a timeframe for your expenses, it also helps to analyze how you will incur them. For example, hosting a conference requires dozens of expenses — honoraria, travel, interpreting, space rental, Web marketing, postage, etc. It’s impossible to pull a figure out
	Out with the old, in with the new 
	Since we mentioned object codes, we might as well come clean. Object code is the old term for expense account. It came from the system prior to PeopleSoft, but the term managed to stick. We need to change that — like the mullet, object code is so passé. The hip and the cool use expense account (or account, for the truly hip) to talk about how we spend our funds. And you know how you use account to refer to your department’s budget? We’ve updated that, too. Now, your department budget is referred to as … you
	 
	Breaking down Webster’s definition 
	Breaking down Webster’s definition 
	Breaking down Webster’s definition 
	Breaking down Webster’s definition 
	 
	Budget: A statement… 
	 
	What Webster’s says 
	What Webster’s says 
	What Webster’s says 
	What Webster’s says 

	What it means 
	What it means 


	…of the financial position of an administration… 
	…of the financial position of an administration… 
	…of the financial position of an administration… 

	…how much money our department has… 
	…how much money our department has… 

	Span

	…for a definite period of time… 
	…for a definite period of time… 
	…for a definite period of time… 

	…to use during the fiscal year (October 1 to September 30)… 
	…to use during the fiscal year (October 1 to September 30)… 


	…based on estimates of expenditures during the period… 
	…based on estimates of expenditures during the period… 
	…based on estimates of expenditures during the period… 

	…based on how much we think our projects will cost… 
	…based on how much we think our projects will cost… 


	…and proposals for financing them. 
	…and proposals for financing them. 
	…and proposals for financing them. 

	…and the breakdown of how much we need by expense account. 
	…and the breakdown of how much we need by expense account. 
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	So, that’s it. That’s what a budget is. It’s how your department plans to spend its money. 
	 
	It’s also important to emphasize what a budget does. Obviously, it guides spending for the next fiscal year. More importantly, it links your department’s actions (through expenditures) with its priorities. Your department has goals to achieve — they cannot be successful without investing money for the training and materials your staff needs. Your budget reflects your department’s priorities. 
	 
	The relationship between budgets and priorities is critical for good planning. That’s why the president announces University priorities every year and that’s why division heads give preferential treatment to proposals that directly support the priorities. Anyone who studies Gallaudet’s budget immediately sees that we prioritize accessibility because we designate more funds for interpreting and captioning than our peers do. Ultimately, there’s a finite amount of funds, and priorities help us determine how be
	 
	Keep in mind! Budgets reflect an organization’s priorities. 
	Keep in mind! Budgets reflect an organization’s priorities. 
	Keep in mind! Budgets reflect an organization’s priorities. 
	Keep in mind! Budgets reflect an organization’s priorities. 

	Span


	How budgeting works at Gallaudet 
	The budgeting process begins in December or January, when the president announces the University’s priorities for the following two fiscal years. Yes, the University works on two budgets simultaneously — let’s call them FY +1 and FY +2 (as in “next year” and “in two years”). 
	 
	Departments submit plans to their division head, explaining why their projects are important and how they support University priorities. The division heads, in turn, review the proposals and develop their division-wide budgets, which become the foundation for the University budget. The president then presents the University budget to the Board of Trustees. Once the Board approves the budgets, the FY +1 budget becomes the official University budget on October 1 while the FY +2 budget is sent to the governmen
	 
	 
	 
	 
	 
	 
	InlineShape


	The whole process runs from December to June, but wise departments use the summer months to monitor and, if necessary, change their current spending behaviors. They also use the quiet time to set new goals for the upcoming fiscal year. Budgeting is like losing weight — much easier done a little at a time rather than all at once. 
	The whole process runs from December to June, but wise departments use the summer months to monitor and, if necessary, change their current spending behaviors. They also use the quiet time to set new goals for the upcoming fiscal year. Budgeting is like losing weight — much easier done a little at a time rather than all at once. 
	 



	So, what does this mean for you? 
	 
	It means that when you enter PeopleSoft on October 1, you should see a clean, new budget with payroll figures that reflect COLAs and merit increases. Expense account allocations should be set up for the new year and expenses should be zero. Most important, your bottom line — what’s left in your budget after setting aside payroll and other encumbrances — should be a positive number. (If it isn’t, you’ve got a problem beyond the scope of this book, and you should talk to someone in the Finance Office.) 
	 
	Of course, this is all theoretical, because there are lots of if’s: if you filed your paperwork properly to reallocate funds (see Budget Revisions, p. 27); if COLAs have been approved; if Congress has actually passed the new year’s budget. Most likely, you’ll have some revisions to make, but you should see some minor changes and expenses equal (or close) to zero. 
	General budget concepts 
	As you begin budgeting, you’ll want to keep a few concepts in mind. These guidelines may not address every situation you encounter, but they’ll get you through most of them. 
	Bottom line 
	You’ve often heard the question, “What’s the bottom line?” In conversation, it usually means, “What’s the point? What do I really need to know?” As you may have guessed, bottom line comes from looking at budgets. It refers to the last line of a budget spreadsheet, where all the totals are given and (the $25,000 question) how much money is left in your account. 
	 
	In general, as long as your bottom line is a positive number, you’re in good shape. Some of the expense accounts above it may be negative — meaning you’ve spent more in those accounts than you planned to — but hopefully you have several areas with positive balances so everything comes out all right in the end. It’s hard to wrap your mind around that at first … that some negatives are OK as long as the bottom line is positive. 
	 
	 
	 
	InlineShape

	This illustration shows a department that has exceeded its budget by $69,476.77. (In case you’re wondering, this is not good.) 
	Expenses: Positives or negatives? 
	Positive and negative numbers can be confusing on budget worksheets, especially when one worksheet might show expenses as a negative number while another shows it as a positive. You need to keep in mind the worksheet’s purpose. If it shows how much money you have, expenses are negative and expense reimbursements (i.e., money that comes into your department, usually through I.I.s) are positive. If it shows how much money you’ve spent, then expenses are positive and reimbursements are negative. 
	 
	The GUBS (Budget Status by Account) worksheet on the previous page tracks how much money you have left, so expenses are negative and reimbursements are positive. In the column labeled Actual Expenses/Revenues, the line for General Office Expenses shows “-7,573.43” or expenses totaling $7,573.43. The line for Inter Department Charge shows “2,417.65” or reimbursements totaling $2,417.65. 
	 
	If you’re tracking how much you have left, expenses are negative. If you’re tracking how much you have spent, expenses are positive. 
	If you’re tracking how much you have left, expenses are negative. If you’re tracking how much you have spent, expenses are positive. 
	If you’re tracking how much you have left, expenses are negative. If you’re tracking how much you have spent, expenses are positive. 
	If you’re tracking how much you have left, expenses are negative. If you’re tracking how much you have spent, expenses are positive. 
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	In the example to the right, taken from GUACTJRN (Actuals Detail), we track our expenditures. So, expenses appear as positive numbers (“45.18” or $45.18), and expense reimbursements appear as negatives  (“-725.00” or $725.00). 
	Figure
	Encumbrances 
	Encumbrances are place holders for your spending. Expenditures that you have promised to make but haven’t paid yet are set aside to ensure you’ll have enough money to meet your obligations when they come due.  
	 
	The best example of an encumbrance is payroll. PeopleSoft automatically sets aside a large chunk of your department’s budget to cover everyone’s salary and benefits for the full year. Then, with each pay period, a portion of the encumbered amount becomes an expense as each employee gets paid. At the beginning of the fiscal year, everyone’s full salary and benefits are in the encumbered column. As the year progresses, the encumbrances decrease while the actual expenses increase. 
	 
	Encumbrances are factored into your bottom line calculations, so it can be tricky to differentiate between the bottom line (what your worksheet shows) and what you actually have left (how much money you have on hand). For example, if you’ve promised to pay Company X $10,000 for their services and you’ve paid $3,000 to date, your encumbrance would be $7,000. Your budget would show that you’ve spent the full $10,000 even though you still have $7,000 in your possession. Some managers like to know this subtle d
	 
	So what do you do if you want to reallocate the encumbered funds? You can deobligate them. (See Contracts and Purchasing for assistance.) Continuing with the Company X example, if you decide to cancel their service, the $7,000 encumbrance would go back into your remaining funds, and your bottom line would increase by $7,000. (Of course, keep in mind that you need to weigh the pros and cons of canceling a contract.) 
	 
	If you cancel a contract, deobligate the remaining encumbered funds to improve your bottom line. 
	If you cancel a contract, deobligate the remaining encumbered funds to improve your bottom line. 
	If you cancel a contract, deobligate the remaining encumbered funds to improve your bottom line. 
	If you cancel a contract, deobligate the remaining encumbered funds to improve your bottom line. 
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	Balancing ins and outs 
	Part of working with a budget is moving funds among different accounts to cover your expenses accurately. Let’s say you need to increase your budget for 5200 (Travel and Transportation). Where does the increase come from? More often than not, the increase comes from a decrease in another area of your own budget. It’s a zero sum game — if one area goes up, another must come down. 
	 
	What’s confusing about this concept is that you rarely get an influx of new money. So it’s important to distinguish between needs for a funding increase (as in “Please give us more money,”) and shifting funds within your budget. This is where the word budget can be fuzzy. Budget is not money. Budget is how you plan to use your money. Money or funds is money. So, don’t ask “What’s left in our budget?” Ask “What’s left of our funds?” 
	 
	Budget ≠ $$$ Budget = plans for using $$$ Funds = $$$ 
	Budget ≠ $$$ Budget = plans for using $$$ Funds = $$$ 
	Budget ≠ $$$ Budget = plans for using $$$ Funds = $$$ 
	Budget ≠ $$$ Budget = plans for using $$$ Funds = $$$ 

	Span


	Big picture vs. detail 
	If you’ve worked with account codes, you know that there are high level categories (those that end in “00”) and detail accounts. When you budget, you need to keep the big picture in mind, so use the high level accounts to guesstimate your expenses. However, when you track your expenditures, use the detail accounts to identify how you’ve spent your funds. Don’t budget at the detail level, unless you’re working with payroll (e.g., submit budget revisions for 5300, not 5351). On the flip side, don’t charge any
	Temporary vs. permanent 
	You see these terms with budget revisions, which are changes to expense accounts. Temporary budget revisions are changes that do not continue to the next fiscal year; permanent revisions do. 
	 
	Let’s say your department is developing a new student handbook. You expect to spend $5,000 in the next fiscal year on printing, and your current budget has no money allotted for 5700 (Printing and Publishing). For a temporary budget revision (e.g., a single printing of the handbook), you would shift $5,000 from other areas of your budget to 5700. (Remember, it’s a zero sum game.) When the next fiscal year begins, the $5,000 would disappear from 5700 and go back to their original assignments. 
	 
	Now, let’s suppose your department decides to print a new student handbook every year. You’ll need funds for this project every year. In this case, you would submit a permanent budget revision. When the next fiscal year begins, your budget would show $5,000 allocated for 5700 expenses. 
	How to establish a budget 
	So, now that we’ve covered budget basics, are you looking at your current budget and thinking, “This is not quite where I want it to be”? With a little diligence and patience, you can rework the budget to better reflect your department’s activities. 
	 
	First, you need good records — at least three or four months of expenses. (For the truly gung-ho, a year’s worth would be even better for this exercise.) You’ll use these records to estimate your expenses by account. You can either pull information from GUACTJRN or use your “in house” records, such as copies of accounting forms. 
	 
	The information in PeopleSoft is the University’s official data. If your records are significantly different from PeopleSoft’s, you should contact the Finance Office to resolve the discrepancy. 
	The information in PeopleSoft is the University’s official data. If your records are significantly different from PeopleSoft’s, you should contact the Finance Office to resolve the discrepancy. 
	The information in PeopleSoft is the University’s official data. If your records are significantly different from PeopleSoft’s, you should contact the Finance Office to resolve the discrepancy. 
	The information in PeopleSoft is the University’s official data. If your records are significantly different from PeopleSoft’s, you should contact the Finance Office to resolve the discrepancy. 

	Span


	 
	Let’s assume you’ve gathered records for three months. Assign every expense to the appropriate expense account. This is important, because the best way to analyze spending is to know where the money’s going. For example, if everything falls under 5351 (General Supplies) or 5371 (Miscellaneous Services), you won’t be able to tell anything about your department’s spending. Likewise, if you classify a pager subscription under 5333 (Other Communications) one month and then 5371 another month, you won’t get good
	 
	When you’ve finished, tally the amounts in each account — they become your quarterly expense estimates (3 months = ¼ year). Aggregate the estimates under the high level “00” category (remember, big picture), and round figures to the nearest whole dollar. Once you’ve done that, multiply your “00” category estimate by four (4 quarters = 1 year) and the new figure is your budget estimate. (Don’t wallow here; we’ve got an example coming up.) 
	 
	Of course, you should also use common sense. If you happened to pull records for June, July, and August, your estimates might be low because the campus is usually quiet in the summer. Likewise, if you used records during months when your department hosted a major event, your expenses might be higher than normal. Use your judgment to determine if the estimate is reliable or not. 
	Example: Estimating expenses to develop a budget 
	Let’s walk through an example. Here is a portion of a department’s GUACTJRN report: 
	 
	P
	Span
	 
	InlineShape

	Partial actuals detail 
	 
	The full report shows expenses from January 1 to March 31, 2007 (3 months). To keep things simple, let’s look only at 5300 (General Office Expenses) accounts, and let’s assume the account assignments are correct. Summing by account, we find the following: 
	 
	Account 
	Account 
	Account 
	Account 

	Description 
	Description 

	 Total 
	 Total 

	Span

	5322 
	5322 
	5322 

	Rental of equipment 
	Rental of equipment 

	80.73 
	80.73 

	Span

	5324 
	5324 
	5324 

	Copying services 
	Copying services 

	1080.00 
	1080.00 

	Span

	5332 
	5332 
	5332 

	Postage 
	Postage 

	134.61 
	134.61 

	Span

	5334 
	5334 
	5334 

	Telephone usage (long distance) 
	Telephone usage (long distance) 

	106.86 
	106.86 

	Span

	5338 
	5338 
	5338 

	Telephone service (lines) 
	Telephone service (lines) 

	495.00 
	495.00 

	Span

	5341 
	5341 
	5341 

	Periodicals, books, etc. 
	Periodicals, books, etc. 

	47.80 
	47.80 

	Span

	5351 
	5351 
	5351 

	General supplies 
	General supplies 

	1067.40 
	1067.40 

	Span

	5300 
	5300 
	5300 

	General Office Expense Total 
	General Office Expense Total 

	3012.40 
	3012.40 

	Span


	 
	$3,012    4  =  $12,048 
	 
	Assuming this quarter was typical for this department, we would recommend allocating $12,100 for 5300. Remember, budgets are not exact, so round up or down as your intuition tells you. 
	 
	Repeat this exercise for each expense category (codes ending in “00”), and you’ll get the gist of where money should be stashed in your budget. Hopefully, your totals are less than your entire 
	budget. If they come out higher, your department needs to rethink how it uses its money or prepare a compelling argument for a budget increase … or both. 
	Expense Accounts 
	Have you ever debated whether an expense falls under one account or another? Where do I put non-GIS interpreter charges? Why do some accounts appear in my PeopleSoft report when I can’t find them on any Finance Office lists? This section provides you with definitions for each expense account and when to use them. 
	 
	Consistency is the key! If you have trouble assigning an account to a particular expense, just make sure all occurrences of that expense fall in the same account. 
	Consistency is the key! If you have trouble assigning an account to a particular expense, just make sure all occurrences of that expense fall in the same account. 
	Consistency is the key! If you have trouble assigning an account to a particular expense, just make sure all occurrences of that expense fall in the same account. 
	Consistency is the key! If you have trouble assigning an account to a particular expense, just make sure all occurrences of that expense fall in the same account. 
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	Keep in mind that the high level “00” category code is used for budgeting only. You charge expenses to the detail account codes within each category. (Don’t worry, if you use a “00” code, the Finance Office will contact you to fix it.) 
	 
	The following table lists most expense accounts and definitions. If you have an old copy of the account codes and find one that isn’t listed here, it’s probably obsolete or used only by specific departments under specific circumstances (and those departments know who they are). This table provides the most current list of account codes, their titles and descriptions. 
	 
	Under 5300 (General Office Supplies), some accounts have asterisks. They correspond to services provided by Reprographic Services, Postal Services and Telephone, and the expenses are entered directly into PeopleSoft from the provider. Your department does not receive an I.I. for these charges. 
	Table 1: Expense accounts and when to use them 
	ACCOUNT 
	ACCOUNT 
	ACCOUNT 
	ACCOUNT 

	CATEGORY 
	CATEGORY 

	USE FOR … 
	USE FOR … 

	Span

	4500 
	4500 
	4500 

	Revenue 
	Revenue 

	Most departments don’t have revenue. 
	Most departments don’t have revenue. 
	If your department regularly generates revenue, please contact the Finance Office for bookkeeping guidance. 

	Span

	4573 
	4573 
	4573 

	Miscellaneous Departmental Income 
	Miscellaneous Departmental Income 

	… money your department receives for something that isn’t your primary mission (e.g., sales of a special report produced by your department). 
	… money your department receives for something that isn’t your primary mission (e.g., sales of a special report produced by your department). 
	If you have questions about recording revenue, please contact the Finance Office. 

	Span


	5100 
	5100 
	5100 
	5100 

	Salaries and Wages Accounts 
	Salaries and Wages Accounts 

	Most of the expenses in 5100 should be handled by HR only, as they pertain to employee salary and benefits. 
	Most of the expenses in 5100 should be handled by HR only, as they pertain to employee salary and benefits. 
	The main reason you would need these codes is to complete personnel action forms (PAFs), such as merit increases, new hires or status changes. For assistance, contact HR. 
	Special notes are given below. Otherwise, defer to HR for salary-related account assignments. 

	Span

	5111 
	5111 
	5111 

	Regular Status Instructional Faculty or Teacher 
	Regular Status Instructional Faculty or Teacher 

	 
	 

	Span

	5112 
	5112 
	5112 

	Temporary Instructional Faculty or Teacher 
	Temporary Instructional Faculty or Teacher 

	 
	 

	Span

	5115 
	5115 
	5115 

	Short-term Faculty 
	Short-term Faculty 

	 
	 

	Span

	5116 
	5116 
	5116 

	Special Pay - Temporary Faculty or Teacher 
	Special Pay - Temporary Faculty or Teacher 

	… compensation in addition to an individual’s salary. Typically, special pay is awarded for accepting additional responsibilities beyond the job description, such as chairing a major initiative. 
	… compensation in addition to an individual’s salary. Typically, special pay is awarded for accepting additional responsibilities beyond the job description, such as chairing a major initiative. 

	Span

	5117 
	5117 
	5117 

	Special Pay - Regular Status Faculty or Teacher 
	Special Pay - Regular Status Faculty or Teacher 

	Span

	5119 
	5119 
	5119 

	Faculty/Teacher Benefits 
	Faculty/Teacher Benefits 

	 
	 

	Span

	5121 
	5121 
	5121 

	Regular Status Staff - Exempt 
	Regular Status Staff - Exempt 

	 
	 

	Span

	5123 
	5123 
	5123 

	Regular Status Staff - Non-Exempt 
	Regular Status Staff - Non-Exempt 

	 
	 

	Span

	5124 
	5124 
	5124 

	Special Pay – Exempt Staff 
	Special Pay – Exempt Staff 

	 
	 

	Span

	5125 
	5125 
	5125 

	Regular Status Staff - Collective Bargaining 
	Regular Status Staff - Collective Bargaining 

	 
	 

	Span

	5126 
	5126 
	5126 

	O/T Special Pay – Non-Exempt 
	O/T Special Pay – Non-Exempt 

	 
	 

	Span

	5129 
	5129 
	5129 

	Staff Benefits 
	Staff Benefits 

	 
	 

	Span

	5131 
	5131 
	5131 

	Temporary Staff - Non-Exempt 
	Temporary Staff - Non-Exempt 

	 
	 

	Span

	5132 
	5132 
	5132 

	Short-Term Temporary Staff 
	Short-Term Temporary Staff 

	 
	 

	Span

	5134 
	5134 
	5134 

	Extended Temporary Staff - Exempt 
	Extended Temporary Staff - Exempt 

	 
	 

	Span

	5135 
	5135 
	5135 

	Student Compensation 
	Student Compensation 

	 
	 

	Span

	5136 
	5136 
	5136 

	Summer Student Compensation 
	Summer Student Compensation 

	… compensation for students working in the summer but not enrolled in a summer class. 
	… compensation for students working in the summer but not enrolled in a summer class. 

	Span


	5137 
	5137 
	5137 
	5137 

	Interpreter on Payroll 
	Interpreter on Payroll 

	… interpreters who are full-time staff in your department. For GIS, use 5144. For external interpreting agencies, use 5451.  
	… interpreters who are full-time staff in your department. For GIS, use 5144. For external interpreting agencies, use 5451.  

	Span

	5138 
	5138 
	5138 

	Call in/Substitute 
	Call in/Substitute 

	 
	 

	Span

	5139 
	5139 
	5139 

	Temporary Staff Benefits 
	Temporary Staff Benefits 

	 
	 

	Span

	     5149 
	     5149 
	     5149 

	Staff Benefits OT/Special Pay 
	Staff Benefits OT/Special Pay 

	 
	 

	Span

	     5159 
	     5159 
	     5159 

	Faculty Benefits – Special Pay 
	Faculty Benefits – Special Pay 

	 
	 

	Span

	     5169 
	     5169 
	     5169 

	Faculty Benefits – SP Temp 
	Faculty Benefits – SP Temp 

	 
	 

	Span

	5200 
	5200 
	5200 

	Travel and Transportation Accounts 
	Travel and Transportation Accounts 

	Gallaudet covers many expenses for faculty, teachers and staff who travel on official business for the University.  
	Gallaudet covers many expenses for faculty, teachers and staff who travel on official business for the University.  
	Refer to the A&O Manual, Section 2.05 for details on what is or isn’t allowed. 

	Span

	5211 
	5211 
	5211 

	Travel – Outreach 
	Travel – Outreach 

	… travel for events that raise awareness of Gallaudet through non-academic activities (e.g., presentation by an employee on deafness). 
	… travel for events that raise awareness of Gallaudet through non-academic activities (e.g., presentation by an employee on deafness). 

	Span

	5213 
	5213 
	5213 

	Travel – Professional Development 
	Travel – Professional Development 

	… travel for faculty, teachers and staff to continuing education events related to their jobs. 
	… travel for faculty, teachers and staff to continuing education events related to their jobs. 

	Span

	5215 
	5215 
	5215 

	Travel – Development and Fund Raising 
	Travel – Development and Fund Raising 

	… travel for events that cultivate donor prospects and/or raise funds for the University. 
	… travel for events that cultivate donor prospects and/or raise funds for the University. 

	Span

	5217 
	5217 
	5217 

	Travel – Recruiting 
	Travel – Recruiting 

	… travel for events that attract new individuals to Gallaudet. 
	… travel for events that attract new individuals to Gallaudet. 

	Span

	5219 
	5219 
	5219 

	Travel – Administrative 
	Travel – Administrative 

	… travel for events related to the management of the University or a department (e.g., mileage to meeting with a University vendor). 
	… travel for events related to the management of the University or a department (e.g., mileage to meeting with a University vendor). 

	Span

	5221 
	5221 
	5221 

	Travel – Non-Gallaudet 
	Travel – Non-Gallaudet 

	… travel to/from campus for non-Gallaudet employees, such as guest speakers. 
	… travel to/from campus for non-Gallaudet employees, such as guest speakers. 

	Span

	5222 
	5222 
	5222 

	Travel - Departmental 
	Travel - Departmental 

	  … travel for faculty, teachers and staff related to academic or athletic activities  
	  … travel for faculty, teachers and staff related to academic or athletic activities  

	Span

	5300 
	5300 
	5300 

	General Office Expense Accounts 
	General Office Expense Accounts 

	The bulk of variable office expenses occur in the 5300 category. 
	The bulk of variable office expenses occur in the 5300 category. 
	Categories with an asterisk (*) are automatically entered into PeopleSoft by the provider (i.e., Reprographics, Post Office, and ITS). 

	Span

	5321 
	5321 
	5321 

	Rental of Facilities 
	Rental of Facilities 

	… room rentals for events; Kellogg Conference Hotel room rentals would be classified here. 
	… room rentals for events; Kellogg Conference Hotel room rentals would be classified here. 

	Span


	5322 
	5322 
	5322 
	5322 

	Rental of Equipment 
	Rental of Equipment 

	… equipment rentals for events, such as computers, A/V, tents, etc. 
	… equipment rentals for events, such as computers, A/V, tents, etc. 

	Span

	5324 
	5324 
	5324 

	Reprographic Services* 
	Reprographic Services* 

	… copying done by Reprographic Services. 
	… copying done by Reprographic Services. 

	Span

	5325 
	5325 
	5325 

	Copying Services 
	Copying Services 

	… copying done by an EXTERNAL company. 
	… copying done by an EXTERNAL company. 

	Span

	5331 
	5331 
	5331 

	Telephone and TDD 
	Telephone and TDD 

	… purchase of an actual telephone or TTY. Cell phone service can be classified here, also. 
	… purchase of an actual telephone or TTY. Cell phone service can be classified here, also. 
	Charges for Gallaudet line usage are classified separately. 

	Span

	5332 
	5332 
	5332 

	Postage* 
	Postage* 

	… postage as calculated by Postal Services. 
	… postage as calculated by Postal Services. 
	Courier and overnight delivery expenses should also be classified here. 

	Span

	5333 
	5333 
	5333 

	Other Communications 
	Other Communications 

	… purchase of other communication devices (such as pagers or videophones) and their monthly service subscriptions, if applicable. 
	… purchase of other communication devices (such as pagers or videophones) and their monthly service subscriptions, if applicable. 

	Span

	5334 
	5334 
	5334 

	Telephone Usage* 
	Telephone Usage* 

	… toll and long distance charges. 
	… toll and long distance charges. 

	Span

	5338 
	5338 
	5338 

	Tele-Line Service – MRC* 
	Tele-Line Service – MRC* 

	… monthly fee for telephone service. 
	… monthly fee for telephone service. 

	Span

	5341 
	5341 
	5341 

	Periodicals, Books and Films 
	Periodicals, Books and Films 

	… purchase of periodicals, books and films for department use. 
	… purchase of periodicals, books and films for department use. 

	Span

	5343 
	5343 
	5343 

	Magazines & Periodicals 
	Magazines & Periodicals 

	…purchase of magazines 
	…purchase of magazines 

	Span

	5344 
	5344 
	5344 

	Books 
	Books 

	… purchase of books for the Library. 
	… purchase of books for the Library. 

	Span

	5351 
	5351 
	5351 

	General Supplies 
	General Supplies 

	… purchase of general office supplies, such as paper, printer ink, pens, calendars, etc. 
	… purchase of general office supplies, such as paper, printer ink, pens, calendars, etc. 

	Span

	5361 
	5361 
	5361 

	Repairs 
	Repairs 

	… repairs to office equipment, such as a broken copier. Repairs done by PPD (such as a hole in the wall) should go under 5931, Interdepartmental Services. 
	… repairs to office equipment, such as a broken copier. Repairs done by PPD (such as a hole in the wall) should go under 5931, Interdepartmental Services. 

	Span

	5366 
	5366 
	5366 

	Temporary Help – Agencies 
	Temporary Help – Agencies 

	… services provided for temp employees through temporary staffing agencies 
	… services provided for temp employees through temporary staffing agencies 

	Span

	5371 
	5371 
	5371 

	Miscellaneous Services 
	Miscellaneous Services 

	… other services a department may require, such as water service. 
	… other services a department may require, such as water service. 
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	5381 
	5381 
	5381 

	Entertainment 
	Entertainment 

	… expenses incurred for entertaining a guest of the University (such as treating a visiting speaker to dinner), or catering for a large reception. 
	… expenses incurred for entertaining a guest of the University (such as treating a visiting speaker to dinner), or catering for a large reception. 
	Note: The A&O Manual has strict guidelines on what constitutes an entertainment expense. Refer to Section 2.05 for more information. 

	Span


	5400 
	5400 
	5400 
	5400 

	Consultants and Advisors 
	Consultants and Advisors 

	Expenses in 5400 usually involve a purchase requisition to establish a contract between the University and the consultant/advisor. 
	Expenses in 5400 usually involve a purchase requisition to establish a contract between the University and the consultant/advisor. 
	Refer to the A&O Manual, Section 3.07 for more information or contact the Contracts & Purchasing Department. 

	Span

	5411 
	5411 
	5411 

	Academic Consultants 
	Academic Consultants 

	… individuals who provide academic services to the University, such as advising on curriculum revisions. 
	… individuals who provide academic services to the University, such as advising on curriculum revisions. 

	Span

	5421 
	5421 
	5421 

	Research Consultants 
	Research Consultants 

	… individuals who provide research services to the University, such as advising on sampling techniques. 
	… individuals who provide research services to the University, such as advising on sampling techniques. 

	Span

	5431 
	5431 
	5431 

	Administrative Consultants 
	Administrative Consultants 

	… individuals who provide advisory services related to University operations (such as strategic planning), or other administrative functions. Temp agency hires are classified here. 
	… individuals who provide advisory services related to University operations (such as strategic planning), or other administrative functions. Temp agency hires are classified here. 

	Span

	5441 
	5441 
	5441 

	Honoraria 
	Honoraria 

	… payments made to guest lecturers. 
	… payments made to guest lecturers. 

	Span

	5451 
	5451 
	5451 

	Interpreting Contractors 
	Interpreting Contractors 

	… payments made to external interpreting agencies. 
	… payments made to external interpreting agencies. 

	Span

	5461 
	5461 
	5461 

	Royalties 
	Royalties 

	… payments made to individuals from profits on items they created, such as the author of a book. 
	… payments made to individuals from profits on items they created, such as the author of a book. 

	Span

	5462 
	5462 
	5462 

	Advance Royalties 
	Advance Royalties 

	… royalty payments made before an item is sold. 
	… royalty payments made before an item is sold. 

	Span

	5500 
	5500 
	5500 

	Professional Fees/Service Contracts 
	Professional Fees/Service Contracts 

	As with 5400 expenses, service contracts may require purchase requisitions. Contact Contracts & Purchasing for more information. 
	As with 5400 expenses, service contracts may require purchase requisitions. Contact Contracts & Purchasing for more information. 

	Span

	5501 
	5501 
	5501 

	Legal fees 
	Legal fees 

	… legal services provided 
	… legal services provided 

	Span

	5502 
	5502 
	5502 

	Accounting fees 
	Accounting fees 

	…accounting, tax services provided (e.g.auditors) 
	…accounting, tax services provided (e.g.auditors) 

	Span

	5511 
	5511 
	5511 

	Professional Fees 
	Professional Fees 

	… professional services (e.g., consultants, architects, etc.) 
	… professional services (e.g., consultants, architects, etc.) 

	Span

	5521 
	5521 
	5521 

	Maintenance Contracts 
	Maintenance Contracts 

	… service contract with a vendor for regular maintenance of office equipment (e.g., monthly servicing of office copier). Emergency repairs (e.g., when the copier spews smoke) are classified under 5361. 
	… service contract with a vendor for regular maintenance of office equipment (e.g., monthly servicing of office copier). Emergency repairs (e.g., when the copier spews smoke) are classified under 5361. 

	Span

	5522 
	5522 
	5522 

	Software, Licenses, and Services 
	Software, Licenses, and Services 

	… purchase of computer software licenses and associated services, such as help line subscription. 
	… purchase of computer software licenses and associated services, such as help line subscription. 

	Span

	5531 
	5531 
	5531 

	Service Contracts 
	Service Contracts 

	… agreements with external companies or consultants who provide a business-related service, such as Web design. 
	… agreements with external companies or consultants who provide a business-related service, such as Web design. 

	Span


	5545 
	5545 
	5545 
	5545 

	Library Electronic DB Services 
	Library Electronic DB Services 

	… services for electronic DB for the library 
	… services for electronic DB for the library 

	Span

	5561 
	5561 
	5561 

	Insurance  
	Insurance  

	… property coverage, workers comp, auto, etc 
	… property coverage, workers comp, auto, etc 

	Span

	5600 
	5600 
	5600 

	Professional Development 
	Professional Development 

	Both professional organization expenses and job training fall under 5600. Related travel expenses, however, should appear in 5213 (Travel - Professional Development). 
	Both professional organization expenses and job training fall under 5600. Related travel expenses, however, should appear in 5213 (Travel - Professional Development). 

	Span

	5611 
	5611 
	5611 

	Professional Dues/Memberships 
	Professional Dues/Memberships 

	… annual dues to professional organizations related to an employee’s job. 
	… annual dues to professional organizations related to an employee’s job. 

	Span

	5621 
	5621 
	5621 

	Training Programs - On-Campus 
	Training Programs - On-Campus 

	… registration fee and related expenses for training provided by a Gallaudet department. 
	… registration fee and related expenses for training provided by a Gallaudet department. 

	Span

	5631 
	5631 
	5631 

	Training Programs - Off-Campus 
	Training Programs - Off-Campus 

	… registration fee and related expenses for training provided by a non-Gallaudet entity. 
	… registration fee and related expenses for training provided by a non-Gallaudet entity. 

	Span

	5641 
	5641 
	5641 

	Professional Meetings 
	Professional Meetings 

	… registration fee and related expenses for meetings and conferences of professional organizations. 
	… registration fee and related expenses for meetings and conferences of professional organizations. 

	Span

	5651 
	5651 
	5651 

	Sponsored Meetings 
	Sponsored Meetings 

	… expenses related to meetings for the general public (e.g., a lecture that has been advertised and open to the public) 
	… expenses related to meetings for the general public (e.g., a lecture that has been advertised and open to the public) 

	Span

	5700 
	5700 
	5700 

	Printing and Publishing 
	Printing and Publishing 

	This category is related to the production of actual books or printed material. Copying falls under 5324 (Reprographics) or 5325 (external). 
	This category is related to the production of actual books or printed material. Copying falls under 5324 (Reprographics) or 5325 (external). 

	Span

	5711 
	5711 
	5711 

	Printing and Publications 
	Printing and Publications 

	… production of a book or other printed material performed by an EXTERNAL vendor. 
	… production of a book or other printed material performed by an EXTERNAL vendor. 

	Span

	5718 
	5718 
	5718 

	Reprographic Printing and Publishing 
	Reprographic Printing and Publishing 

	… production of a book or other printed material performed by Reprographic Services. 
	… production of a book or other printed material performed by Reprographic Services. 

	Span

	5800 
	5800 
	5800 

	Student Aid 
	Student Aid 

	 
	 

	Span

	5811 
	5811 
	5811 

	Stipends 
	Stipends 

	… payment for student living and travel expenses. 
	… payment for student living and travel expenses. 

	Span

	5851 
	5851 
	5851 

	Tuition and Fees (Grants Only) 
	Tuition and Fees (Grants Only) 

	… tuition covered by grants. 
	… tuition covered by grants. 

	Span

	5900 
	5900 
	5900 

	Interdepartmental Charges 
	Interdepartmental Charges 

	These codes are used when paying other campus departments or receiving payments. 
	These codes are used when paying other campus departments or receiving payments. 

	Span

	5931 
	5931 
	5931 

	Campus Services 
	Campus Services 

	… payments to other campus departments. 
	… payments to other campus departments. 

	Span

	5932 
	5932 
	5932 

	Interdepartmental Credits 
	Interdepartmental Credits 

	… payments from other campus departments. 
	… payments from other campus departments. 

	Span

	6300 
	6300 
	6300 

	Special Projects 
	Special Projects 

	Special projects are just that — special, one-time expenses, such as developing a new workshop. 
	Special projects are just that — special, one-time expenses, such as developing a new workshop. 

	Span

	6301 
	6301 
	6301 

	Departmental Projects 
	Departmental Projects 

	… expenses related to a special project. 
	… expenses related to a special project. 

	Span


	6380 
	6380 
	6380 
	6380 

	Foreign Study Programs 
	Foreign Study Programs 

	… study abroad programs 
	… study abroad programs 

	Span

	6400 
	6400 
	6400 

	Furniture and Equipment 
	Furniture and Equipment 

	These expenses are often related to purchase orders. 
	These expenses are often related to purchase orders. 
	Criteria for whether or not an item must be inventoried is outlined in the A&O Manual, Section 2.23. Most departmental purchases are uninventoried. 

	Span

	6411 
	6411 
	6411 

	Furniture - Inventoried 
	Furniture - Inventoried 

	… furniture over $5,000. 
	… furniture over $5,000. 

	Span

	6421 
	6421 
	6421 

	Equipment - Inventoried 
	Equipment - Inventoried 

	… equipment (e.g., computers, copiers, printers, etc.) over $5,000. 
	… equipment (e.g., computers, copiers, printers, etc.) over $5,000. 

	Span

	6431 
	6431 
	6431 

	Equipment - Uninventoried 
	Equipment - Uninventoried 

	... equipment under $5,000. 
	... equipment under $5,000. 

	Span

	6441 
	6441 
	6441 

	Furniture - Uninventoried 
	Furniture - Uninventoried 

	… furniture under $5,000. 
	… furniture under $5,000. 

	Span

	6600 
	6600 
	6600 

	Access Services 
	Access Services 

	This category is related to the services provided by interpreters and for captioning.  
	This category is related to the services provided by interpreters and for captioning.  

	Span

	6630 
	6630 
	6630 

	GIS Interpreting Service 
	GIS Interpreting Service 

	…interpreting services provided by GIS 
	…interpreting services provided by GIS 

	Span

	6631 
	6631 
	6631 

	Interpreting Contractors 
	Interpreting Contractors 

	…interpreting services provided by an EXTERNAL contractor. 
	…interpreting services provided by an EXTERNAL contractor. 

	Span

	6632 
	6632 
	6632 

	Captioning Service 
	Captioning Service 

	..expenses related to captioning services 
	..expenses related to captioning services 

	Span


	The EDA Says No… 
	Gallaudet is unique in its funding because it receives money from the federal government. Yes, folks, your tax dollars go toward the money that is now running this University. When Congress passed the Education of the Deaf Act (EDA) in 1986, it authorized Gallaudet and the National Technical Institute of the Deaf to receive federal appropriations. It also prohibited the use of federal funds to purchase the following: 
	 Alcoholic beverages 
	 Alcoholic beverages 
	 Alcoholic beverages 

	 Goods or services for personal use 
	 Goods or services for personal use 

	 Housing and personal living expenses (unless required by written employment agreement) 
	 Housing and personal living expenses (unless required by written employment agreement) 

	 Lobbying 
	 Lobbying 

	 Membership in country clubs and social or dining clubs or organizations 
	 Membership in country clubs and social or dining clubs or organizations 

	 International student recruitment 
	 International student recruitment 


	Most of the no-no’s make sense. Look at it this way: If it would upset you to find out your representative or senator were spending your tax dollars to purchase an item, it probably is an EDA no-no, too. 
	 
	On the rare occasion that you do need to purchase one of the above items (e.g., wine for a reception), you must submit a request for non-federal discretionary funding with the president, vice president, or provost.  
	Garbage In, Garbage Out 
	Ahh, the golden rule of programmers also applies to good budgeters. The quality of information you get from your budget reports depends on the quality of data you provide on the accounting forms. In other words, if you do a lousy job assigning expense accounts (garbage in), your budget won’t tell you much about how your department spent its money (garbage out). 
	 
	Consequently, in this section we review the accounting forms you use most often. The bulk of your PeopleSoft report data comes from these forms, so it’s a good idea to understand the connection between what you enter in the forms and what you see in the reports.  
	 
	Some accounting forms (i.e., check requests, petty cash, I.I.s, etc.) allow you to enter an Optional Tracking Number field. If your department uses internal tracking (such as grouping expenses by course or by project), enter an Optional Tracking Number to code expenses for your own records. 
	 
	The following pages cover each form individually. The forms that appear are partial forms and should not be used for your future transactions. You can download the current forms by clicking the Forms & Procedures link on the Finance Office’s Web site at http://finance.gallaudet.edu. 
	 
	Check Request 
	Use this form to pay for products or services not associated with a purchase order. 
	 
	 
	 
	 
	Finance Office 
	Finance Office 
	Finance Office 
	Finance Office 
	College Hall, Room 108 
	Phone/tty 202 651-5299 
	Fax 202 448-6920 

	TD
	Span
	Gallaudet University 
	Check Request 

	Span
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	TD
	Span
	Today's 
	Date 

	  
	  

	TD
	Span
	OPTIONAL tracking number-up to 8 characters 

	  
	  

	Span
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	TD
	Span
	PAY TO: 

	Span

	TR
	TD
	Span
	Payee 

	 
	 
	 

	Span

	TR
	TD
	Span
	Address 

	  
	  
	  

	Span

	TR
	TD
	Span
	City 

	 
	 

	TD
	Span
	State 

	 
	 

	TD
	Span
	Zip Code 

	 
	 

	Span


	 
	Table
	TR
	TD
	Span
	Social Security # 
	(if payee is an individual) 

	 
	 

	Span
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	TR
	TD
	Span
	DESCRIPTION 

	TD
	Span
	AMOUNT 

	Span

	 
	 
	 
	 
	 

	 
	 

	Span

	 
	 
	 

	TD
	Span
	TOTAL 

	  
	  

	Span
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	TR
	TD
	Span
	CHARGE TO: 

	Span
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	TD
	Span
	Department 

	TD
	Span
	Expense Account 

	TD
	Span
	Amount 

	TD
	Span
	Department 

	TD
	Span
	Expense Account 

	TD
	Span
	Amount 

	Span

	 
	 
	 

	 
	 

	 
	 

	 
	 

	 
	 

	 
	 

	Span
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	Span
	Requested By 

	Signature:  
	Signature:  
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	Telephone 

	  
	  

	TD
	Span
	Date 
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	TD
	Span
	 

	Print: 
	Print: 

	TD
	Span
	 

	 
	 

	TD
	Span
	 

	 
	 

	Span


	APPROVED BY: Signature: ______________________________ DATE: ______________ 
	 Print: _______________________________ 
	Check requests must be approved in accordance with policy 2.02.  Appropriate documentation must be attached. 
	Special Instructions: 
	 U.S. resident 
	 U.S. resident 
	 U.S. resident 

	 International resident 
	 International resident 

	 EFT (attach appropriate paperwork for new account set-up) 
	 EFT (attach appropriate paperwork for new account set-up) 

	 Payment to this invoice only 
	 Payment to this invoice only 

	 Combine with other payments 
	 Combine with other payments 

	 Mail Check (please provide current address) 
	 Mail Check (please provide current address) 

	 Pick up at Cashier’s Office 
	 Pick up at Cashier’s Office 

	 Hold check with these special instructions 
	 Hold check with these special instructions 


	Partial form — Not for official use 

	Span


	Textbox
	Span
	Complete this section, if appropriate. 

	Textbox
	Span
	For your dept’s internal record keeping 

	Textbox
	Span
	You must provide the mailing address (and social security number, if applicable) for the payee, even if the payee insists on picking up the check. It’s an auditing thing; don’t question it. The payee name generally appears in GUACTJRN as the Journal Line Description. 

	Textbox
	Span
	If the check request is for several different products, you can list them here with their respective costs. Please provide as much detail as you can — it’s an auditing thing. 

	Textbox
	Span
	You can split costs with other departments or assign multiple expense accounts to one check request. Doing this will provide you with a more accurate picture of how you are spending money. 

	Figure
	 
	Interdepartmental Invoices (I.I.s) 
	Use this form to pay or receive payment from another campus department. 
	 
	 
	 
	 
	 
	 
	InlineShape
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	TD
	Span
	Today’s 
	Date 

	 
	 

	TD
	Span
	OPTIONAL tracking number-up to 8  
	characters 
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	DEPARTMENT REQUESTING SERVICE 
	DEPARTMENT REQUESTING SERVICE 
	DEPARTMENT REQUESTING SERVICE 
	DEPARTMENT REQUESTING SERVICE 

	TD
	Span
	 

	DEPARTMENT PROVIDING SERVICE 
	DEPARTMENT PROVIDING SERVICE 
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	Department 
	Name 
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	Span
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	Span
	Department 
	Name 
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	TR
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	Building and 
	Room Number 
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	Span
	Building and 
	Room Number 
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	TD
	Span
	Requested 
	By 
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	Span
	Ext 
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	TD
	Span
	Delivered 
	By 

	 
	 

	TD
	Span
	Ext 
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	Span
	 DESCRIPTION OF SERVICES 

	TD
	Span
	  AMOUNT 
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	TR
	TD
	Span
	FOR THIS TRANSACTION, ENTER THE DESCRIPTION  
	(UP TO 30 CHARACTERS) YOU WANT TO APPEAR IN YOUR 
	PEOPLESOFT FINANCIAL REPORT. 
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	Span
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	Span

	TR
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	Span
	CHARGE TO 
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	Span
	CREDIT TO 
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	TD
	Span
	Department 

	TD
	Span
	Expense Account 

	TD
	Span
	Amount 
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	Span
	Department  
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	Span
	Expense Account 
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	Span
	Amount 
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	Approved 
	By/Date 
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	Approved 
	By/Date 
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	Interdepartmental Invoices requests must be approved in accordance with policy 2.02.  
	Appropriate documentation must be attached. 
	Partial form — Not for official use 

	Span


	Textbox
	Span
	Always provide documentation! 

	Textbox
	Span
	For your dept’s internal record keeping 

	Textbox
	Span
	Department making  the payment 

	Textbox
	Span
	Department receiving reimbursement 

	Figure
	Textbox
	Span
	Whatever you enter here will appear on your GUACTJRN report. 

	Figure
	Textbox
	Span
	You can use the additional lines to list other products/services and their costs. 

	Textbox
	Span
	Complete the area that pertains to your department. Only complete the other department’s information if you have discussed department and account numbers with them. As with check requests, you can split costs/credits among several different accounts. 

	Textbox
	Span
	TOTAL 

	 
	Petty Cash 
	Use this form to receive cash from the Cashier’s Office. 
	 
	 
	 
	 
	 
	 
	InlineShape
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	TR
	TD
	Span
	Today’s 
	Date 

	 
	 

	TD
	Span
	OPTIONAL tracking 
	number-up to 8 
	characters 

	 
	 

	Span
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	TR
	TD
	Span
	PAY TO 
	 

	 
	 

	TD
	Span
	EXT. 

	 
	 

	TD
	Span
	AMOUNT 

	 
	 

	Span


	 
	Check One 
	 
	 
	 
	 

	TD
	Span
	REQUEST FOR PETTY CASH REIMBURSEMENT (Attach receipts) 

	Span

	 
	 
	 

	TD
	Span
	REQUEST FOR PETTY CASH ADVANCE (Receipts are due in three business day) 

	Span
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	TR
	TD
	Span
	DESCRIPTION OF EXPENSES 

	Span

	TR
	TD
	Span
	For this petty cash request, type the description 
	(up to 30 characters) you want to appear in your 
	PeopleSoft report. 

	 
	 

	Span

	DETAILED DESCRIPTION OF EXPENSES 
	DETAILED DESCRIPTION OF EXPENSES 
	DETAILED DESCRIPTION OF EXPENSES 
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	CHARGE TO: 
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	Department Account 
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	Span
	Expense Account 

	TD
	Span
	        Amount 

	TD
	Span
	Department Account 
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	   Expense Account 
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	Span
	    Amount 
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	APPROVED BY: ___________________________ ______________________________ DATE: ____________ 
	  Print Name    Signature 
	 
	PETTY CASH RECEIVED BY: ___________________ ______________________________ DATE: ____________ 
	    Print Name  Signature 
	 
	Petty Cash Forms must be approved in accordance with policy 2.07. Appropriate documentation must be attached. 
	Partial form — Not for official use 

	Span


	Textbox
	Span
	Always provide documentation! 

	Textbox
	Span
	For your dept’s internal record keeping 

	Textbox
	Span
	The person who’s getting the cash 

	Textbox
	Span
	You MUST provide a receipt and change (if applicable). 

	Figure
	Textbox
	Span
	Whatever you enter here will appear on your GUACTJRN report. 

	Figure
	Textbox
	Span
	You can expand on your entry here. 

	Textbox
	Span
	You can split costs among multiple departments and/or accounts. 

	 
	 
	 
	Travel Advance/Reimbursement Form 
	Use this form to record expenses related to travel for University business. 
	 
	Finance Office 
	Finance Office 
	Finance Office 
	Finance Office 
	College Hall #108 
	(202) 540-8519 – VideoPhone 
	(202) 651-5299 – Voice 
	(202) 448-6920 – FAX 

	TD
	Span
	Gallaudet University 
	Travel Advance / Reimbursement Form 

	Span

	TR
	TD
	Span
	Today’s Date 

	 
	 

	TD
	Span
	Travel Order # 
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	TR
	TD
	Span
	Name 

	 
	 

	Employee     Student   Other  
	Employee     Student   Other  

	Span

	TR
	TD
	Span
	Home or Campus Address 

	TD
	Span
	Street 

	 
	 

	Span

	TR
	TD
	Span
	City 

	 
	 

	TD
	Span
	State 

	 
	 

	TD
	Span
	Zip Code 

	 
	 

	Span

	TR
	TD
	Span
	Reason for this Trip and Traveler’s Role 

	 
	 

	 
	 
	Is this an International trip?  Yes   No  
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	TR
	TD
	Span
	Duration of Trip 

	TD
	Span
	From 

	Date 
	Date 
	 

	Time 
	Time 
	 

	TD
	Span
	To 

	Date 
	Date 
	 

	Time 
	Time 
	 

	TD
	Span
	Destination 

	 
	 

	Span

	TR
	TD
	Span
	Will any portion be paid by a Non-Gallaudet Organization? If so whom and amount. 
	(Check or cash receipt only at time of reimbursement.) 

	 
	 

	Span

	TR
	TD
	Span
	Detail of Expenses                                

	TD
	Span
	 

	TD
	Span
	Gallaudet P-Card 
	Expenses 

	TD
	Span
	Estimated Expenses 

	TD
	Span
	Actual Expenses 

	Span

	TR
	TD
	Span
	Item 

	TD
	Span
	Description 

	TD
	Span
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	Span
	Lodging 

	 
	 

	 
	 

	 
	 

	 
	 

	Span

	TR
	TD
	Span
	Meals 
	(Include conference agenda) 

	 
	 

	 
	 

	 
	 

	 
	 

	Span

	TR
	TD
	Span
	Transportation 
	(Include itinerary with  
	pre-approval form) 
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	Registration Fee 
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	Other Expenses 
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	TR
	TD
	Span
	Total 

	TD
	Span
	Receipts must be attached to support actual expenses. 
	Per diem rates may be used for meal expenses. 

	 
	 

	 
	 

	Span

	TR
	TD
	Span
	Note: Please submit this form to the Finance Office two weeks prior to the travel date if an advance is needed. Complete the estimated column to determine the travel advance. 

	TD
	Span
	Advance Requested 
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	Span
	 

	Span

	TR
	TD
	Span
	Department Account 

	 
	 

	TD
	Span
	Expense Account 
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	Span
	Advance Received 

	TD
	Span
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	TR
	TD
	Span
	 

	 
	 

	TD
	Span
	 

	 
	 

	TD
	Span
	 

	TD
	Span
	 

	 
	 

	Span


	Textbox
	Span
	Traveler’s information; home address is required if calculating mileage to/from a destination. 

	Textbox
	Span
	This is an auditing thing, to ensure travel falls within the guidelines outlined in the A&O Manual, Section 2.05. 

	Textbox
	Span
	Lodging = hotel. Obviously, mini-bar and other extra services are NOT included. 
	Meals = Travelers usually get $42/day for their meals. Alcohol, however, is NOT allowed. 
	Transportation = anything that gets them there — including mileage if using their own car. 
	Registration fee = conference/meeting registration. 
	Other expenses = other expenses incurred during the trip, like workshop fees not included with registration. 

	Textbox
	Span
	See next page. 

	Textbox
	Span
	With the exception of registration fees, everything on the form should fall under 5200 (Travel and Transportation). Registration should fall under 5600 (Professional Development). 
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	TR
	TD
	Span
	Pre-Travel Approval Required 
	(Travel expenses will not be reimbursed unless travel had been approved prior to the start of the travel and a copy of this document given to the Finance Office.) 

	Span

	TR
	TD
	Span
	Traveler’s Signature 

	TD
	Span
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	Span
	Date 

	TD
	Span
	 

	Span

	TR
	TD
	Span
	Approved: Budget Unit Head Signature 
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	Span
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	Span
	Date 

	TD
	Span
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	TR
	TD
	Span
	Approved: Senior Administrator’s Signature 
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	Span
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	Span
	Date 

	TD
	Span
	 

	Span

	TR
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	Span
	Approved for International Travel: President’s Signature 
	(if required) 
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	Span
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	Span
	Date 

	TD
	Span
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	Span
	Approval of Reimbursement Expenses Upon Return 

	TD
	Span
	Original 

	TD
	Span
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	TR
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	Amended 
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	Span
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	Traveler’s Signature 
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	Date 
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	Due Traveler 
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	Budget Unit Head Signature 
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	Date 

	TD
	Span
	 

	TD
	Span
	Due Gallaudet 

	TD
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	Senior Administrator’s Signature (if required) 

	TD
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	Date 

	TD
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	Span

	TR
	TD
	Span
	Finance Office Use Only 
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	Approved by 
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	Voucher Number 

	TD
	Span
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	Textbox
	Span
	Approvals must be obtained prior to the start of travel.  No expenses will be reimbursed unless all approvals have been completed. 

	Textbox
	Span
	Actual expenses must be documented and submitted within 5 business days after the return date. 
	 

	Additional notes on the Travel Advance/Reimbursement Form 
	You only need to complete the Estimated Expenses column if the traveler requests a travel advance. Once travel is completed, fill in the Actual Expenses column to calculate if money is due to or from the traveler.  
	If Estimated > Actual, the traveler owes money 
	If Estimated < Actual, the traveler gets reimbursed 
	Traveling with purchase cards. Generally, travelers who have purchase cards don’t need a travel advance. You still need to reconcile the meal expenses — whether charged to the hotel room, paid with cash, or paid on the purchase card — to ensure they fall within the per diem rates. You will also need to verify purchase card expenses and review account assignments on the JP Morgan Chase Web site, http://www.paymentnet.com. 
	 
	As stated on the form, when calculating estimated and actual expenses, do NOT include any items that have been paid for using the purchase card. Otherwise, items will be double-counted — once with this form and once with the automatic download from JP Morgan Chase. 
	 
	Is it allowed? It can be tricky determining if an expense is allowed as a travel expense. You can always refer to the A&O Manual, Section 2.05 for the University’s official guidelines on travel. You can also ask yourself, “Is this expense directly related to the individual’s assignment?” If it is, great! Process the expense. If it isn’t, you may need to discuss your concerns with the traveler to determine if the expense is allowable. 
	 
	 
	Personnel Action Form (PAF) 
	Use this form to record any employee status or salary changes in your department. 
	 
	Regular PAF — Page 1 
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	GALLAUDET UNIVERSITY 
	REGULAR 
	PERSONNEL ACTION FORM 

	Span
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	Effective Date 

	 
	 

	TD
	Span
	Today’s 
	Date 

	 
	 

	Span


	PERSONAL INFORMATION 
	Table
	TR
	TD
	Span
	Ms/Mrs/ 
	Mr/Dr 

	 
	 

	TD
	Span
	Name 
	L/F/MI  

	 
	 

	TD
	Span
	SS 
	# 
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	TR
	TD
	Span
	Address 
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	Span
	City 
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	Span
	State 

	 
	 

	TD
	Span
	Zip 
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	TR
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	Date of Birth 

	 
	 

	TD
	Span
	Home Telephone Number 
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	TYPE OF ACTION  
	 
	 
	 
	 

	TD
	Span
	New Appointment 

	 
	 

	TD
	Span
	Promotion 

	 
	 

	TD
	Span
	Performance Increase 

	 
	 

	TD
	Span
	Transfer 

	Span

	 
	 
	 

	TD
	Span
	Rehire 

	 
	 

	TD
	Span
	Reclassification 
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	Additional Responsibilities  

	 
	 

	TD
	Span
	Account Distribution 
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	Extension of Appointment 
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	Span
	Union Pay Adjustment 
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	Span
	Change of Status 

	 
	 

	Other: 
	Other: 

	Span
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	Span
	LWOP 

	Reason: 
	Reason: 
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	Span
	Return From LWOP 

	Span
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	Span
	Paid Leave 

	Type: 
	Type: 
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	Span
	Return From Paid Leave 

	Span


	POSITION CONTROL FUNDING 
	 
	 
	 
	 

	TD
	Span
	New Position 

	 
	 

	Replacement of: 
	Replacement of: 
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	Span
	Federal   

	 
	 

	TD
	Span
	Income 
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	Span
	Grant 
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	JOB INFORMATION 
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	TR
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	PREVIOUS 
	PREVIOUS 

	NEW 
	NEW 
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	Span
	Job Title 
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	TD
	Span
	Department Name 
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	TR
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	Department # and Account # (Object Code) 
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	TR
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	Appointment (i.e., 9, 10, 11, 12 months) 

	 
	 

	 
	 

	Span

	TR
	TD
	Span
	Full-Time/Part-Time (Hrs/Week, Attach Schedule) 

	 
	 

	 
	 

	Span


	SALARY 
	Table
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	PREVIOUS 
	PREVIOUS 

	NEW 
	NEW 

	Span

	TR
	TD
	Span
	Salary Schedule/Level/Step 
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	TR
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	Hourly Rate (Non-Exempt)/or Daily Rate 
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	TR
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	Base Salary (Exempt) 
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	TR
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	Span
	Add 
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	Span
	2/9 
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	Add Other 
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	Total 
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	TR
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	Salary Distribution (Describe, e.g., 9 mos salary paid over 12 mos) 

	 
	 

	 
	 

	Span


	ACCOUNT DISTRIBUTION (if more than one account) 
	 PREVIOUS NEW 
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	Partial form — Not for official use 

	Span


	Textbox
	Span
	This is an HR/Accounting thing and has to do with which fund is supporting the employee’s salary. 

	Textbox
	Span
	Official date the change is recorded in the employee’s personnel file. 

	Textbox
	Span
	Human Resources Services 
	College Hall, Room 106 
	Ext. 5352 

	Textbox
	Span
	Standard information collected about each employee. 

	Textbox
	Span
	For definitions of each action, please see the HR Web site on the University intranet. 

	Textbox
	Span
	Employee’s updated information; for new hires, this information can usually be found on the employee requisition form. 
	 
	See notes below for details about each field. 

	Textbox
	Span
	Employee’s current information; for new hires, leave this column blank. 
	 
	See notes below for details about each field. 

	Textbox
	Span
	This section is important for employees who are paid by multiple departments (e.g., faculty who receive special appointments outside their primary department). You can enter either the percentage each department is responsible for or the actual amount. 

	 
	Regular PAF — Page 2 
	LOCATION INFORMATION 
	LOCATION INFORMATION 
	LOCATION INFORMATION 
	LOCATION INFORMATION 
	Table
	TR
	TD
	Span
	Building 

	 
	 

	TD
	Span
	Room 

	 
	 

	TD
	Span
	Telephone Ext 

	 
	 

	TD
	Span
	Voice, TTY, or Both 

	 
	 

	Span


	 
	PREPARER VERIFICATION 
	Table
	TR
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	Span
	Prepared By 

	 
	 

	TD
	Span
	Telephone Extension 
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	TR
	TD
	Span
	I-9 Form 
	Attached 

	 
	 

	TD
	Span
	I-9 Form 
	On File 

	 
	 

	TD
	Span
	Tax Forms 
	Attached 

	 
	 

	TD
	Span
	Recent Tax Forms On  
	File (within calendar year) 

	 
	 

	TD
	Span
	Employee data sheet attached 
	(All temporary categories) 
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	SIGNATURE 
	SIGNATURE 

	DATE 
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	DATE 
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	Administrator 
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	HUMAN RESOURCES SERVICES/PAYROLL USE ONLY 

	TD
	Span
	Human Resources Services  
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	ORIGINAL MUST BE SUBMITTED TO THE HUMAN RESOURCES SERVICES OFFICE.  DEPARTMENTS SHOULD MAKE COPIES FOR THEIR FILES.   
	ATTACH SUPPORTING DOCUMENTS. 
	Partial form — Not for official use 

	Span


	Textbox
	Span
	This information is for the employee directory. If the employee works for two different departments, list the location where you are most likely to find this person. 

	Textbox
	Span
	The top line applies to you, the person who prepared the PAF. The second line (tax forms, etc.) applies to the employee. In most cases, the tax forms should already be on file with HR. If the individual is a new hire or rehire, you might want to check if HR has already collected the appropriate forms from him/her. If not, get them and submit with the PAF. 

	Additional notes on the PAF 
	The field descriptions for the Job Information box are as follows: 
	 Job Title. This title will also be used for the individual’s directory listing. 
	 Job Title. This title will also be used for the individual’s directory listing. 
	 Job Title. This title will also be used for the individual’s directory listing. 

	 Department Name. For employees who work in two different departments, list the individual’s primary department, where the position resides. 
	 Department Name. For employees who work in two different departments, list the individual’s primary department, where the position resides. 

	 Department # and Account Code. The primary department’s budget code and the individual’s account code. Contact HR for help with employee classifications. 
	 Department # and Account Code. The primary department’s budget code and the individual’s account code. Contact HR for help with employee classifications. 

	 Appointment. Indicate the employee’s appointment (i.e., 9-, 10-, 11-, or 12-month). 
	 Appointment. Indicate the employee’s appointment (i.e., 9-, 10-, 11-, or 12-month). 

	 Full-time/Part-time. This matters for employee classification and also as a qualification for benefits. Hours per week must be indicated. Attach the employee’s schedule for eTIME®. 
	 Full-time/Part-time. This matters for employee classification and also as a qualification for benefits. Hours per week must be indicated. Attach the employee’s schedule for eTIME®. 


	 
	The field descriptions for the Salary box are as follows: 
	 Salary Schedule/Level/Step. The salary schedule is based on the employee’s status as a faculty, staff or teacher. For new hires, the salary schedule should be listed on the employee requisition form. 
	 Salary Schedule/Level/Step. The salary schedule is based on the employee’s status as a faculty, staff or teacher. For new hires, the salary schedule should be listed on the employee requisition form. 
	 Salary Schedule/Level/Step. The salary schedule is based on the employee’s status as a faculty, staff or teacher. For new hires, the salary schedule should be listed on the employee requisition form. 

	 Hourly (Non-exempt) or Daily Rate and Base Rate (Exempt). Indicate the employee’s previous and new pay rate. 
	 Hourly (Non-exempt) or Daily Rate and Base Rate (Exempt). Indicate the employee’s previous and new pay rate. 

	 Add 1/9, 2/9. This field is for faculty who have a 10- or 11-month appointment. 
	 Add 1/9, 2/9. This field is for faculty who have a 10- or 11-month appointment. 

	 Add Other. Indicate any additional pay. 
	 Add Other. Indicate any additional pay. 

	 Total. The sum of the base salary and additional payments (1/9, 2/9, other fields). For hourly and daily rate employees, this field is just their hourly or daily rate. 
	 Total. The sum of the base salary and additional payments (1/9, 2/9, other fields). For hourly and daily rate employees, this field is just their hourly or daily rate. 

	 Salary Distribution. Indicate the employee’s salary distribution (e.g., 12 mos. over 12 mos.; 9 mos. over 9 mos.; or 9 mos. over 12 mos.) 
	 Salary Distribution. Indicate the employee’s salary distribution (e.g., 12 mos. over 12 mos.; 9 mos. over 9 mos.; or 9 mos. over 12 mos.) 


	 
	For special payments, use the Special Personnel Action Form (SPAF). If you have any questions about completing PAFs or SPAFs, contact the HR office at ext. 5352 v/tty or go to their Web site: http://af.gallaudet.edu/hrs/hrs.asp. 
	Purchase Requisition 
	Use this form to create purchase orders for purchases over $5,000 or for service contracts with specific terms. 
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	TD
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	REQUISITION 
	NUMBER 

	 
	 

	Span

	TR
	TD
	Span
	FOR INTERNAL USE ONLY. THIS IS 
	NOT A PURCHASE ORDER NUMBER. 
	“DO NOT GIVE TO VENDORS.” 

	Span

	TR
	TD
	Span
	TODAY’S  DATE 

	 
	 

	 
	 

	 
	 

	Span

	ACCOUNT NUMBER 
	ACCOUNT NUMBER 
	ACCOUNT NUMBER 
	 

	DEPT./GRANT NAME 
	DEPT./GRANT NAME 
	 

	DELIVER TO: BLDG/ROOM NO. 
	DELIVER TO: BLDG/ROOM NO. 
	 

	Span

	INVENTORY ACCOUNT NUMBER (if other than above) 
	INVENTORY ACCOUNT NUMBER (if other than above) 
	INVENTORY ACCOUNT NUMBER (if other than above) 
	 

	DATE NEEDED 
	DATE NEEDED 
	 

	FOR QUESTIONS ABOUT THIS REQ., CONTACT/PHONE 
	FOR QUESTIONS ABOUT THIS REQ., CONTACT/PHONE 
	 

	Span

	SPECIAL INSTRUCTIONS: 
	SPECIAL INSTRUCTIONS: 
	SPECIAL INSTRUCTIONS: 
	 

	Span

	TR
	TD
	Span
	SELECTED CONTRACTOR (DO NOT WRITE IN THIS SPACE) 

	LIST THREE SUGGESTED CONTRACTORS, ADDRESSES, TELEPHONE NUMBERS 
	LIST THREE SUGGESTED CONTRACTORS, ADDRESSES, TELEPHONE NUMBERS 

	Span

	TR
	TD
	Span
	SHIP VIA: 

	TD
	Span
	INVOICE TERMS: 

	DELIVERY DATE: 
	DELIVERY DATE: 

	Span

	ITEM 
	ITEM 
	ITEM 

	QUANTITY 
	QUANTITY 

	UNIT 
	UNIT 

	 
	 
	COMPLETE DESCRIPTION 
	 

	MODEL NUMBER, SIZE, COLOR, CATALOG NUMBER, MANUFACTURER, SPECIAL INSTRUCTIONS, ETC. 
	MODEL NUMBER, SIZE, COLOR, CATALOG NUMBER, MANUFACTURER, SPECIAL INSTRUCTIONS, ETC. 

	UNIT PRICE 
	UNIT PRICE 

	AMOUNT 
	AMOUNT 

	Span
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	TOTAL 
	TOTAL 
	TOTAL 

	TD
	Span
	 

	Span


	APPROVAL SIGNATURE 
	1 
	1 
	1 
	1 

	INITIATOR 
	INITIATOR 

	SIGNATURE DATE 
	SIGNATURE DATE 
	 

	3 
	3 

	ADMINISTRATOR/VICE PRES. 
	ADMINISTRATOR/VICE PRES. 
	 

	SIGNATURE DATE 
	SIGNATURE DATE 
	 

	Span

	2 
	2 
	2 

	BUDGET UNIT HEAD 
	BUDGET UNIT HEAD 
	 

	SIGNATURE DATE 
	SIGNATURE DATE 
	 

	4 
	4 

	VICE-PRESIDENT 
	VICE-PRESIDENT 
	 

	SIGNATURE DATE 
	SIGNATURE DATE 
	 

	Span


	 
	Partial form — Not for official use 

	Span


	GALLAUDET UNIVERSITY 
	GALLAUDET UNIVERSITY 
	REQUISITION 
	 
	Create an 8-digit Requisition number using your 4-digit Budget Unit number plus a 4-digit number in sequence (Do not use the same number twice) 

	Textbox
	Span
	Preprinted forms have pre-assigned req. numbers. For electronic forms, follow the directions (circled). 

	Figure
	Figure
	Textbox
	Span
	For product delivery 

	Textbox
	Span
	Department budget code 

	Textbox
	Span
	Expense account code 

	Textbox
	Span
	Usually your name & extension 

	Textbox
	Span
	List each item or service individually; they correspond to the line items listed in your POSTAT report. (See Part II.) 
	As always, include documentation when possible. 

	Textbox
	Span
	The person who will receive the products/services. 

	Textbox
	Span
	Large purchases may require administrator signatures, depending on the BUH’s financial authority. (See Financial Access form below.) 

	Textbox
	Span
	The BUH must sign all requisitions. 

	 
	Along with all the accounting forms to spend your department’s funds, there are forms to manage the funds. 
	Budget Revision 
	Use this form to revise expense account allocations within your budget OR to transfer funds from one department to another. Remember, all revisions must equal zero. 
	Textbox
	Span
	For your dept’s internal record keeping 
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	TR
	TD
	Span
	Today’s 
	Date 
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	OPTIONAL tracking 
	number-up to 8 characters 
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	FISCAL YEAR 
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	PERMANENT REVISION 

	      
	      

	TD
	Span
	TEMPORARY REVISION 
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	TD
	Span
	BUDGET UNIT 
	NUMBER 

	TD
	Span
	EXPENSE/ 
	REVENUE 
	ACCOUN  

	TD
	Span
	AMOUNT 
	(IN $$ ONLY) 
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	DESCR PTION 

	Span

	      
	      
	      

	      
	      

	      
	      

	      
	      

	Span

	      
	      
	      

	      
	      

	      
	      

	      
	      

	Span

	      
	      
	      

	      
	      

	      
	      

	      
	      

	Span

	      
	      
	      

	      
	      

	      
	      

	      
	      

	Span

	      
	      
	      

	      
	      

	      
	      

	      
	      

	Span

	      
	      
	      

	      
	      

	      
	      

	      
	      

	Span

	TR
	TD
	Span
	 

	TOTAL 
	TOTAL 
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	APPROVED 
	Table
	TR
	TD
	Span
	Budget Unit 
	Head 

	      
	      

	TD
	Span
	Date 

	      
	      

	Span

	TR
	TD
	Span
	Unit 
	Administrator 

	      
	      

	TD
	Span
	Date 

	      
	      

	Span

	TR
	TD
	Span
	Administrative 
	Officer 

	      
	      

	TD
	Span
	Date 

	      
	      

	Span

	TR
	TD
	Span
	Finance  
	Office 

	      
	      

	TD
	Span
	Date 

	      
	      

	Span

	Partial form — Not for official use 
	Partial form — Not for official use 
	Partial form — Not for official use 

	Span


	 

	Span


	Textbox
	Span
	The fiscal year in which the revision becomes effective, usually the current fiscal year (if submitting this form well before September) or the next one (if revising around September). 

	Textbox
	Span
	If you intend for the change to become a part of your budget going forward, check permanent. If it is effective for only one year, check temporary. 

	Textbox
	Span
	Budget Unit Number. Department’s budget number. 
	Expense/Revenue Account. Accounts being revised. Remember to keep the nonpayroll accounts at the “00” level. Payroll changes can be listed at the detail level. 
	Amount. Use whole dollar figures. Remember that the sum of all amounts must be zero. 
	Description. This line appears in GUBUDJRN. It is where you record the reason for the revision. 

	Figure
	 
	 
	 
	Financial Signature/Access Authority Form 
	Use this form to change who has access to your department’s funds. Typically, you only use this form when there is a personnel change. 
	 
	 
	 
	 
	 
	 
	 
	 
	InlineShape


	FINANCIAL SIGNATURE / ACCESS AUTHORITY FORM 
	FINANCIAL SIGNATURE / ACCESS AUTHORITY FORM 
	GALLAUDET UNIVERSITY 
	Finance OFFICE 
	College Hall - Room 108 
	Phone: 202 / 651-5299 (VOICE / TTY) - Fax: 202 / 448-6920 

	Span


	 
	 
	 
	 

	 
	 

	Funding Source: 
	Funding Source: 

	Span

	TR
	Print Organization Name / Project Title below:      (Note: Only 30 characters will show in the system) 
	Print Organization Name / Project Title below:      (Note: Only 30 characters will show in the system) 

	General 
	General 

	 
	 

	Span

	TR
	 
	 

	Endowment 
	Endowment 

	 
	 

	Span

	TR
	Division: 
	Division: 

	Donation 
	Donation 

	 
	 

	Span

	TR
	Dean-Director to which the ORG reports: 
	Dean-Director to which the ORG reports: 

	Grant 
	Grant 

	 
	 

	Span

	TR
	Assoc. Dean Unit, if applicable: 
	Assoc. Dean Unit, if applicable: 

	Other * 
	Other * 

	 
	 

	Span


	 * Provide details for Other Funding Source: 
	Please indicate which one: 
	Please indicate which one: 
	Please indicate which one: 
	Please indicate which one: 
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	New* 

	TD
	Span
	Change 

	TD
	Span
	Removal 

	Span
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	* New organizations must complete the form located at http://intranet.gallaudet.edu/af/Finance/neworg.html 
	 

	Under $500 
	Under $500 

	$500 - $9,999 
	$500 - $9,999 

	$10,000 - $24,999 
	$10,000 - $24,999 

	$25,000 or more 
	$25,000 or more 

	Petty Cash (limit $100) 
	Petty Cash (limit $100) 

	Biweekly Payroll 
	Biweekly Payroll 

	Payroll Authorization 
	Payroll Authorization 

	Budget Revisions 
	Budget Revisions 

	View PeopleSoft Reports 
	View PeopleSoft Reports 

	Span

	 
	 
	 

	Print: name here 
	Print: name here 

	Position Title: 
	Position Title: 

	Signature: 
	Signature: 

	Please use Y or N in each box 
	Please use Y or N in each box 
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	_________________________________________________________   ______________________ 
	Unit Administrator Signature [Directors, Associate Deans, Managers, and Department   Date 
	Heads reporting to a Senior Administrator (see definition below)], required on all forms. 
	 
	 
	_________________________________________________________   ______________________ 
	Senior Administrator Signature (Special Assistants to the President;    Date 
	Deans & Associate Deans reporting directly to the Provost; and 
	Executive Directors & Directors reporting directly to the VP), required if $10,000 or over. 
	 
	 
	_________________________________________________________   ______________________ 
	Administrative Officer Signature (Vice President, Provost, & President), required    Date 
	if $25,000 or over. 
	Partial form — Not for official use 
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	Textbox
	Span
	Identifies where your department falls in the University organizational structure. 
	 

	Textbox
	Span
	Organization No. 
	 
	 
	 
	 

	 
	 

	 
	 

	 
	 

	Span


	4 digits 

	Textbox
	Span
	Department budget 

	Textbox
	Span
	Most likely, you will check General. The other funds are special accounts. 

	Textbox
	Span
	Any employee who needs access to the department’s funds must sign this form. Generally, anyone who receives financial access will be authorized to make purchases up to $500 and request petty cash. BUHs receive authority for expenses above $500, payroll authorization, budget revisions and access to PeopleSoft. Administrative assistants should have access to biweekly payroll (meaning they’re the ones who fill out the forms), PeopleSoft and, depending on their situation, may have authority for expenses above $

	Part II: PeopleSoft Reports 
	Part II: PeopleSoft Reports 
	—
	 
	Up Close and Personal
	 

	Now that we’ve discussed “Garbage In, Garbage Out” and reviewed the accounting forms, let’s look at the output part of budgeting … the PeopleSoft reports. This section summarizes each PeopleSoft report, explaining what they contain and how to use them. 
	The big picture 
	Before we look at each individual report, it’s important to note that they are all summarized on the GUBS (Budget Status by Account) report. The arrows below show where the information can be found in more detail. Get to know GUBS — it’s your map through “Budget Land.” 
	P
	Span
	 
	InlineShape

	The big picture — How GUBS summarizes all the reports 
	The workhorses — What you’ll use every time 
	If you’ve been handling your department’s budget for a while, you’re probably quite familiar with the Budget Status by Account and Actuals Detail reports. There’s good reason for this — they provide almost everything you need to know about your budget. 
	GUBS — Budget Status by Account 
	GUBS should be the first stop every time you study your budget. As we mentioned earlier, it combines all your reports into one document, which means it’s a snapshot of your department’s financial situation. 
	 
	GUBS Summary 
	GUBS Summary 
	GUBS Summary 
	GUBS Summary 
	 Purpose: Provide snapshot of your financial situation 
	 Purpose: Provide snapshot of your financial situation 
	 Purpose: Provide snapshot of your financial situation 

	 Expenses: Shown as negatives 
	 Expenses: Shown as negatives 

	 Rows: Top section is revenue; middle is payroll; bottom is nonpayroll 
	 Rows: Top section is revenue; middle is payroll; bottom is nonpayroll 

	 Columns:  Where you started (Annual Budget), where you are today (Remaining), and how you got there (Encumbered, Actual Expenses/Revenues, and Total) 
	 Columns:  Where you started (Annual Budget), where you are today (Remaining), and how you got there (Encumbered, Actual Expenses/Revenues, and Total) 

	 Claim to fame: Shows you the bottom line 
	 Claim to fame: Shows you the bottom line 



	Span
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	Span
	 
	InlineShape

	Sample GUBS (Budget Status by Account) report 
	 
	Tour by rows. Most likely, when you open a GUBS file, you won’t see the revenue portion of the report — relatively few departments need a revenue budget. But if your department happens to be one of them, you can find your revenue budget at the top of the GUBS report. For more information about revenue budgets, please contact the Finance Office. 
	 
	The next section summarizes payroll information. It is the only part of the report that provides category breakdowns (i.e., accounts ending in digits other than “00”). Almost everything in payroll is a fixed expense, meaning the expenses are the same each pay period. As mentioned in Part I, payroll is encumbered to ensure your department has enough money to cover everyone’s 
	salary and benefits. The only exception to this rule is Student Compensation (5135). This expense is variable, depending on how many hours your student worker(s) clocked; 5135 funds are not encumbered. 
	 
	The bottom section contains nonpayroll information. Here, expenses are grouped at the general category level. Encumbrances in nonpayroll indicate purchase orders that have outstanding payments. 
	 
	The last row is your budget’s bottom line. It provides totals to date for each column, the most important of which is the Remaining value. 
	 
	Tour by columns. The columns in GUBS are linked through simple math: 
	 
	 
	 
	 
	 

	ANNUAL BUDGET 
	ANNUAL BUDGET 

	ENCUMBERED 
	ENCUMBERED 

	ACTUAL EXPENSES/ REVENUES 
	ACTUAL EXPENSES/ REVENUES 

	TOTAL 
	TOTAL 

	REMAINING 
	REMAINING 

	Span

	Math formula 
	Math formula 
	Math formula 

	A 
	A 

	B 
	B 

	C 
	C 

	B + C 
	B + C 

	A - (B + C) 
	A - (B + C) 

	Span

	Example 
	Example 
	Example 

	1,000 
	1,000 

	-300 
	-300 

	-500 
	-500 

	-800 
	-800 

	200 
	200 

	Span


	 
	In English, it means that what you’ve set aside (encumbered) and what you’ve actually spent (actuals) are deducted from your annual budget to give you what’s left to spend (remaining).  
	 
	Keep in mind, however, that encumbered funds are funds you’ve promised to pay but haven’t actually paid yet. In the example above, your funds are actually $500, because the $300 that’s encumbered is still in your possession. Here’s a good rule of thumb: If the encumbered amount is in payroll, consider it money you can’t touch. The only time you can deobligate encumbered payroll is if there’s a personnel change in your department. If the encumbered amount is in nonpayroll, you can think about deobligating th
	 
	How to use the report. Consider this report your “cheat sheet” when the BUH asks you, “How much money do we have left in our budget? Can we afford to do XYZ?” Scan the bottom line to see your budget’s vital statistics — total budget, total expenses to date, and total funds left. When forecasting future expenses, you could scan the Encumbered column to see how much money you owe on existing purchase orders. (You’ll also want to calculate your monthly fixed nonpayroll expenses, like pager subscriptions and ph
	GUACTJRN — Actuals Detail 
	GUACTJRN (Actuals Detail) lists every expense as it was entered into PeopleSoft. If you were to sum the expenses by account, the totals would correlate to the rows in GUBS. Whereas GUBS gives you a budget snapshot, GUACTJRN shows you every single transaction that happened. 
	 
	Data for GUACTJRN come from the accounting forms (see Part I, Garbage In, Garbage Out), payroll, Corporate Express, JP Morgan Chase (purchase card), and campus service departments (Reprographics, Telephone, Postal Services, Transportation and GIS). With so many data sources, it’s possible (though infrequent) to find errors in this report. You should review the entries regularly and report discrepancies to the Finance Office. 
	 
	GUACTJRN Summary 
	GUACTJRN Summary 
	GUACTJRN Summary 
	GUACTJRN Summary 
	 Purpose: Provides detail about each transaction 
	 Purpose: Provides detail about each transaction 
	 Purpose: Provides detail about each transaction 

	 Expenses: Shown as positives 
	 Expenses: Shown as positives 

	 Rows: Each transaction 
	 Rows: Each transaction 

	 Columns: Data fields about each transaction 
	 Columns: Data fields about each transaction 

	 Claim to fame: Allows you to analyze spending behavior 
	 Claim to fame: Allows you to analyze spending behavior 



	Span
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	Span
	 
	InlineShape

	Sample GUACTJRN (Actuals Detail) report 
	 
	Tour by rows. Each row equals one financial transaction. At the beginning of the fiscal year, GUACTJRN might be only a page long. By August, however, it’s practically a book! Transactions (or records) are entered into PeopleSoft in the order they were received, which means that sometimes, you’ll find an expense from last month in the middle of this month’s entries. Before reconciling your report, perform a SORT by date (see Part IV, Manipulating and analyzing budget data) to ensure out of order entries are 
	 
	The last row of GUACTJRN totals all your expenses. Because this report tracks how much you’ve spent, expenses are positive numbers and reimbursements are negative. 
	 
	Tour by columns. You probably won’t use most of the columns in the report, but they are necessary to record complete information about each transaction. 
	 Journal and Line # are record identifiers. Give this information to Finance Office staff when you have questions about specific transactions. It’ll help them find the record faster. 
	 Journal and Line # are record identifiers. Give this information to Finance Office staff when you have questions about specific transactions. It’ll help them find the record faster. 
	 Journal and Line # are record identifiers. Give this information to Finance Office staff when you have questions about specific transactions. It’ll help them find the record faster. 

	 Period and Date tell you when the transaction occurred. Period refers to the month of the fiscal year (October = 1, November = 2, etc.) 
	 Period and Date tell you when the transaction occurred. Period refers to the month of the fiscal year (October = 1, November = 2, etc.) 

	 Org, Fund, and Acct tell you where the transactions were counted. Org is your department’s budget code; Fund refers to which pot of money the funds came from (general, grants, etc.); and Acct is the expense account. Of the three, you really only pay attention to Acct. 
	 Org, Fund, and Acct tell you where the transactions were counted. Org is your department’s budget code; Fund refers to which pot of money the funds came from (general, grants, etc.); and Acct is the expense account. Of the three, you really only pay attention to Acct. 

	 Monetary Amount, Ref, and Journal Line Description tell you how much the transaction was and what it was for. There’s actually a relationship between Journal and Ref. Below is a table that explains it. (Wow your colleagues at your next budget meeting!) 
	 Monetary Amount, Ref, and Journal Line Description tell you how much the transaction was and what it was for. There’s actually a relationship between Journal and Ref. Below is a table that explains it. (Wow your colleagues at your next budget meeting!) 


	Table 2: The Journal and Ref relationship 
	Journal Prefix 
	Journal Prefix 
	Journal Prefix 
	Journal Prefix 

	Journal Source 
	Journal Source 

	Ref 
	Ref 

	Description 
	Description 

	Span

	All numbers 
	All numbers 
	All numbers 

	Interdepartmental transfer, GIS, Travel, Reprographics, Post Office, Other Finance Office entries 
	Interdepartmental transfer, GIS, Travel, Reprographics, Post Office, Other Finance Office entries 

	Blank 
	Blank 

	Varies 
	Varies 

	Span

	AP 
	AP 
	AP 

	Accounts Payable 
	Accounts Payable 

	Invoice # 
	Invoice # 

	Vendor Name 
	Vendor Name 

	Span

	AV 
	AV 
	AV 

	Development Office 
	Development Office 

	Constituent ID 
	Constituent ID 

	Batch ID + Donor name 
	Batch ID + Donor name 

	Span

	BSS 
	BSS 
	BSS 

	Bookstore 
	Bookstore 

	Blank 
	Blank 

	Date of Service 
	Date of Service 

	Span

	EXP 
	EXP 
	EXP 

	Staples (Corporate Express) 
	Staples (Corporate Express) 

	EWAY Order # 
	EWAY Order # 

	Order Number 
	Order Number 

	Span

	EXP 
	EXP 
	EXP 

	JPMorgan Purchase Card 
	JPMorgan Purchase Card 

	Transaction YYMMDD 
	Transaction YYMMDD 

	Vendor Name 
	Vendor Name 

	Span

	EXP 
	EXP 
	EXP 

	Telephone 
	Telephone 

	Month 
	Month 

	Telephone Line or Telephone MRC Service 
	Telephone Line or Telephone MRC Service 

	Span

	PEX 
	PEX 
	PEX 

	Payroll 
	Payroll 

	Pay Period 
	Pay Period 

	Employee Name 
	Employee Name 

	Span

	SF 
	SF 
	SF 

	Student Accounts Tuition or Fee Charged 
	Student Accounts Tuition or Fee Charged 

	Student's ID # 
	Student's ID # 

	Tuition or fee description 
	Tuition or fee description 

	Span

	SF 
	SF 
	SF 

	Cashier's Office 
	Cashier's Office 

	Blank 
	Blank 

	C/R + deposit date + deposit description 
	C/R + deposit date + deposit description 

	Span


	 Year is the fiscal year in which the transaction was counted. 
	 Year is the fiscal year in which the transaction was counted. 
	 Year is the fiscal year in which the transaction was counted. 


	 
	How to use the report. You’ll probably use GUACTJRN the most, as it can give you the clearest picture of your department’s spending behavior. By using the Excel functions explained in Part IV, you can analyze expenses by account. For example, you might track Professional Development (5600) expenses over several months to see if they form a pattern (like steady 
	increases). This pattern, in turn, could guide decisions to revise budget allocations or change employee behavior (as in “Stop going to conferences every month!”). 
	The fine tuners — What you’ll use to adjust your budget 
	These reports are handy when you need to revise your budget, which should be at least once a year. (Budgets expire! See Part I, What is a budget?) They do not contain information about your actual expenses or revenue; they only look at your plans to spend or earn money. 
	GUBE/GUBR — Expense/Revenue Budget 
	GUBE (Expense Budget) and GUBR (Revenue Budget) are essentially the same report. GUBE, obviously, looks at the expenditure side of the budget while GUBR looks at earnings. These reports look like GUBS, and they function in much the same way, too. In this case, GUBE and GUBR provide snapshots of how the budget has been revised. Because these reports do not track expenses, positive and negative numbers indicate increases and decreases to accounts. With the exception of COLAs applied by HR and funding increase
	 
	GUBE/GUBR Summary 
	GUBE/GUBR Summary 
	GUBE/GUBR Summary 
	GUBE/GUBR Summary 
	 Purpose: Provide snapshot of changes to department budget 
	 Purpose: Provide snapshot of changes to department budget 
	 Purpose: Provide snapshot of changes to department budget 

	 Rows: (GUBE) Top half is payroll; bottom half is nonpayroll; (GUBR) revenue accounts 
	 Rows: (GUBE) Top half is payroll; bottom half is nonpayroll; (GUBR) revenue accounts 

	 Columns: Changes to the budget 
	 Columns: Changes to the budget 

	 Claim to fame: Shows how your budget has changed over the fiscal year 
	 Claim to fame: Shows how your budget has changed over the fiscal year 



	Span


	 
	Because most departments do not collect revenue, this section will focus only on GUBE. For help with GUBR, contact the Finance Office. 
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	InlineShape

	Sample GUBE (Expense Budget) report 
	 
	Tour by rows. As with GUBS, GUBE is divided into payroll allocations on top and nonpayroll on the bottom.  
	 
	Note how the sample budget above shows mostly “0.00” for nonpayroll expenses. Clearly, the department has not budgeted well for its initiatives. They may have enough money to cover their projects, but their budget should reflect how funds will be used. Remember, budget = plan to use money. Zero allocations = zero planning. 
	 
	Here’s the same budget with a little more planning. 
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	Sample GUBE report — revised budget plan 
	 
	Based on this budget, the department has staff who plan to attend a conference, because they have allocated funds in Professional Development (5600) and Transportation & Travel (5200). Likewise, this department is undertaking a major project with the help of a consultant, as Consultants & Advisors (5400) and Special Projects (6300) show. Finally, this department plans to replace some computers and has set aside funds in Furniture and Equipment (6400) to cover that. 
	 
	Tour by columns. Like GUBS, the columns in GUBE/GUBR are related by math functions. 
	 
	 
	 
	 
	 

	BASE BUDGET 
	BASE BUDGET 

	PERMANENT REVISION 
	PERMANENT REVISION 

	BASE & PERMANENT TOTAL 
	BASE & PERMANENT TOTAL 

	TEMPORARY REVISION 
	TEMPORARY REVISION 

	REVISED BUDGET 
	REVISED BUDGET 

	Span

	Math formula 
	Math formula 
	Math formula 

	A 
	A 

	B 
	B 

	A + B 
	A + B 

	C 
	C 

	A + B + C 
	A + B + C 

	Span

	Example 
	Example 
	Example 

	1,000 
	1,000 

	500 
	500 

	1,500 
	1,500 

	200 
	200 

	1,700 
	1,700 

	Span


	 
	Base budget is the budget you begin the fiscal year with. Often, it’s your revised budget from the previous year. A permanent revision is a budget change that will carry over to all subsequent fiscal years. In the table above, your base budget for the next fiscal year would be $1,500, as you made a $500 permanent revision. A temporary revision is a change to the budget for the current fiscal year only. Typically, you would see a temporary revision if a department is undertaking a special project, like a maj
	 
	You might use permanent and temporary revisions to reallocate funds in your nonpayroll budget. Just remember that the revisions must equal zero. Continuing our budget illustration, here’s how permanent and temporary revisions would be recorded: 
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	Sample GUBE report — permanent and temporary revisions 
	 
	Notice the Total Non-Payroll line. The sums of the permanent revisions and temporary revisions are both zero. Funds were reallocated from General Office Expenses (5300) and Special Projects (6300). Based on this budget, we can tell that the use of a consultant is intended for this fiscal year only. The other expenses will carry over to subsequent years, meaning the department plans 
	to send staff to professional development conferences and replace computer equipment annually. (Nice department!) 
	 
	How to use the report. This report is especially handy when doing your annual budget review to see if your department’s priorities and activities will be appropriately funded. It will give you an overview of what needs to be changed and how to shift the funds. 
	GUBUDJRN — Budget Detail 
	In the previous section, we compared GUBS and GUBE/GUBR. As you might have guessed, GUBUDJRN is comparable to GUACTJRN, except this report tracks details about budget changes. And like GUBE/GUBR, GUBUDJRN does not track any expenses. 
	 
	GUBUDJRN Summary 
	GUBUDJRN Summary 
	GUBUDJRN Summary 
	GUBUDJRN Summary 
	 Purpose: Provide details about budget changes 
	 Purpose: Provide details about budget changes 
	 Purpose: Provide details about budget changes 

	 Rows: Individual revisions to budget 
	 Rows: Individual revisions to budget 

	 Columns: Data fields about each revision 
	 Columns: Data fields about each revision 

	 Claim to fame: Provides the “Why?” behind budget revisions 
	 Claim to fame: Provides the “Why?” behind budget revisions 
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	Sample GUBUDJRN (Budget Detail) report 
	 
	Tour by rows. Each row is an individual budget revision. If you submit several budget revisions, GUBUDJRN provides a history of when and why the revisions happened. Most likely, you won’t see many rows, as you shouldn’t make frequent changes to your budget during the fiscal year. 
	 
	Let’s continue with the sample budget from the GUBE section. After we submit our budget revision form, our GUBUDJRN might look like this: 
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	Sample GUBUDJRN report — outlined area shows nonpayroll budget revisions 
	 
	Notice that all the nonpayroll budget revisions (outlined area) equal zero. The first six nonpayroll revisions are permanent, meaning they will be incorporated into all future budgets. The last two are temporary, indicating they are for this fiscal year only. 
	 
	Tour by columns. Each column represents a data field about the revision. 
	 
	 Journal is the record identifier. If you need to discuss a revision, have this info handy to help the Finance Office locate the record. 
	 Journal is the record identifier. If you need to discuss a revision, have this info handy to help the Finance Office locate the record. 
	 Journal is the record identifier. If you need to discuss a revision, have this info handy to help the Finance Office locate the record. 

	 Date is when the revision went into effect. Any item listed as “Base Budget Forward” should show October 1 as the date, as that’s the start of the fiscal year. 
	 Date is when the revision went into effect. Any item listed as “Base Budget Forward” should show October 1 as the date, as that’s the start of the fiscal year. 

	 Fund, Dept, and Acct show where the revision was recorded. Fund pertains to which University fund provides money for this budget (general vs. grants), Dept is the department (as opposed to Org in GUACTJRN), and Acct is the expense account.  
	 Fund, Dept, and Acct show where the revision was recorded. Fund pertains to which University fund provides money for this budget (general vs. grants), Dept is the department (as opposed to Org in GUACTJRN), and Acct is the expense account.  

	 Budget is the fiscal year budget that is being revised. In our example, it’s the 2007 fiscal year budget. 
	 Budget is the fiscal year budget that is being revised. In our example, it’s the 2007 fiscal year budget. 

	 Type, Amount, and Descr tell you whether the change is permanent or temporary (Type), how much it was for (Amount), and the reason for it (Descr).  
	 Type, Amount, and Descr tell you whether the change is permanent or temporary (Type), how much it was for (Amount), and the reason for it (Descr).  


	 
	How to use the report. Like GUBE/GUBR, this report is handy for budget planning. It provides you with the history behind your budget revisions. It also confirms whether or not payroll or funding changes were applied to your budget. 
	The supporting cast — What you’ll use for encumbered expenses 
	For the most part, you shouldn’t adjust encumbrances. However, it’s nice to know some details about them, so that’s where the Payroll Encumbrances and POSTAT reports come into play. They help you track your department’s major expenses. 
	Payroll Encumbrances 
	The Payroll Encumbrances report shows you each employee’s total salary and benefits and how much of their salary/benefits remains to be paid. It also shows the fixed expense attributed to each employee per pay period. 
	 
	Payroll Encumbrances Summary 
	Payroll Encumbrances Summary 
	Payroll Encumbrances Summary 
	Payroll Encumbrances Summary 
	 Purpose: Provide detail about payroll 
	 Purpose: Provide detail about payroll 
	 Purpose: Provide detail about payroll 

	 Expenses: Shown as positives 
	 Expenses: Shown as positives 

	 Rows: Salary and benefit expense by employee 
	 Rows: Salary and benefit expense by employee 

	 Columns: Data fields for each expense 
	 Columns: Data fields for each expense 

	 Claim to fame: Shows payroll expenses by pay period 
	 Claim to fame: Shows payroll expenses by pay period 
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	Sample Payroll Encumbrances report 
	 
	Tour by rows. There are two entries per employee — one each for salary and benefits. Only employees on the University payroll will appear on this report; student workers, for example, are not included here. (They are shown on GUACTJRN.)  
	 
	This report shows how much payroll remains to be paid; it does not show you how much you’ve already paid each employee. To find out how much you’ve already paid, you have two options. The easy option is to hop over to your GUBS and look at the Actual Expenses/Revenues column. 
	Of course, the figures given there only tell you how much you’ve paid the entire group; it doesn’t break down the numbers by employee. 
	 
	The other option is to subtract the Remaining Encumbered from the Annual Salary, which allows you to calculate amounts for each employee. So, for Joe Employee 1, salary and benefits paid to date would be: 
	$110,251 - 42,404.20 = $67,846.80 in salary and $31,422 - 12,085.20 = $19,336.80 in benefits. 
	 
	Tour by columns. The data fields are pretty self-explanatory. 
	 
	 Account is the expense account. Everything in this column should begin with a 51. 
	 Account is the expense account. Everything in this column should begin with a 51. 
	 Account is the expense account. Everything in this column should begin with a 51. 

	 Description is the employee classification. You might see other categories of employees here, like Short-term Faculty (5115) or Regular Status Staff - Non-exempt (5123). 
	 Description is the employee classification. You might see other categories of employees here, like Short-term Faculty (5115) or Regular Status Staff - Non-exempt (5123). 

	 Annual Salary includes both the payments for wages and benefits. This is the total amount paid to the employee for the fiscal year. 
	 Annual Salary includes both the payments for wages and benefits. This is the total amount paid to the employee for the fiscal year. 


	(The default mode in PeopleSoft shows this amount rounded to the nearest whole dollar. You can see the exact amount by highlighting the cells then typing CTRL+1. In the Decimal places box, enter a 2 then click OK.) 
	 Bi-weekly Gross is the amount that is paid to the employee per pay period. It is 1/26th of the Annual Salary. For faculty who are paid over 9 or 10 months, this figure may differ from the actual expense. For example, 9-month faculty might be paid over 19 pay periods instead of 26, so they are paid 1/19th of the Annual Salary, not 1/26th. (The 1/19th payments are recorded in GUACTJRN.) 
	 Bi-weekly Gross is the amount that is paid to the employee per pay period. It is 1/26th of the Annual Salary. For faculty who are paid over 9 or 10 months, this figure may differ from the actual expense. For example, 9-month faculty might be paid over 19 pay periods instead of 26, so they are paid 1/19th of the Annual Salary, not 1/26th. (The 1/19th payments are recorded in GUACTJRN.) 
	 Bi-weekly Gross is the amount that is paid to the employee per pay period. It is 1/26th of the Annual Salary. For faculty who are paid over 9 or 10 months, this figure may differ from the actual expense. For example, 9-month faculty might be paid over 19 pay periods instead of 26, so they are paid 1/19th of the Annual Salary, not 1/26th. (The 1/19th payments are recorded in GUACTJRN.) 

	 Remaining Pay Periods shows the number of pay periods left in the fiscal year. In our example, there are 10 pay periods remaining, which means 16 pay periods have occurred. 
	 Remaining Pay Periods shows the number of pay periods left in the fiscal year. In our example, there are 10 pay periods remaining, which means 16 pay periods have occurred. 

	 Remaining Encumbered is the amount of the annual salary that has yet to be paid. It should equal (Bi-weekly Gross)  (Remaining Pay Periods). Nine- and 10-month faculty figures may be different from what the report shows. 
	 Remaining Encumbered is the amount of the annual salary that has yet to be paid. It should equal (Bi-weekly Gross)  (Remaining Pay Periods). Nine- and 10-month faculty figures may be different from what the report shows. 


	 
	How to use the report. You probably won’t need to use this report until calculating merit increases. Or it can be handy if there’s a personnel change in your department. (For example, if an employee leaves mid-year, their remaining encumbered salary could be deobligated and reassigned to other portions of your budget.) By the way, when the president announces a General Pay Increase, HR automatically applies it to everyone’s salaries and benefits. You’ll see the adjustments appear on GUBUDJRN and the figures
	POSTAT — Purchase Order Status 
	POSTAT (Purchase Order Status) lets you track payments made to vendors via purchase orders. Typically, you issue purchase orders for purchases over $5,000 or for service contracts with specific terms of agreement (such as using a project consultant). The purpose of issuing a purchase order is to ensure your department has sufficient funds to pay the full contract. As payments are made to the vendor, they are recorded both in GUACTJRN and POSTAT. 
	 
	POSTAT Summary 
	POSTAT Summary 
	POSTAT Summary 
	POSTAT Summary 
	 Purpose: Track payments made and remaining on purchase orders 
	 Purpose: Track payments made and remaining on purchase orders 
	 Purpose: Track payments made and remaining on purchase orders 

	 Expenses: Shown as negatives 
	 Expenses: Shown as negatives 

	 Rows: Items on a purchase order 
	 Rows: Items on a purchase order 

	 Columns: Data field about each item 
	 Columns: Data field about each item 

	 Claim to fame: Shows what you owe on your big ticket items 
	 Claim to fame: Shows what you owe on your big ticket items 
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	Sample POSTAT (Purchase Order Status) report — Page 1 
	P
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	Sample POSTAT (Purchase Order Status) report — Page 2 
	 
	Tour by rows. Each row corresponds to an item on a purchase order. If a purchase order contains multiple items, it will have multiple rows in the report. For example, the Apple Computer purchase was for two items (iLife 2006 single license and iLife 2006 volume purchase licensing), so each item is listed separately. 
	 
	This report tracks both amounts due and payments, so it looks different from the other budget reports. Each item is listed at least twice — once for the amount due and one or more times for each payment made. In this example, the iLife licenses have been paid in full. You see a positive number in the amount column when the purchase order is issued and a negative amount when a payment is applied. 
	 
	Tour by columns. There’s a lot of data associated with each item on a purchase order, so the columns span two pages. 
	 
	 PO ID is the purchase order number. It’s also the best way to identify the purchase order if you have a question for Contracts and Purchasing. 
	 PO ID is the purchase order number. It’s also the best way to identify the purchase order if you have a question for Contracts and Purchasing. 
	 PO ID is the purchase order number. It’s also the best way to identify the purchase order if you have a question for Contracts and Purchasing. 

	 PO Date is the date the purchase order was issued. It is not the date the requisition was made. 
	 PO Date is the date the purchase order was issued. It is not the date the requisition was made. 


	 PO Status tells you if the purchase order is active or not. Dispatched means it’s ready to use. Completed means either the purchase order has been paid in full or the department has deobligated or closed it. 
	 PO Status tells you if the purchase order is active or not. Dispatched means it’s ready to use. Completed means either the purchase order has been paid in full or the department has deobligated or closed it. 
	 PO Status tells you if the purchase order is active or not. Dispatched means it’s ready to use. Completed means either the purchase order has been paid in full or the department has deobligated or closed it. 

	 Vendor tells you who is providing the product/service. 
	 Vendor tells you who is providing the product/service. 

	 Buyer identifies who initiated the purchase order.  
	 Buyer identifies who initiated the purchase order.  

	 Req Number is the requisition number, taken from the purchase requisition form you submitted to Contracts and Purchasing. 
	 Req Number is the requisition number, taken from the purchase requisition form you submitted to Contracts and Purchasing. 

	 Line Status tells you which portions, if any, of the purchase order have been paid. Active means the item is ready to use; Closed means the item has been received/completed; and Cancelled means you no longer need the item and have requested its deletion (deobligation) from the purchase order. 
	 Line Status tells you which portions, if any, of the purchase order have been paid. Active means the item is ready to use; Closed means the item has been received/completed; and Cancelled means you no longer need the item and have requested its deletion (deobligation) from the purchase order. 

	 Line identifies the items of a purchase order. It essentially numbers each part of the purchase order. In our example, there are two purchase orders. The first one is for only one item (Web site design); the second one is for two (iLife purchase and volume license). 
	 Line identifies the items of a purchase order. It essentially numbers each part of the purchase order. In our example, there are two purchase orders. The first one is for only one item (Web site design); the second one is for two (iLife purchase and volume license). 

	 Item Description tells you what the item is. 
	 Item Description tells you what the item is. 

	 Fund, Org, and Acct tell you how the expense is recorded. As with the other reports, Fund indicates which University fund the money comes from (general vs. grant or other); Org is your department’s budget code; and Acct is the expense account. 
	 Fund, Org, and Acct tell you how the expense is recorded. As with the other reports, Fund indicates which University fund the money comes from (general vs. grant or other); Org is your department’s budget code; and Acct is the expense account. 

	 Budget Yr is the fiscal year in which the purchase order exists. If you have a contract that runs from August to December, you would have to issue two purchase orders — one for this fiscal year and one for the new fiscal year that begins on October 1. POSTAT shows only purchase orders for the current fiscal year. 
	 Budget Yr is the fiscal year in which the purchase order exists. If you have a contract that runs from August to December, you would have to issue two purchase orders — one for this fiscal year and one for the new fiscal year that begins on October 1. POSTAT shows only purchase orders for the current fiscal year. 

	 Voucher records the check number if the University has issued a payment on the purchase order. This column is an easy way to tell if the row shows an amount due or an expense. (Amounts due don’t have Voucher entries.) 
	 Voucher records the check number if the University has issued a payment on the purchase order. This column is an easy way to tell if the row shows an amount due or an expense. (Amounts due don’t have Voucher entries.) 

	 Amount shows either the purchase order amount or payments made. In our example, we see that $56,000 of the total $84,000 has been paid on the first purchase order. The second purchase order has been paid in full. 
	 Amount shows either the purchase order amount or payments made. In our example, we see that $56,000 of the total $84,000 has been paid on the first purchase order. The second purchase order has been paid in full. 


	When a purchase order is issued, the amount appears as an encumbrance on the GUBS report. As payments are made, they are deducted from the Encumbered column and added to Actual Expenses. 
	 
	How to use the report. This report is the best place to track any activities related to a purchase order. For example, if you don’t clearly reference the purchase order on an invoice, the Finance Office may just issue a check. Your department will have paid the vendor but the check won’t show on the purchase order. If this happens, you should contact Contracts and Purchasing to have the payment amount deobligated. POSTAT is also useful for calculating outstanding payments on purchase orders when you forecas
	 
	Part III: Suggested Budget Practices
	Part III: Suggested Budget Practices
	 

	In this section, we provide suggestions for tracking your department’s budget more efficiently. These are suggestions only; you may develop routines that are better suited to how you manage finances and plan future activities. 
	Develop a budget routine 
	Probably the easiest way to monitor your budget is to designate specific days (such as the 1st and 15th of the month) as “budget days.” On these days, you would spend time reviewing the reports. This habit, more than any other, will help you become more familiar and comfortable with your department’s budget. 
	 
	By consistently downloading reports every month, you can more easily identify new versus reconciled records. You will also be able to spot patterns in spending behavior. Most importantly, the time needed to review reports would eventually decrease as you get more practice looking at the information contained in them. One month of expenses is a lot easier to reconcile than two or three months’ worth. So the longer you go between “budget days,” the longer your “budget wrestling session.” 
	 
	It’s one thing to analyze the information in a budget; it’s another to make it useful to someone else, notably the BUH. So, the second step of your budget routine might be noting your observations in a report. This serves two purposes: (1) it helps the BUH plan department activities better; and (2) it serves as a reminder to you of what you found when your next budget day comes around.  
	 
	The report should be only one page — too long and it will become more of a burden than a help. Think bullet points. Think big picture. Think about what the BUH would need to know if s/he has only one minute to read the report. Suggested information to include: 
	 
	 Top 3 (or 5) areas of spending — the nonpayroll accounts where your department spent the most money since the last budget day 
	 Top 3 (or 5) areas of spending — the nonpayroll accounts where your department spent the most money since the last budget day 
	 Top 3 (or 5) areas of spending — the nonpayroll accounts where your department spent the most money since the last budget day 

	 Payments made (or not made) on purchase orders 
	 Payments made (or not made) on purchase orders 

	 New purchase orders issued (if applicable) — Initiating a new purchase order will create an encumbrance, which affects your bottom line. 
	 New purchase orders issued (if applicable) — Initiating a new purchase order will create an encumbrance, which affects your bottom line. 

	 Reminders of upcoming expenses — If you know your department needs funds for an upcoming activity, a gentle reminder could help the BUH plan for the expenses accordingly. 
	 Reminders of upcoming expenses — If you know your department needs funds for an upcoming activity, a gentle reminder could help the BUH plan for the expenses accordingly. 

	 How much is remaining in your budget — Remember to factor encumbrances, monthly fixed expenses (like phone service) and upcoming expenses into your calculations. 
	 How much is remaining in your budget — Remember to factor encumbrances, monthly fixed expenses (like phone service) and upcoming expenses into your calculations. 

	 Revisions that have (or haven’t yet) been incorporated into the budget, if you submitted a budget revision request 
	 Revisions that have (or haven’t yet) been incorporated into the budget, if you submitted a budget revision request 

	 Recommendations for revising the budget, if you notice areas that are “out of whack.” Remember that you also must identify account(s) to provide the funds to the account(s) that need them. 
	 Recommendations for revising the budget, if you notice areas that are “out of whack.” Remember that you also must identify account(s) to provide the funds to the account(s) that need them. 


	Resources to help you budget 
	Budget processes. You can always contact the Finance Office for assistance with a budget process, such as completing forms or correcting errors in a report. For assistance with purchase orders, contact Contracts and Purchasing. They can help you with purchase requisitions, deobligating funds, and extending contracts to a new fiscal year. Finally, for personnel actions and anything related to payroll, contact Human Resources. 
	 
	Key contacts 
	Key contacts 
	Key contacts 
	Key contacts 
	Accounting: Finance Office — College Hall, Room 108 • ext. 5299 v/tty 
	Purchase orders: Contracts & Purchasing — College Hall, Room 313 • ext. 5533 v/tty 
	Payroll: Payroll Office — College Hall, Room 320 • ext. 5293 tty 

	Span


	 
	Budget data. Remember that PeopleSoft data come from multiple sources. The Finance Office can assist you with most data issues, especially those that come from other departments (GIS, Reprographics, Postal Services, ITS and Transportation). You can also verify purchase card expenses at the JP Morgan Chase Web site, http://www.paymentnet.com. When you login, you can review your purchases and assign them the correct accounts. 
	 
	Budget concepts. The Finance Office maintains a list of accounting terms on their Web site at http://finance.gallaudet.edu/terms.html. They also have common accounting forms and expense account codes on the University intranet. You need to enter your Bison/Campus username (using the format campus\firstname.lastname) and password to access these Web pages. 
	 
	How to’s 
	This section provides summaries of how to perform common budget tasks. Terms in SMALL CAPS are Excel commands; underlined terms are identifiers (column titles, window names, etc.)  
	How to determine your bottom line 
	ACTION 
	ACTION 
	ACTION 
	ACTION 

	REASON 
	REASON 
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	Open GUBS. 
	Open GUBS. 
	Open GUBS. 

	GUBS summarizes expenditures and revenues. 
	GUBS summarizes expenditures and revenues. 
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	Look at the last line, Net Total. 
	Look at the last line, Net Total. 
	Look at the last line, Net Total. 

	Net Total adds the totals for payroll and nonpayroll budget, encumbrances, expenses, and remaining funds. 
	Net Total adds the totals for payroll and nonpayroll budget, encumbrances, expenses, and remaining funds. 
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	Bottom Line 
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	How to determine your actual remaining funds 
	ACTION 
	ACTION 
	ACTION 
	ACTION 

	REASON 
	REASON 
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	Open GUBS. 
	Open GUBS. 
	Open GUBS. 

	GUBS summarizes expenditures and revenues. 
	GUBS summarizes expenditures and revenues. 

	Span

	Look at the last line, Net Total. 
	Look at the last line, Net Total. 
	Look at the last line, Net Total. 

	Net Total adds the totals for payroll and nonpayroll budget, encumbrances, expenses, and remaining funds. 
	Net Total adds the totals for payroll and nonpayroll budget, encumbrances, expenses, and remaining funds. 
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	ACTION 
	ACTION 
	ACTION 
	ACTION 

	REASON 
	REASON 
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	Calculate: 
	Calculate: 
	Calculate: 
	Remaining - Nonpayroll Encumbered -69,476.77 - (-28,000) = -41,476.77 
	(See red circles on illustration above.) 
	Encumbered is listed as a negative value so you are subtracting a negative, which means you’re really adding the Encumbered value to Remaining. 

	Funds in the Encumbered column are funds that have been promised but are still in your possession. By adding them back to the Remaining amount, you can calculate how much money you still have on hand. 
	Funds in the Encumbered column are funds that have been promised but are still in your possession. By adding them back to the Remaining amount, you can calculate how much money you still have on hand. 
	 
	Use only the Nonpayroll Encumbered amounts; Payroll Encumbered shouldn’t be altered unless your department has a personnel change. 
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	How to find a specific amount or payee in your Actuals Details report. 
	ACTION 
	ACTION 
	ACTION 
	ACTION 

	REASON 
	REASON 
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	Open GUACTJRN. 
	Open GUACTJRN. 
	Open GUACTJRN. 

	GUACTJRN lists all your transactions, so you can search entries for amounts, payees, or any other information you want. 
	GUACTJRN lists all your transactions, so you can search entries for amounts, payees, or any other information you want. 
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	Type CTRL+F (FIND). Enter your search criteria in the box and click Find Next. 
	Type CTRL+F (FIND). Enter your search criteria in the box and click Find Next. 
	Type CTRL+F (FIND). Enter your search criteria in the box and click Find Next. 

	The FIND command searches your worksheet by rows or by columns and highlights the first cell it finds with your criteria. 
	The FIND command searches your worksheet by rows or by columns and highlights the first cell it finds with your criteria. 
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	Figure
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	Use GUACTJRN to search Monetary Amount or Journal Line Description fields to find specific payments. 

	 
	 
	 
	 

	 
	 


	ACTION 
	ACTION 
	ACTION 

	REASON 
	REASON 

	Span

	If the found cell is not what you were looking for, you can click FIND NEXT until you find the record you want. 
	If the found cell is not what you were looking for, you can click FIND NEXT until you find the record you want. 
	If the found cell is not what you were looking for, you can click FIND NEXT until you find the record you want. 

	If multiple cells have your criteria, Excel will highlight each one until it reaches the end. Some found cells may contain your search criteria as a portion of its cell (e.g., a search for “AV” will yield “AV” and also “Bette Davis” and “David Copperfield” because they all have an “AV” in them.) 
	If multiple cells have your criteria, Excel will highlight each one until it reaches the end. Some found cells may contain your search criteria as a portion of its cell (e.g., a search for “AV” will yield “AV” and also “Bette Davis” and “David Copperfield” because they all have an “AV” in them.) 
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	If your criteria is not found in the worksheet, you may need to check the spelling or amount to ensure you have correct information. 
	If your criteria is not found in the worksheet, you may need to check the spelling or amount to ensure you have correct information. 
	If your criteria is not found in the worksheet, you may need to check the spelling or amount to ensure you have correct information. 

	If a FIND yields no results and you are certain your information is correct, it could mean that the item has not yet been entered into PeopleSoft. Wait a few days and try FIND again. 
	If a FIND yields no results and you are certain your information is correct, it could mean that the item has not yet been entered into PeopleSoft. Wait a few days and try FIND again. 
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	If you find what you want, click Close. 
	If you find what you want, click Close. 
	If you find what you want, click Close. 

	The FIND window stays open otherwise. 
	The FIND window stays open otherwise. 
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	How to determine outstanding payments on a purchase order 
	ACTION 
	ACTION 
	ACTION 
	ACTION 

	REASON 
	REASON 
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	Open POSTAT. 
	Open POSTAT. 
	Open POSTAT. 

	POSTAT summarizes actions on all purchase orders. 
	POSTAT summarizes actions on all purchase orders. 
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	Go to the Amount column and calculate the total for all entries related to the purchase order in question. 
	Go to the Amount column and calculate the total for all entries related to the purchase order in question. 
	Go to the Amount column and calculate the total for all entries related to the purchase order in question. 

	The Amount column lists both the total amount due and the payments made toward the purchase. Positive numbers are the amounts due; negative numbers are payments made (expenses). 
	The Amount column lists both the total amount due and the payments made toward the purchase. Positive numbers are the amounts due; negative numbers are payments made (expenses). 
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	Figure
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	Highlight Amounts related to P.O. and look for sum in bottom status bar 
	 
	 
	InlineShape


	How to associate a payment with a purchase order 
	ACTION 
	ACTION 
	ACTION 
	ACTION 

	REASON 
	REASON 

	Span

	When you receive an invoice from the vendor, include: 
	When you receive an invoice from the vendor, include: 
	When you receive an invoice from the vendor, include: 
	OK to pay 
	P.O. # 
	BUH Signature 
	Date 

	When staff see a purchase order number, they know immediately to associate the payment with the P.O.  
	When staff see a purchase order number, they know immediately to associate the payment with the P.O.  
	Payments made on P.O.s will decrease encumbrances. Otherwise, regular checks increase expenses without affecting encumbrances. 
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	If a payment was made and was not applied to the purchase order, contact Contracts and Purchasing to adjust the encumbrance. 
	If a payment was made and was not applied to the purchase order, contact Contracts and Purchasing to adjust the encumbrance. 
	If a payment was made and was not applied to the purchase order, contact Contracts and Purchasing to adjust the encumbrance. 
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	OK to pay 
	P.O. #987654 
	El Guapo 
	5/8/07 

	 
	How to establish a budget that reflects your department’s actions and priorities 
	The information that follows is a repeat of the example given in Part I, How to establish a budget. Illustrations of Excel commands can be found in Part IV. 
	 
	ACTION 
	ACTION 
	ACTION 
	ACTION 

	REASON 
	REASON 
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	Open GUACTJRN. 
	Open GUACTJRN. 
	Open GUACTJRN. 

	GUACTJRN lists all your transactions so you can subtotal expenses by account. 
	GUACTJRN lists all your transactions so you can subtotal expenses by account. 

	Span

	FILTER for nonpayroll expenses then SORT by account. 
	FILTER for nonpayroll expenses then SORT by account. 
	FILTER for nonpayroll expenses then SORT by account. 

	See Part IV to review FILTER and SORT. 
	See Part IV to review FILTER and SORT. 
	Work with nonpayroll expenses only, because they are the ones your department can control. Payroll is generally predetermined by HR. 
	SORT by account to group all similar expenses together. 
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	SUBTOTAL the Monetary Amount column. 
	SUBTOTAL the Monetary Amount column. 
	SUBTOTAL the Monetary Amount column. 

	See Part IV to review SUBTOTAL. 
	See Part IV to review SUBTOTAL. 
	Subtotaling allows you to see how much you’ve spent on each account. 
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	Aggregate accounts under the general categories (5200, 5300, etc.). Compare the totals to what exists on your current budget. 
	Aggregate accounts under the general categories (5200, 5300, etc.). Compare the totals to what exists on your current budget. 
	Aggregate accounts under the general categories (5200, 5300, etc.). Compare the totals to what exists on your current budget. 

	Budgets look at the big picture. You used the details in the previous steps to help you guesstimate values for major expense areas. 
	Budgets look at the big picture. You used the details in the previous steps to help you guesstimate values for major expense areas. 
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	Submit Budget Revision forms, if necessary, to move funds within your budget. Remember to determine if the change will be permanent or temporary and to keep all changes equal to zero. 
	Submit Budget Revision forms, if necessary, to move funds within your budget. Remember to determine if the change will be permanent or temporary and to keep all changes equal to zero. 
	Submit Budget Revision forms, if necessary, to move funds within your budget. Remember to determine if the change will be permanent or temporary and to keep all changes equal to zero. 

	Remember, budget = plan to spend $$$. The more accurately you allocate funds, the easier it is to eyeball how well your department is carrying out its activities and meeting its goals. 
	Remember, budget = plan to spend $$$. The more accurately you allocate funds, the easier it is to eyeball how well your department is carrying out its activities and meeting its goals. 

	Span


	 
	 
	Part IV: Working with Excel
	Part IV: Working with Excel
	 

	You thought budgeting was hard enough, but now you’ve got to use Excel! This section will introduce you to basic Excel commands that you might use to analyze budget reports. 
	Setting the stage: Preparing your document for analysis 
	Learning how to use a computer program is challenging. It can be especially frustrating to read a manual, if you learn better from hands-on instruction or videos. 
	 
	This section will try to bridge that gap by using screen shots to illustrate the concepts. We’ll use special formatting, like SMALL CAPS for commands and underlining for identifiers or parameters (like which window we’re in or what to set a field to). To explain where commands can be found, we will use MENU > COMMAND > SUBCOMMAND. 
	 
	If you see… 
	If you see… 
	If you see… 
	If you see… 

	…it means 
	…it means 

	Span

	FILE > SAVE AS 
	FILE > SAVE AS 
	FILE > SAVE AS 

	Go to the File menu to find the Save As command. 
	Go to the File menu to find the Save As command. 

	Span

	FORMAT > COLUMN > HIDE 
	FORMAT > COLUMN > HIDE 
	FORMAT > COLUMN > HIDE 

	Go to the Format menu, then to Column. You will get a submenu where you can find Hide. 
	Go to the Format menu, then to Column. You will get a submenu where you can find Hide. 

	Span

	Save in 
	Save in 
	Save in 

	In the dialog box, there’s a window called “Save in.” Make sure the info in the box is what you want. 
	In the dialog box, there’s a window called “Save in.” Make sure the info in the box is what you want. 

	Span

	In the Fit to: field, enter 1. 
	In the Fit to: field, enter 1. 
	In the Fit to: field, enter 1. 

	There’s a field called “Fit to.” Enter a “1” in the box next to it. 
	There’s a field called “Fit to.” Enter a “1” in the box next to it. 

	Span


	 
	Occasionally, we’ll explore a topic that is slightly advanced, such as customizing filters. Knowing these topics can help you become more proficient at using Excel, but they aren’t necessary if you just want to know the basics. We’ll highlight these discussions as Detours so you know you can skip the section if you want to. 
	Reviewing the basic commands 
	Excel has hundreds of commands to manipulate data. This section explains the commands you will probably use the most. These are the basics — you will learn other, more involved commands for analysis later in this manual. 
	 
	Where possible, we recommend using keyboard shortcuts rather than the mouse, because typing is more efficient. After you’ve used the keyboard shortcuts a few times, you’ll find them easy to remember as well as big time and energy savers. 
	Table 1: Common Excel commands 
	Command 
	Command 
	Command 
	Command 

	Keyboard shortcut/ Location 
	Keyboard shortcut/ Location 

	What it does 
	What it does 

	Span

	FILE MENU 
	FILE MENU 
	FILE MENU 

	Span

	Open 
	Open 
	Open 

	CTRL+O 
	CTRL+O 

	Opens a file. 
	Opens a file. 

	Span

	Close 
	Close 
	Close 

	CTRL+W 
	CTRL+W 

	Closes a file; you can save the file before closing. 
	Closes a file; you can save the file before closing. 

	Span

	Save 
	Save 
	Save 

	CTRL+S 
	CTRL+S 

	Saves your file. 
	Saves your file. 

	Span

	Page Setup… 
	Page Setup… 
	Page Setup… 

	FILE > PAGE SETUP 
	FILE > PAGE SETUP 

	Controls how your report prints (full scale vs. reduced, paper orientation, margins, etc.) — great tool to minimize paper waste. 
	Controls how your report prints (full scale vs. reduced, paper orientation, margins, etc.) — great tool to minimize paper waste. 

	Span

	Print Preview 
	Print Preview 
	Print Preview 

	FILE > PRINT PREVIEW 
	FILE > PRINT PREVIEW 

	Allows you to check how your report will print — also helps minimize paper waste. 
	Allows you to check how your report will print — also helps minimize paper waste. 

	Span

	Print 
	Print 
	Print 

	CTRL+P 
	CTRL+P 

	Prints your document. 
	Prints your document. 

	Span

	EDIT MENU 
	EDIT MENU 
	EDIT MENU 

	Span

	Undo 
	Undo 
	Undo 

	CTRL+Z 
	CTRL+Z 

	For your “oops” moments — this command undoes whatever action you just did. You can undo several steps, by retyping CTRL+Z as many times as needed. 
	For your “oops” moments — this command undoes whatever action you just did. You can undo several steps, by retyping CTRL+Z as many times as needed. 

	Span

	Redo 
	Redo 
	Redo 

	CTRL+Y 
	CTRL+Y 

	Repeats whatever action you just did — useful for commands that don’t have keyboard shortcuts, like inserting a row. Insert your first row, then type CTRL+Y to insert more. 
	Repeats whatever action you just did — useful for commands that don’t have keyboard shortcuts, like inserting a row. Insert your first row, then type CTRL+Y to insert more. 

	Span

	Cut 
	Cut 
	Cut 

	CTRL+X 
	CTRL+X 

	Removes your selection from the document so you can insert it elsewhere. 
	Removes your selection from the document so you can insert it elsewhere. 

	Span

	Copy 
	Copy 
	Copy 

	CTRL+C 
	CTRL+C 

	Copies your selection so you can insert it elsewhere. 
	Copies your selection so you can insert it elsewhere. 

	Span

	Paste 
	Paste 
	Paste 

	CTRL+V 
	CTRL+V 

	Inserts your cut or copied selection into the worksheet. 
	Inserts your cut or copied selection into the worksheet. 

	Span

	Find 
	Find 
	Find 

	CTRL+F 
	CTRL+F 

	Searches for data you specify. 
	Searches for data you specify. 

	Span


	Command 
	Command 
	Command 
	Command 

	Keyboard shortcut/ Location 
	Keyboard shortcut/ Location 

	What it does 
	What it does 

	Span

	INSERT MENU 
	INSERT MENU 
	INSERT MENU 

	Span

	Rows 
	Rows 
	Rows 

	INSERT > ROWS 
	INSERT > ROWS 

	Inserts a blank row — useful if you want to separate groups of data instead of seeing one long list. 
	Inserts a blank row — useful if you want to separate groups of data instead of seeing one long list. 

	Span

	Columns 
	Columns 
	Columns 

	INSERT > COLUMNS 
	INSERT > COLUMNS 

	Inserts a blank column — useful if you want to add information that isn’t in PeopleSoft to each transaction (e.g., who created the expense). 
	Inserts a blank column — useful if you want to add information that isn’t in PeopleSoft to each transaction (e.g., who created the expense). 

	Span

	Worksheet 
	Worksheet 
	Worksheet 

	INSERT > WORKSHEET 
	INSERT > WORKSHEET 

	Inserts a blank worksheet into your file — great for analyzing large blocks of data without destroying your original. 
	Inserts a blank worksheet into your file — great for analyzing large blocks of data without destroying your original. 

	Span


	 
	Besides these commands, you’ll also highlight cells to calculate totals quickly. Suppose you want to calculate only the first 12 transactions in this month’s GUACTJRN report. You would click on the first transaction and drag the mouse down to the 12th. The status bar at the bottom of the screen will show you the total of whatever you highlighted. 
	 
	To use the highlight technique with nonadjacent cells, hold down the CTRL key and click your mouse on the cells you want to add. (Click a cell again to deselect it from your total.) The sum will appear in the bottom status bar. 
	Saving your work and the original data set 
	As you learn to use Excel, you’ll find it easy to dive in and play with the data. After you’ve completely dissected your worksheet, you might find that you made a mistake at the very beginning and need to go back to square one. Unfortunately, you forgot to save the original, so now you have to reenter PeopleSoft and download a whole new report. Ugh! Learn to prep your files first and save yourself a lot of frustration. 
	 
	Ideally, you already have a folder for your budget files. If you don’t, take time now to create one so you can easily find all your reports when you need them. 
	 
	Creating a budget folder 
	Creating a budget folder 
	Creating a budget folder 
	Creating a budget folder 

	Span

	1. Click on your Desktop. 
	1. Click on your Desktop. 
	1. Click on your Desktop. 
	1. Click on your Desktop. 
	1. Click on your Desktop. 

	2. Right-click your mouse then select NEW > FOLDER. 
	2. Right-click your mouse then select NEW > FOLDER. 

	3. Rename the new folder something useful, like Budget Files. 
	3. Rename the new folder something useful, like Budget Files. 
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	Back to where we left off …. Let’s save your report first. 
	 
	Saving your PeopleSoft report 
	Saving your PeopleSoft report 
	Saving your PeopleSoft report 
	Saving your PeopleSoft report 

	Span

	1. In Excel, select FILE > SAVE AS. 
	1. In Excel, select FILE > SAVE AS. 
	1. In Excel, select FILE > SAVE AS. 
	1. In Excel, select FILE > SAVE AS. 
	1. In Excel, select FILE > SAVE AS. 

	2. Make sure the Save in window shows Budget Files. 
	2. Make sure the Save in window shows Budget Files. 

	a. If it doesn’t, select DESKTOP > BUDGET FILES. 
	a. If it doesn’t, select DESKTOP > BUDGET FILES. 
	a. If it doesn’t, select DESKTOP > BUDGET FILES. 


	3. Pick a useful name for the report like 051507-BudgetStatus. 
	3. Pick a useful name for the report like 051507-BudgetStatus. 

	4. Hit SAVE. 
	4. Hit SAVE. 

	5. All subsequent saves can be done with CTRL+S (SAVE). 
	5. All subsequent saves can be done with CTRL+S (SAVE). 



	Span


	 
	About naming files. It’s best to include the date at the start of your file name, so you can easily locate and identify the report(s) you want. 
	Figure
	 
	It’s also good to avoid using spaces and periods in your file names. (The spaces and periods affect how computers process information about a file.) 
	 
	 
	 
	 
	Now that you’ve saved your report, we need to copy the original data. It’s best to work with the copy, because if something goes awry, you can always go back to the original. 
	 
	Copying the original data and renaming worksheets 
	Copying the original data and renaming worksheets 
	Copying the original data and renaming worksheets 
	Copying the original data and renaming worksheets 

	Span

	1. Right-click on the worksheet tab, Sheet1. 
	1. Right-click on the worksheet tab, Sheet1. 
	1. Right-click on the worksheet tab, Sheet1. 
	1. Right-click on the worksheet tab, Sheet1. 
	1. Right-click on the worksheet tab, Sheet1. 

	2. Select MOVE OR COPY …. 
	2. Select MOVE OR COPY …. 

	3. Check the box next to Create a copy and click OK . 
	3. Check the box next to Create a copy and click OK . 

	4. Right-click on the new worksheet tab and select RENAME. 
	4. Right-click on the new worksheet tab and select RENAME. 

	5. Rename the sheet something useful, like Use This. 
	5. Rename the sheet something useful, like Use This. 

	6. You can also rename the original worksheet. Right-click on the worksheet tab for Sheet1 and RENAME it Original. 
	6. You can also rename the original worksheet. Right-click on the worksheet tab for Sheet1 and RENAME it Original. 



	Span


	 
	Creating a copy of a worksheet 
	Figure
	Viewing reports on the screen and in print 
	Some PeopleSoft reports are large, requiring you to scroll up and down frequently on the screen. In print, these reports can take up several pages. You can save time and resources by using FREEZE PANES and PAGE SETUP. 
	Keeping titles in view 
	FREEZE PANES allows you to keep a portion of your worksheet stationary and, therefore, visible on your screen. It’s especially useful when looking at the long list of transactions in GUACTJRN, as titles remain visible to remind you what’s in each column. Using this command does NOT change any data in your worksheet. It just changes how you view it. 
	 
	Using FREEZE PANES 
	Using FREEZE PANES 
	Using FREEZE PANES 
	Using FREEZE PANES 

	Span

	1. Click on the cell immediately below and to the right of where you want to freeze. 
	1. Click on the cell immediately below and to the right of where you want to freeze. 
	1. Click on the cell immediately below and to the right of where you want to freeze. 
	1. Click on the cell immediately below and to the right of where you want to freeze. 
	1. Click on the cell immediately below and to the right of where you want to freeze. 

	a. If you want to freeze only rows, click on the first cell of the row below where you want the freeze. 
	a. If you want to freeze only rows, click on the first cell of the row below where you want the freeze. 
	a. If you want to freeze only rows, click on the first cell of the row below where you want the freeze. 

	b. If you want to freeze only columns, click on the topmost cell of the column to the right of where you want the freeze. 
	b. If you want to freeze only columns, click on the topmost cell of the column to the right of where you want the freeze. 


	2. Go to WINDOW > FREEZE PANES. 
	2. Go to WINDOW > FREEZE PANES. 

	3. When FREEZE PANES is on, you will see thin black lines marking where the freeze begins. 
	3. When FREEZE PANES is on, you will see thin black lines marking where the freeze begins. 

	4. To undo FREEZE PANES, go to WINDOW > UNFREEZE PANES. 
	4. To undo FREEZE PANES, go to WINDOW > UNFREEZE PANES. 



	Span


	 
	You probably won’t need to freeze a column when working on your budget reports, but it can be useful if you find yourself scrolling left-right a lot. 
	Figure
	 
	Detour! 
	Related to freezing panes is designating a title row/column for printed reports. When you designate a title row/column, Excel automatically prints it on every page. 
	 
	 
	(Left) In GUACTJRN, select cell B8 then FREEZE PANES to freeze titles across the top. 
	 
	Detour! Setting print titles 
	Detour! Setting print titles 
	Detour! Setting print titles 
	Detour! Setting print titles 

	Span

	1. Go to FILE > PAGE SETUP. 
	1. Go to FILE > PAGE SETUP. 
	1. Go to FILE > PAGE SETUP. 
	1. Go to FILE > PAGE SETUP. 
	1. Go to FILE > PAGE SETUP. 

	2. Select the Sheet tab. 
	2. Select the Sheet tab. 

	3. In the second section, Print titles, enter the row/column that you want to appear as a title. 
	3. In the second section, Print titles, enter the row/column that you want to appear as a title. 

	a. To select rows, click on the WORKSHEET icon next to Rows to repeat at top. 
	a. To select rows, click on the WORKSHEET icon next to Rows to repeat at top. 
	a. To select rows, click on the WORKSHEET icon next to Rows to repeat at top. 

	b. To select columns, click on the WORKSHEET icon next to Columns to repeat at left. 
	b. To select columns, click on the WORKSHEET icon next to Columns to repeat at left. 


	4. You can choose multiple rows/columns by dragging across the entire area you want repeated. 
	4. You can choose multiple rows/columns by dragging across the entire area you want repeated. 

	5. After selecting the title rows/columns, click on the DROP WINDOW icon and click OK. 
	5. After selecting the title rows/columns, click on the DROP WINDOW icon and click OK. 
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	Span


	Setting print titles 
	Setting print titles 
	Setting print titles 
	Setting print titles 



	Figure
	Printing budget reports (Page Setup) 
	Have you ever tried to print GUACTJRN only to have a single column cross over to a second page, giving you 15 pages of what you need … and 15 pages of nothing but a column of “2007s”? It kills the environmentalist in you, doesn’t it? Well, you can control how your reports print using the PAGE SETUP command.  
	Figure
	 
	PAGE SETUP controls different printing aspects of your worksheet, such as page specifications, margins, the header and footer, and print area. For this section, we will focus only on page specifications. 
	 
	For some reports, like GUBS, it’s best to see everything laid out on one page. 
	 
	Printing budget reports on one page only 
	Printing budget reports on one page only 
	Printing budget reports on one page only 
	Printing budget reports on one page only 

	Span

	1. Go to FILE > PAGE SETUP. 
	1. Go to FILE > PAGE SETUP. 
	1. Go to FILE > PAGE SETUP. 
	1. Go to FILE > PAGE SETUP. 
	1. Go to FILE > PAGE SETUP. 

	2. Choose the Page tab of the dialog box. 
	2. Choose the Page tab of the dialog box. 

	3. In the second section, Scaling, select the Fit to: button. 
	3. In the second section, Scaling, select the Fit to: button. 

	4. Enter a 1 in both boxes so it reads: 1 page(s) wide by 1 tall. 
	4. Enter a 1 in both boxes so it reads: 1 page(s) wide by 1 tall. 

	5. Click OK. 
	5. Click OK. 
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	Print on one page only 
	Print on one page only 
	Print on one page only 
	Print on one page only 

	Print one page wide by  long 
	Print one page wide by  long 

	Span


	Figure
	Figure
	 
	For other reports, like GUACTJRN, it’s best to see entire entries on one page. However, because the actuals are a long list, you can’t tell how many pages the report will be. In this case, you’d use the following format: 
	 
	Printing budget reports one-page wide by  pages long 
	Printing budget reports one-page wide by  pages long 
	Printing budget reports one-page wide by  pages long 
	Printing budget reports one-page wide by  pages long 

	Span

	1. Go to FILE > PAGE SETUP. 
	1. Go to FILE > PAGE SETUP. 
	1. Go to FILE > PAGE SETUP. 
	1. Go to FILE > PAGE SETUP. 
	1. Go to FILE > PAGE SETUP. 

	2. Choose the Page tab of the dialog box. 
	2. Choose the Page tab of the dialog box. 

	3. In the second section, Scaling, select the Fit to: button. 
	3. In the second section, Scaling, select the Fit to: button. 

	4. Enter a 1 in the first box, page(s) wide. In the second box, delete the 1 so the box is blank. 
	4. Enter a 1 in the first box, page(s) wide. In the second box, delete the 1 so the box is blank. 

	5. Click OK . 
	5. Click OK . 
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	Before printing, you can check that everything is laid out the way you want. By doing a PRINT PREVIEW, you can see exactly how the pages will be printed, including how many pages the entire document will be. 
	 
	Previewing a document before printing 
	Previewing a document before printing 
	Previewing a document before printing 
	Previewing a document before printing 

	Span

	1. In the Excel toolbar, click on the magnifying glass icon  
	1. In the Excel toolbar, click on the magnifying glass icon  
	1. In the Excel toolbar, click on the magnifying glass icon  
	1. In the Excel toolbar, click on the magnifying glass icon  
	1. In the Excel toolbar, click on the magnifying glass icon  


	 OR go to FILE > PRINT PREVIEW. 
	2. In the bottom left corner, Excel shows you how many pages are in your document. 
	2. In the bottom left corner, Excel shows you how many pages are in your document. 
	2. In the bottom left corner, Excel shows you how many pages are in your document. 

	3. Scroll through the preview to check your report will print the way you want. 
	3. Scroll through the preview to check your report will print the way you want. 



	Span


	Figure
	Manipulating and analyzing budget data 
	The fun with Excel and PeopleSoft begins when you start moving data around to find patterns and other useful information within your report. The three most common functions you will use are sorting, filtering, and subtotaling. 
	Sorting data 
	Sorting means to order the data from highest to lowest (or lowest to highest). This function is particularly useful for grouping like entries together. For example, when you sort GUACTJRN by account, you can clearly see how many expenses have been attributed to each account. 
	 
	Sorting does NOT change your data. It only changes how you see it. 
	 
	Sorting data — One-click method 
	Sorting data — One-click method 
	Sorting data — One-click method 
	Sorting data — One-click method 

	 
	 

	Span

	1. Click on a cell in the column that you want to sort. The cell MUST contain an entry. 
	1. Click on a cell in the column that you want to sort. The cell MUST contain an entry. 
	1. Click on a cell in the column that you want to sort. The cell MUST contain an entry. 
	1. Click on a cell in the column that you want to sort. The cell MUST contain an entry. 
	1. Click on a cell in the column that you want to sort. The cell MUST contain an entry. 

	2. Click on the SORT AZ icon. 
	2. Click on the SORT AZ icon. 


	 
	 

	GUACTJRN sorted by account 
	GUACTJRN sorted by account 

	Span


	Figure
	Figure
	 
	Probably the biggest pitfall with sorting is that once you sort the data, it’s hard to unsort it. Normally, that’s not a problem because the data hasn’t changed. Still, if the sort isn’t what you wanted AND you haven’t done anything else (like enter new data or save the document), you can hit CTRL+Z to UNDO the sort. 
	Figure
	 
	If you can’t undo the sort (see right), you can always go back to your original data, make another copy, and start over. (This is why you should always work from a copy, not the original.) 
	 
	Detour! 
	Excel allows you to sort up to three fields simultaneously. Sorting by multiple fields is useful when you want subsets of data to be ordered. For example, you might want to track expenses over time — have your 5334 (Telephone Usage) charges increased over time? You would sort by account first to group all the 5334 entries together and then by date to see if the charges form any patterns. 
	 
	Detour! Sorting data by multiple fields 
	Detour! Sorting data by multiple fields 
	Detour! Sorting data by multiple fields 
	Detour! Sorting data by multiple fields 

	Span

	1. Click on any cell with data. 
	1. Click on any cell with data. 
	1. Click on any cell with data. 
	1. Click on any cell with data. 
	1. Click on any cell with data. 

	2. Go to DATA > SORT…. 
	2. Go to DATA > SORT…. 

	3. In the Sort by box, select the field you want sorted first. 
	3. In the Sort by box, select the field you want sorted first. 

	4. In the first Then by box, select the second field you want sorted. 
	4. In the first Then by box, select the second field you want sorted. 

	5. In the second Then by box, select the third field you want sorted, if applicable. 
	5. In the second Then by box, select the third field you want sorted, if applicable. 

	6. Click OK. 
	6. Click OK. 



	Span


	 
	Still on the detour! 
	When you sort by multiple fields, Excel sorts in the order you tell it to.  
	 
	Here’s a table that is sorted by Date, then Account, then Amount. Note that only the Date column is completely ordered. 
	Here’s a table that is sorted by Date, then Account, then Amount. Note that only the Date column is completely ordered. 
	Here’s a table that is sorted by Date, then Account, then Amount. Note that only the Date column is completely ordered. 
	Here’s a table that is sorted by Date, then Account, then Amount. Note that only the Date column is completely ordered. 
	 
	The other 2 columns are ordered based on their dates first. For the 2 entries on 01/05/07, they are in Account order first because that was the order of our sort. 

	Date 
	Date 

	Account 
	Account 

	Amount 
	Amount 

	Span

	TR
	01/01/07 
	01/01/07 

	5213 
	5213 

	14.00 
	14.00 

	Span

	TR
	01/02/07 
	01/02/07 

	5219 
	5219 

	14.00 
	14.00 

	Span

	TR
	01/05/07 
	01/05/07 

	5213 
	5213 

	16.00 
	16.00 

	Span

	TR
	01/05/07 
	01/05/07 

	5219 
	5219 

	10.00 
	10.00 

	Span

	TR
	01/08/07 
	01/08/07 

	5221 
	5221 

	65.00 
	65.00 

	Span


	 
	 
	Here’s the same table sorted by Account, then Date, then Amount. Again, notice that only the Account column is completely ordered. 
	Here’s the same table sorted by Account, then Date, then Amount. Again, notice that only the Account column is completely ordered. 
	Here’s the same table sorted by Account, then Date, then Amount. Again, notice that only the Account column is completely ordered. 
	Here’s the same table sorted by Account, then Date, then Amount. Again, notice that only the Account column is completely ordered. 
	 
	The pair of entries for 5219 are listed in chronological order and descending amount. That’s because we told Excel to order first by Date and then by Amount. 

	Date 
	Date 

	Account 
	Account 

	Amount 
	Amount 

	Span

	TR
	01/01/07 
	01/01/07 

	5213 
	5213 

	14.00 
	14.00 

	Span

	TR
	01/05/07 
	01/05/07 

	5213 
	5213 

	16.00 
	16.00 

	Span

	TR
	01/02/07 
	01/02/07 

	5219 
	5219 

	14.00 
	14.00 

	Span

	TR
	01/05/07 
	01/05/07 

	5219 
	5219 

	10.00 
	10.00 

	Span

	TR
	01/08/07 
	01/08/07 

	5221 
	5221 

	65.00 
	65.00 

	Span


	 
	Finally, here’s the table sorted again, this time by Amount, then Date, then Account. Again, notice how the presentation of data changes based on how we sorted. 
	Finally, here’s the table sorted again, this time by Amount, then Date, then Account. Again, notice how the presentation of data changes based on how we sorted. 
	Finally, here’s the table sorted again, this time by Amount, then Date, then Account. Again, notice how the presentation of data changes based on how we sorted. 
	Finally, here’s the table sorted again, this time by Amount, then Date, then Account. Again, notice how the presentation of data changes based on how we sorted. 

	Date 
	Date 

	Account 
	Account 

	Amount 
	Amount 

	Span

	TR
	01/05/07 
	01/05/07 

	5219 
	5219 

	10.00 
	10.00 

	Span

	TR
	01/01/07 
	01/01/07 

	5213 
	5213 

	14.00 
	14.00 

	Span

	TR
	01/02/07 
	01/02/07 

	5219 
	5219 

	14.00 
	14.00 

	Span

	TR
	01/05/07 
	01/05/07 

	5213 
	5213 

	16.00 
	16.00 

	Span

	TR
	01/08/07 
	01/08/07 

	5221 
	5221 

	65.00 
	65.00 
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	What’s the point of showing you all of these tables? 
	What’s the point of showing you all of these tables? 
	What’s the point of showing you all of these tables? 
	What’s the point of showing you all of these tables? 
	SORTING ORDER MATTERS! 

	Span


	Filtering data 
	Filtering means selecting a specific subset of information to appear. For example, you can filter data so only 5200 accounts appear or only expenses from January 1 to January 31 appear. 
	 
	When Excel filters data, only the data you specify will show on the screen. As with sorting, filtering does NOT change your data. It only changes how you view it. In this case, filtering gives you a “lens” through which to view a specific set of data. 
	 
	Filtering data 
	Filtering data 
	Filtering data 
	Filtering data 

	Span

	1. Click on a cell with data. 
	1. Click on a cell with data. 
	1. Click on a cell with data. 
	1. Click on a cell with data. 
	1. Click on a cell with data. 

	2. Go to DATA > FILTER > AUTOFILTER. 
	2. Go to DATA > FILTER > AUTOFILTER. 

	3. You should see menu arrows appear for each column title (see below). 
	3. You should see menu arrows appear for each column title (see below). 

	4. Use menus to select your filter. 
	4. Use menus to select your filter. 


	Example: Let’s filter so we see only our FedEx expenses. 
	Go to JOURNAL LINE DESCRIPTION > FEDEX (see below). 
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	Filtering data, step 3 
	Filtering data, step 3 
	Filtering data, step 3 

	Filtering data, step 4 
	Filtering data, step 4 
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	Figure
	Figure
	 
	After you apply the FedEx filter, you may see the total expense figure at the bottom of the Monetary Amount column (see right). Remember that filtering just lets you view your data differently — in essence, filtering squishes all the non-essential cells to 0 height (thus hiding them). Rows at the bottom move up, as does the data in them. 
	Figure
	 
	So, how do you figure out your total FedEx charges? Highlight the Monetary Amount cells and look at the bottom status bar. You will see your FedEx charges total $200.64. 
	 
	When you’re finished looking at the FedEx charges, you can filter for a different expense or you can remove the filter to see all your data again. 
	 
	Removing a filter 
	Removing a filter 
	Removing a filter 
	Removing a filter 

	Span

	1. Go to the menu where you applied the filter. In our example, it’s Journal Line Description. 
	1. Go to the menu where you applied the filter. In our example, it’s Journal Line Description. 
	1. Go to the menu where you applied the filter. In our example, it’s Journal Line Description. 
	1. Go to the menu where you applied the filter. In our example, it’s Journal Line Description. 
	1. Go to the menu where you applied the filter. In our example, it’s Journal Line Description. 


	Hint: Look for menu arrows that have turned blue. Blue arrows indicate a filter has been applied. 
	2. Scroll to the top and select (ALL). 
	2. Scroll to the top and select (ALL). 
	2. Scroll to the top and select (ALL). 



	 
	 

	Span


	Figure
	 
	Detour! 
	Sometimes, you want to filter by something that doesn’t appear on the menu. For example, you want to see all expenses in the 5300 account, but the ACCT filter menu shows each individual account you used (5322, 5333, 5334, etc.). You can customize! 
	 
	Detour! Customizing a filter 
	Detour! Customizing a filter 
	Detour! Customizing a filter 
	Detour! Customizing a filter 

	Span

	Let’s filter for all 5300 expenses. 
	Let’s filter for all 5300 expenses. 
	Let’s filter for all 5300 expenses. 
	1. Go to ACCT > (CUSTOM…). 
	1. Go to ACCT > (CUSTOM…). 
	1. Go to ACCT > (CUSTOM…). 

	2. In the first dropdown menu, select begins with. 
	2. In the first dropdown menu, select begins with. 

	3. In the text window, enter 53. 
	3. In the text window, enter 53. 

	4. Click OK. 
	4. Click OK. 

	5. You should now see only your 5300 expenses. 
	5. You should now see only your 5300 expenses. 



	 
	 

	Span


	Figure
	 
	More on the detour! The customize filter operations depend on whether the data is text or a number. Excel differentiates between numbers and numbers stored as text. You can tell which one you have by looking at the top status bar when you click on a cell. If the number is preceded by an apostrophe ( ' ) or if a green flag appears on the cell, you have a number stored as text.  
	 
	If you have numbers, you can filter data with math operators. 
	If you have numbers, you can filter data with math operators. 
	If you have numbers, you can filter data with math operators. 
	If you have numbers, you can filter data with math operators. 

	If you have numbers stored as text, you can filter data with logic operators. 
	If you have numbers stored as text, you can filter data with logic operators. 

	Span

	Example: 
	Example: 
	Example: 
	equal to ( = ) ; is not equal to ( ≠ ) 
	is greater than ( > ), is less than ( < ) 

	Example: 
	Example: 
	begins with; does not begin with 
	contains 
	(These operators don’t have math symbols.) 

	Span


	Calculating subtotals (Putting it all together) 
	The SUBTOTAL command is useful when you want to quickly calculate how much you spent by account in GUACTJRN. However, before you can use SUBTOTAL, you need to prepare your data. 
	 
	Probably the biggest challenge of using Excel is figuring out what you need to do to make the data analyzable. It requires methodical thinking because you will most likely get data that is completely out of order and includes a lot more entries than you really want. 
	 
	Here’s a scenario when you would use SUBTOTAL: You want to find out how much your department spent, by account, on all nonpayroll expenses from January 1 to March 31 (2nd quarter of the fiscal year). 
	 
	First, let’s walk through a step-by-step checklist of what you need to do. 
	Table 3: Breakdown of thought process for sample budget analysis 
	Action 
	Action 
	Action 
	Action 

	Reason 
	Reason 

	Span

	 SORT raw data by date. 
	 SORT raw data by date. 
	 SORT raw data by date. 
	 SORT raw data by date. 
	 SORT raw data by date. 



	Orders all expenses so we can easily identify January 1 to March 31 transactions. 
	Orders all expenses so we can easily identify January 1 to March 31 transactions. 

	Span

	 COPY and PASTE relevant cells to new worksheet. 
	 COPY and PASTE relevant cells to new worksheet. 
	 COPY and PASTE relevant cells to new worksheet. 
	 COPY and PASTE relevant cells to new worksheet. 
	 COPY and PASTE relevant cells to new worksheet. 



	Allows us to isolate the relevant data so it’s easier to manipulate. 
	Allows us to isolate the relevant data so it’s easier to manipulate. 

	Span

	 COPY and PASTE column titles to new worksheet. 
	 COPY and PASTE column titles to new worksheet. 
	 COPY and PASTE column titles to new worksheet. 
	 COPY and PASTE column titles to new worksheet. 
	 COPY and PASTE column titles to new worksheet. 



	Allows us to apply AUTOFILTER and SORT to the new worksheet. (Without column titles, AUTOFILTER and SORT are harder to use.) 
	Allows us to apply AUTOFILTER and SORT to the new worksheet. (Without column titles, AUTOFILTER and SORT are harder to use.) 

	Span

	 RENAME the worksheet. 
	 RENAME the worksheet. 
	 RENAME the worksheet. 
	 RENAME the worksheet. 
	 RENAME the worksheet. 



	Allows us to easily identify our work. 
	Allows us to easily identify our work. 

	Span

	 FILTER the data for nonpayroll transactions. 
	 FILTER the data for nonpayroll transactions. 
	 FILTER the data for nonpayroll transactions. 
	 FILTER the data for nonpayroll transactions. 
	 FILTER the data for nonpayroll transactions. 



	Removes payroll expenses from our analysis. 
	Removes payroll expenses from our analysis. 

	Span

	 SORT new data set by account. 
	 SORT new data set by account. 
	 SORT new data set by account. 
	 SORT new data set by account. 
	 SORT new data set by account. 



	Groups expenses by account. 
	Groups expenses by account. 

	Span


	Action 
	Action 
	Action 
	Action 

	Reason 
	Reason 

	Span

	 SUBTOTAL expenses by account. 
	 SUBTOTAL expenses by account. 
	 SUBTOTAL expenses by account. 
	 SUBTOTAL expenses by account. 
	 SUBTOTAL expenses by account. 



	Calculates totals by account. 
	Calculates totals by account. 

	Span


	 
	Remember this is a multi-step process. If you get confused about why we are doing a certain function, review the checklist above. 
	 
	Preparing your data to SUBTOTAL 
	Preparing your data to SUBTOTAL 
	Preparing your data to SUBTOTAL 
	Preparing your data to SUBTOTAL 

	Span

	PeopleSoft data appears in the order they were entered into the system. We need to sort the data in chronological order, so we can find just the January 1 to March 31 expenses. 
	PeopleSoft data appears in the order they were entered into the system. We need to sort the data in chronological order, so we can find just the January 1 to March 31 expenses. 
	PeopleSoft data appears in the order they were entered into the system. We need to sort the data in chronological order, so we can find just the January 1 to March 31 expenses. 
	 
	1. Click on a cell in the Date column. 
	1. Click on a cell in the Date column. 
	1. Click on a cell in the Date column. 

	2. Click on the SORT AZ icon. 
	2. Click on the SORT AZ icon. 



	Span

	Next, we want to look at only the January 1 to March 31 entries. It’s easier to work with a large subset of data by isolating it onto its own worksheet. 
	Next, we want to look at only the January 1 to March 31 entries. It’s easier to work with a large subset of data by isolating it onto its own worksheet. 
	Next, we want to look at only the January 1 to March 31 entries. It’s easier to work with a large subset of data by isolating it onto its own worksheet. 

	Span

	Copying and pasting records into a new worksheet 
	Copying and pasting records into a new worksheet 
	Copying and pasting records into a new worksheet 

	Span

	1. Place the cursor in the left margin (where the row numbers appear) to highlight an entire row at once. 
	1. Place the cursor in the left margin (where the row numbers appear) to highlight an entire row at once. 
	1. Place the cursor in the left margin (where the row numbers appear) to highlight an entire row at once. 
	1. Place the cursor in the left margin (where the row numbers appear) to highlight an entire row at once. 
	1. Place the cursor in the left margin (where the row numbers appear) to highlight an entire row at once. 

	2. Highlight the rows from January 1 to March 31. 
	2. Highlight the rows from January 1 to March 31. 

	3. Type CTRL+C to COPY the selected cells. 
	3. Type CTRL+C to COPY the selected cells. 

	a. Do NOT type anything else while the cells are highlighted. (If you do accidentally type something, hit CTRL+Z to UNDO your last action and repeat steps 1-3.) 
	a. Do NOT type anything else while the cells are highlighted. (If you do accidentally type something, hit CTRL+Z to UNDO your last action and repeat steps 1-3.) 
	a. Do NOT type anything else while the cells are highlighted. (If you do accidentally type something, hit CTRL+Z to UNDO your last action and repeat steps 1-3.) 


	4. Go to INSERT > WORKSHEET. 
	4. Go to INSERT > WORKSHEET. 

	5. In the new worksheet, click on the topmost, leftmost cell (cell A1, as in column A, row 1) and type CTRL+V to PASTE. The copied records will appear. 
	5. In the new worksheet, click on the topmost, leftmost cell (cell A1, as in column A, row 1) and type CTRL+V to PASTE. The copied records will appear. 



	Span


	Now, your data is in a new worksheet, but there are no column titles. So, let’s add them. 
	Now, your data is in a new worksheet, but there are no column titles. So, let’s add them. 
	Now, your data is in a new worksheet, but there are no column titles. So, let’s add them. 
	Now, your data is in a new worksheet, but there are no column titles. So, let’s add them. 
	 
	1. Go back to your Use This worksheet.  
	1. Go back to your Use This worksheet.  
	1. Go back to your Use This worksheet.  

	2. Highlight the top row where the column titles are. It should be row 7. 
	2. Highlight the top row where the column titles are. It should be row 7. 

	3. Type CTRL+C to COPY the title row. 
	3. Type CTRL+C to COPY the title row. 

	4. Go to your new worksheet. 
	4. Go to your new worksheet. 

	5. Click on the topmost, leftmost cell (cell A1, see right). 
	5. Click on the topmost, leftmost cell (cell A1, see right). 

	6. Go to INSERT > COPIED CELLS. The title row should now appear as the top row 
	6. Go to INSERT > COPIED CELLS. The title row should now appear as the top row 

	of your new worksheet. 
	of your new worksheet. 


	 
	Once you have established your new worksheet, you should rename it. Let’s call it 2ndQtr-NonPayroll, as in nonpayroll expenses analysis for quarter 2. 

	Span

	Now that we have our data subset, we need to filter it for nonpayroll expenses and then sort the transactions by account. 
	Now that we have our data subset, we need to filter it for nonpayroll expenses and then sort the transactions by account. 
	Now that we have our data subset, we need to filter it for nonpayroll expenses and then sort the transactions by account. 

	Span

	Filtering and sorting the new data set 
	Filtering and sorting the new data set 
	Filtering and sorting the new data set 

	Span

	1. Go to DATA > FILTER > AUTOFILTER. Menu arrows should appear with each column title. 
	1. Go to DATA > FILTER > AUTOFILTER. Menu arrows should appear with each column title. 
	1. Go to DATA > FILTER > AUTOFILTER. Menu arrows should appear with each column title. 
	1. Go to DATA > FILTER > AUTOFILTER. Menu arrows should appear with each column title. 
	1. Go to DATA > FILTER > AUTOFILTER. Menu arrows should appear with each column title. 

	2. Go to ACCT > (CUSTOM…). 
	2. Go to ACCT > (CUSTOM…). 

	3. Select does not begin with from the first dropdown menu. 
	3. Select does not begin with from the first dropdown menu. 

	4. Enter 51 in the text box and click OK. 
	4. Enter 51 in the text box and click OK. 

	5. Your data should now show only accounts 5200 and higher, which are the nonpayroll 
	5. Your data should now show only accounts 5200 and higher, which are the nonpayroll 

	expenses. 
	expenses. 


	 
	Now, we SORT the data to group all the accounts together. 
	1. Click on a cell in the Acct column. 
	1. Click on a cell in the Acct column. 
	1. Click on a cell in the Acct column. 

	2. Click on the SORT AZ icon. 
	2. Click on the SORT AZ icon. 

	3. Your data is now grouped by account. 
	3. Your data is now grouped by account. 



	Span


	Figure
	Figure
	At long last, your data is now ready for the SUBTOTAL command! 
	At long last, your data is now ready for the SUBTOTAL command! 
	At long last, your data is now ready for the SUBTOTAL command! 
	At long last, your data is now ready for the SUBTOTAL command! 

	Span

	Subtotaling data 
	Subtotaling data 
	Subtotaling data 

	Span

	1. Go to DATA > SUBTOTALS…. 
	1. Go to DATA > SUBTOTALS…. 
	1. Go to DATA > SUBTOTALS…. 
	1. Go to DATA > SUBTOTALS…. 
	1. Go to DATA > SUBTOTALS…. 

	2. In the dialog box, enter the following: 
	2. In the dialog box, enter the following: 

	a. At each change in: Acct 
	a. At each change in: Acct 
	a. At each change in: Acct 

	b. Use function: Sum 
	b. Use function: Sum 

	c. Add subtotal to: Monetary Amount 
	c. Add subtotal to: Monetary Amount 

	d. This means that with each change in account, Excel will subtotal the figures in the Monetary Amount column. 
	d. This means that with each change in account, Excel will subtotal the figures in the Monetary Amount column. 


	3. Click OK. 
	3. Click OK. 

	4. If you want to double-check Excel’s work, highlight all the expenses and confirm that the sum in the status bar is the same as the subtotal. 
	4. If you want to double-check Excel’s work, highlight all the expenses and confirm that the sum in the status bar is the same as the subtotal. 
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	Subtotal dialog box 
	Subtotal dialog box 
	Subtotal dialog box 

	 
	 

	Span


	Figure
	Figure
	 
	Congratulations! You now have the tools to begin doing your own budget analysis.  
	 
	As we said in the introduction, being able to interpret the data in your budget reports is one of the most powerful contributions you can make to your department … and by extension, the University. Budget analysis helps guide decision-making at its best — by looking at what you want to achieve and how best to get there.  
	 
	 
	Glossary
	Glossary
	 

	The list below includes common terms used in this manual. Additional terms and definitions can be found on the Finance Office Web site at: http://finance.gallaudet.edu/terms.html. 
	 
	Account — on PeopleSoft reports; expense category denoted by 4-digit code; also known as expense account; formerly called object code 
	Actuals — accounting term; expense or revenue that occurred (as in “actually spent/earned”) 
	Appropriations — funds received from the U.S. government; Federal law mandates how these funds may be used 
	Base Budget — on PeopleSoft reports; budget with which a department begins the fiscal year 
	Budget — a department’s plan to spend money during the fiscal year 
	COLA — Cost Of Living Adjustment; generally a percentage increase applied across all salaries and benefits 
	Deobligate — used with encumbrances; release of encumbered funds from a purchase order or payroll for another use 
	Department — on accounting forms; 4-digit code representing your department’s budget; formerly called account 
	Encumbrance — accounting term; money that is set aside for a promised expense (such as for payroll or a purchase order) 
	Expense — outflow of funds; money that is spent to purchase a product or service 
	Expense account — on accounting forms; expense category denoted by 4-digit code; also known as account; formerly called object code 
	Expense reimbursement — money that comes into your department, usually via an I.I. to reimburse an expense/service you provided to another department 
	Federal appropriations — see Appropriations 
	Filter — Excel command; allows user to view a specific subset of data (as in “filters out extraneous data”) 
	Fiscal year — accounting term; year in which all financial transactions are recorded; at Gallaudet, October 1 to September 30 
	Fixed expense — accounting term; expense that does not fluctuate with each occurrence 
	Freeze Panes — Excel command; causes designated area of screen to remain stationary while scrolling through a worksheet  
	Funds — money in a department’s budget 
	GUACTJRN — abbreviation for PeopleSoft report, Actuals Detail; lists details about each financial transaction 
	GUBE — abbreviation for PeopleSoft report, Expense Budget; snapshot of budget revisions to a department’s expense accounts 
	GUBR — abbreviation for PeopleSoft report, Revenue Budget; snapshot of budget revisions to a department’s revenue accounts 
	GUBS — abbreviation for PeopleSoft report, Budget Status by Account; snapshot of a department’s budget with encumbrances, actuals, and remaining funds to date 
	GUBUDJRN — abbreviation for PeopleSoft report, Budget Detail; lists details about budget revisions 
	Object code — former term for expense category denoted by 4-digit code; current terminology is expense account on accounting forms or account (acct) on PeopleSoft reports 
	Organization — on PeopleSoft reports; department whose budget is represented on the report 
	PAF — Personnel Action Form; form used to record changes to an employee’s job information and/or salary 
	PaymentNet — Web site of JP Morgan Chase, the University’s purchase card provider; allows users to verify purchase card expenses and account classifications 
	Payroll Encumbrances — PeopleSoft report; lists salary and benefits information by employee 
	Permanent Budget Revision — accounting term; change to budget that continues to subsequent fiscal years; permanent revisions become part of the next fiscal year’s base budget 
	POSTAT — abbreviation for PeopleSoft report, Purchase Order Status; lists encumbrances and payments associated with purchase orders 
	Purchase card — University credit card 
	Purchase order — contract issued by the University to a vendor, agreeing to purchase specified product(s) or service(s) 
	Purchase requisition — accounting form to initiate a purchase order for a product or service 
	Revenue — inflow of funds; monies earned on sales of products or services 
	Revised Budget — on PeopleSoft reports; base budget with permanent and temporary budget revisions applied 
	Sort — Excel command; allows user to view entries in ascending or descending order 
	SPAF — Special Personnel Action Form; form used to process special non-salary payments to individuals 
	Subtotal — Excel command; sums groups of data as directed by the user 
	Temporary Budget Revision — accounting term; change to budget that applies only to current fiscal year 
	University — Gallaudet University; in this manual, University (with a capital U) refers to Gallaudet and the Clerc Center 
	Variable expense — accounting term; expense that fluctuates with each occurrence 
	 



